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End user notice
Microsoft® Voice Command Version 1.5 for Windows Mobile™

IMPORTANT: Do not become distracted from driving safely if operating a motor vehicle while
using Device Software.

Operating certain parts of this Device requires user attention. Diverting attention away from
the road while driving can possibly cause an accident or other serious consequences. Even
occasional, short diversions of attention can be dangerous if your attention is diverted away
from your driving task at a critical time. Do not change system settings or enter data non-
verbally (using your hands) while driving. Stop the vehicle in a safe and legal manner before
attempting these operations. This is important since while setting up or changing some
functions you might be required to distract your attention away from the road and remove
your hands from the wheel.

Microsoft makes no representations, warranties or other determinations that ANY use of the
Software Product is legal, safe, or in any manner recommended or intended while driving or
otherwise operating a motor vehicle.



General Operation

Voice Command Control: Many of the functions of the Device Software can be accomplished
using only voice commands. Using voice commands while driving allows you to initiate the
command with a button and then operate the Device mostly without removing your hands
from the wheel.

Prolonged Views of Screen: If you are driving, do not access any function requiring a
prolonged view of the screen. Pull over in a safe and legal manner before attempting to
access a function of the system requiring prolonged attention. Even occasional short scans to
the screen may be hazardous if your attention has been diverted away from your driving task
at a critical time.

Volume Setting: Do not raise the volume excessively. Keep the volume at a level where you
can still hear outside traffic and emergency signals while driving. Driving while unable to hear
these sounds could cause an accident.

Let Your Judgment Prevail: The Device Software is only an aid. Make your driving decisions
based on your observations of local conditions and existing traffic regulations. The Device
Software is not a substitute for your personal judgment.

Use of Speech Recognition Functions: Speech recognition software is inherently a statistical
process which is subject to errors. It is your responsibility to monitor the speech recognition
functions and address any errors.



Table of Contents

What's iN the DOX 2.ttt s ne e e sareeeas 2
What you need to use your smartphone........cccccuvieiiiiiiiiiei e 3
Palm® Treo™ 700w smartphonNe OVEIVIEW........ccociiviiiieiiiee e 5
Installing the Dattery ... s 8
Charging the battery ... 9
Turning your smartphone on/off

Making your first call .............
Setting up your computer

Moving around the SCreen .......coceeviiiiiiiiii 19

Using the keyboard ..26
Opening and closing applications ....30
USING YOUT TOAAY SCIEEN....ciiiiicitieieeceeree e s eesre e e s e et e e s e b e e e s e s e e e e seasre e e e s s nnees 31
Synchronizing contacts and other info.......cccociviiiiie e 32
Battery life .

Where t0 1€arN MOTE ... ..ttt e e e s e e e e e e e e e e s enne s 35




[ oY A LI AV =Y VA T= YRR 37

MaKing CallS .....ooiiiiiiiiiei i 41
RECEIVING CallS ..o 46
Using voicemail.......ccccevuvnnees .47
Managing active calls ............... ....48
More ways to manage calls ....b0
Defining speed dial bUTtONS ........ceeiiiiiiiie e 54

Using @ phone headset........cccoviiiiiiiiiniiiin e 58

Sending and receiving messages and email

Using Pocket MSN ...

Browsing the Web ...
Connecting to devices with Bluetooth® wireless technology ........ccccceeecvveeennnns 110
Beaming information With IR ........cccciiiiii e 114

Vi



PICtUrESs & VIABOS ...eviueeiiieieeieiii e cetee sttt ettt e st s e e re e e et e s nnnee e snree s 117
Windows Media Player MObile ... 127

Word Mobile.....ccccvvveveereeeenennn.
PowerPoint Mobile
[ (o= I\ o] o 1 1= TN

USING FIN .. e e e e s e e e e e e e e se s s nanrnrnes
Installing applications...........

Removing applications
Setting synchronization OptionNs ........cccv i 161
Sharing info
USING EXPANSION CArdS ....uuuvuiiiiiiiiiiieiiiieis s s e sss s e e e e e s e e s s s e s s e sssnsnrnrneees 166

Today screen settings...........
Phone settings........cccccevenneee.
System sound settings
Display and appearance SettingS ....uuuiiiiiiiiiiiiiiccccccrrrrrre e 183
Application settings ....cccceevvviiiiiiiiiicccinnns 185
Locking your smartphone and info
Using Auto-Keyguard and touchscreen lockout

vii



SYSIEIM SEHINGS .eeuiiiitieiie et e r e sne e sane s 194

(070] oY aT=Te1d oY aIK=1=] a1 o Vo USRS 201
Transferring info from another device ........cccoeeiiiiiiie e 21
Trouble installing the desktop SOftware? .........ccccoeviiiiiei i 212

Resetting your smartphone
Performance .......ccccceevvvrvvnenennnns

Yo ==Y o PN

[N =Y A%V Y Qoo oY =T o3 1 1o o S
Synchronization (ActiveSynNc® SOftWAre)......ccccuveeieeiciiieeee e 224
Email

Third-party appliCationS....ccuuiiiiiiii i
Making room on your smartphone
VOICE QUAIITY .ot

viii



Welcome

Congratulations on the purchase of your Palm® Treo™ 700w
smartphone. In one compact and indispensable device, you now have
all of the following:

e An advanced mobile smartphone

e A Windows Mobile organizer with portable expansion capability
(MultiMediaCard/SD/SDIO)

* High-speed web browsing with NationalAccess and
BroadbandAccess support

e A 1.3-megapixel digital camera (camera smartphone only)
* Mobile email

e Text and multimedia messaging

e A media player

* Microsoft Office Mobile suite

This guide helps you set up your Treo 700w smartphone and quickly
learn to use it.

[ * 1NOTE Phone and text messaging service require a service contract
with Verizon Wireless. Web, email, and messaging services require a
service contract and high-speed data service from Verizon Wireless.
Data speeds vary based on network availability and capacity.

LOOK HERE: Don't

miss the helpful tips
and cross-references
given in this column.

The Verizon Wireless
business-to-business
sales department
offers a Treo 700w
smartphone withouta
camera. If you
purchased your
smartphone from this
department, check
the packaging to see
if your smartphone
includes a camera.
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What's in the box?

You should have received all of the following items in the Treo 700w
smartphone box:

Hardware

e Treo 700w smartphone
e Rechargeable battery

e AC charger

e USB sync cable

e Headset

Documentation and software
e Read This First setup poster

e Treo 700w Smartphone for Verizon Quick Reference Guide
e Using Your Palm Treo 700w Smartphone (this guide)
e Getting Started CD that includes the following:

e Microsoft® Office Outlook® 2002
e ActiveSync® desktop synchronization software
e Additional software for your smartphone

e Welcome CD that includes the Palm Treo 700w Smartphone
Interactive User Guide

e Palm warranty

Using Your Treo 700w Smartphone



What you need to use your smartphone

As you work through the instructions in this guide, you need all the
items that came in the Treo 700w smartphone box (see “What's in the
box?” on page 2) as well as the following:

e An activated mobile account with data services
e A location with wireless coverage for your smartphone
* An electrical outlet

e The computer you want to synchronize your personal
information with

[ * 1 NOTE To use email, web browsing, or multimedia messaging, your
Verizon Wireless service plan must include data services.

Using Your Treo 700w Smartphone
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CHAPTER 1

Setting up your smartphone
and computer

=+ Did You Know?
The ringer switch
silences all sounds,
Palm® Treo™ 700w smartphone including music,
when you need quiet.
There is no need to

overview navigate menus.
Top view

Expansion
Antenna card slot Stylus

—— )
C ) o)

T

Infrared (IR) port Ringer switch




CHAPTER 1 Setting up your smartphone and computer

%k Tip Front view

Be careful not to

scratch or crush your

smartphone screen. Indicator light (phone
Do not store itin a and charge indicator)
place where other
items might damage
it. Visit
www.palm.com/
mytreo700wVerizon
to find a variety of
useful accessories,
including carrying
cases that protect the
screen.

Earpiece

5-way
navigator
Right action key

OK button

Volume

Side button

Left action
key

Microphone
Phone/Send
button

connector

Headset jack
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www.palm.com/mytreo700wVerizon
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Palm® Treo™ 700w smartphone overview

Back view

Self-portrait mirror Battery door release

Camera lens
(camera
smartphone
only)

Speaker

[ TIMPORTANT The Treo 700w smartphone speaker includes a large
magnet, so be sure not to store your smartphone near credit cards or
other items that could be demagnetized.

CHAPTER 1
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If your smartphone
does not turn on after
inserting the battery,
you need to connect it
to the AC charger to
charge it. If it still
doesn’t start, do a soft
reset. See
“Performing a soft
reset” on page 213.

You can buy an extra
battery as a spare for
long airplane trips or
periods of heavy data
use. Be sure to use
batteries from Palm
only.

Installing the battery

1.

Use one hand to press the battery door release and use the
other hand to slide the battery door downward to remove it
from your smartphone.

Align the battery contacts with the phone contacts inside
the battery compartment.

Insert the battery into the compartment at a 45-degree
angle and then press it into place.

Slide the battery door onto the back of the smartphone
until it clicks into place. Your smartphone screen turns on
and the Treo screen appears. Wait for the progress bar on
the Treo screen to fill and the Windows Mobile screen to
appear.

Follow the onscreen instructions to finish the installation.

Battery
contacts

Battery door
release
Phone

contacts

Using Your Treo 700w Smartphone



Charging the battery CHAPTER 1

Charging the battery + Did You Know?

. If your battery ever
Before using your Palm Treo 700w smartphone, you need to charge the becomes fully

battery. See “Battery life” on page 34 for tips on maximizing the life of drained, your info is

your smartphone’s battery. stored safely on your
smartphone until you

[ 1IMPORTANT Charge the battery for 3.5 hours, or until the indicator ~ recharge the battery

. . . or connect your
light is solid green. smartphone to a

power source.
1. Plug the AC charger into a wall outlet. If necessary, connect an
adapter. =+ Did You Know?
You can charge your

2. With the arrow on the connector facing up (toward your smartphone using

smartphone screen), connect the charger cable to the bottom of your USB cable. The
your smartphone. USB cable must be
directly connected to
o your computer or to
@ an externally

powered (not bus-
powered) USB hub.

Indicator light

Using Your Treo 700w Smartphone 9



CHAPTER 1 Setting up your smartphone and computer

Did You Know? 3. Check the indicator light to confirm your smartphone is charging.
Battery consumption e Solid red indicates your smartphone is charging.
varies based on ¢ Solid green indicates that your smartphone is fully charged.
personal usage.
Consumption factors When your smartphone is on (see “Turning your phone on and off” on

include signal

strength, page 11), the onscreen battery icon displays the charging status:

speakerphone usage, E A solid lightning bolt indicates that the battery is connected to

and the type of calls a wall outlet and is charging.

you make (data or

voice). E A shaded lightning bolt indicates that the battery is connected
to a wall outlet and is fully charged.

h‘*thelipndicator light | A partial battery without a lightning bolt indicates that the

does notturn on when battery is not connected to a wall outlet and it has some

you connect your power.

smartphone to the AC !  Anexclamation point (1) indicates that the battery needs to be

charger, double-check
the cable connection
and the electrical
outlet to which it is
connected.

charged immediately.

g | start ] Y| o= 555 Battery
Werizon Wireless S icon

Tapping the Battery ¥oicemail LfL
icon opens a window 2 SN
showing a percentage

level of charge left in
the battery.

Messaging
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Turning your smartphone on/off

The phone and the screen of your Palm Treo 700w smartphone can be
turned off and on separately. This means you can wake up the screen to
use just the organizer features of your device, without turning on the
phone. Also, when the screen is turned off the phone can be on and
ready for you to receive and make calls.

Turning your phone on and off

When you turn on your phone, it connects to a mobile network so that
you can make and receive phone calls and use other wireless services.

1. Press and hold Power/End @ to turn on your phone. When your
smartphone locates a signal, Verizon Wireless and the signal-
strength icon Y] appear at the top of the screen, indicating you can
use the phone and Internet features (if supported by the local
network).

2. Press and hold Power/End @ again to turn off your phone. When
your phone is off, the phone-off icon Y appears at the top of the
screen and your smartphone is not connected to any mobile
network. You can still use the organizer and other features.

Waking up the screen and turning it off

Wake up the screen and leave the phone turned off when you want to
use only the organizer features of your smartphone, for example, when
you're on a plane and want to look at your calendar. You can also turn
off your smartphone’s screen without turning off your smartphone’s
wireless features.

1. Press Power/End (¥) to wake up the screen.
2. Briefly press Power/End (@ to turn off the screen.

The indicator light
flashes green when
your phone is on and
you're inside a
coverage area. If
you're outside a
coverage area, the
indicator lightflashes
amber and no bars
appear in the signal-
strength icon.

If Sound Mode is on
you hear a series of
tones when you turn
your phone on and
off. For more info on
Sound Mode see
“Setting the ringer
switch” on page 180.

You can set how long
the screen stays on.
Press Start, select
Settings, select the
System tab, and then
select Power. Select
the Advanced tab,
and then increase the
On battery power
setting.

Using Your Treo 700w Smartphone



CHAPTER 1 Setting up your smartphone and computer

* Tip Making your first call

The Dial Lookup list
mightlappearl\j/\?hilb We recommend that you charge your Palm Treo 700w smartphone for a

you are dialing a full 3.5 hours (or until the indicator light is solid green) before using it
number. Continue for the first time.
entering numbers to

place the call. For 1. Turn on your phone (see “Turning your phone on and off” on page

more info on the Dial 11).

Lookup list, see -

“Dialing by contact 2. If you do not see your Today screen, T ep—
press Phone/send @ Yerizon Wireless 2

name” on page 41. .
3. If you have not activated your phone, Type a name o number

follow these steps to do so:

e Use the number pad on the keyboard
to enter ¥228 (these numbers appear
on the ZRRC letter keys).

¢ Press Phone/Send (&) to dial.

* Follow the voice prompts to activate
your phone. A service provisioning
message appears.

e Wait a few minutes until you see the Programming Successful!
message, and then press Dismiss < (left action key).

Messaging
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our first call

4. Use the number pad on the keyboard to
enter the number you want to call.

5. Press Phone/Send (& to dial.

¥ g | Start

Yerizon Wireless

[l Y| = 9:59

<e

6. When your call is complete, press Power/
End (@ to end the call.

Adjusting call volume

While a call is in progress, press the Volume
button on the side of your smartphone to adjust
call volume.

Messaging

Yolume

Volume button

CHAPTER 1

Using Your Treo 700w Smartphone
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If your phone number
doesn’t appear on the
Phone Settings
screen, press OK, and
then turn your phone
off and back on again.
Repeat steps 1-6. If
your phone number
still doesn’t appear,
your phone has not
been activated. Turn
your phone off, wait a
few hours, and then
turn on your phone
and repeat these
steps. If your phone
number still does not
appear, please
contact Verizon
Wireless for
assistance.

What's my number?

1.

Make sure your phone is on (see
“Turning your phone on and off” on
page 11).

If you do not see your Today screen,
press Phone/Send (&).

Press Menu —— (right action key).
Select Preferences > Phone Settings.

On the Phone tab, look for your phone
number below the title bar.

Press OK (@],

Look here for your
phone number

72 | settings

Phone - (408) §55 -2760

Dialpad:

YT

After calls from numbers that are not
in Contacts, ask if I want to add
themn.

Set ring tones For incoming calls.

Phone | Services | NEtWDrKl Security

Using Your Treo 700w Smartphone



Setting up your computer

You can enter or change information on your smartphone or in
Microsoft Office Outlook on your computer, and then synchronize to
automatically update the info in both places—no need to enter the info
twice. We strongly recommend that you synchronize your smartphone
and your computer frequently to keep your information up-to-date (and
backed up) in both locations.

Before you can synchronize, you need to install the desktop
synchronization software and connect the sync cable on your computer.
Even if you already installed a previous version of the ActiveSync®
software, you must install the software that came with your
smartphone on the Getting Started CD.

System requirements

Your computer should meet the following minimum system
requirements:

e Windows 2000 or XP (later versions may also be supported)

e 32MB of available memory (RAM)

e 170MB of free hard disk space

e CDdrive

e Available USB port

e USB sync cable (included with your Palm Treo 700w smartphone)

You can also
synchronize your
smartphone with a
Microsoft Exchange
Server using
Microsoft Office
Outlook. See “Setting
up an Exchange
Server email account”
on page 88.

If you want to
synchronize with a
personal information
manager (PIM) other
than Microsoft Office
Outlook, you must
install a third-party
solution. Contact the
PIM’s author or
vendor to learn if
software is available
for your Treo 700w
smartphone.

Using Your Treo 700w Smartphone



Check the following:

* You must have
Windows Media
Player 10 or later
installed on your
computer.

e If you are installing
on a computer at
work, make sure your
company allows you
to install new
software. Contact
your company’s

IT department for
help.

Need additional help
installing the desktop
software? See
“Trouble installing the
desktop software?” on
page 212.

Installing the desktop synchronization software

1. Close any applications that are currently running on your computer,
including those running in the background. Your computer needs to
have all its resources available to install the software.

2. Insert the Getting Started CD into the CD drive on your computer.

3. Follow the onscreen instructions during the installation. The Install
program prompts you to synchronize for the first time. See
“Synchronizing contacts and other info” on page 32 for more info
on synchronization.

Connecting your smartphone to your computer

[ * 1 NOTE If you're transferring from a previous Windows Mobile
device or from a Palm OS® device, you can learn more about how to
move content, such as pictures, music, and files, to your smartphone by
going to www.palm.com/us/support/Treo700wVerizon.

1. Plug the AC charger into a wall outlet. If necessary, connect an
adapter.

2. Plug the USB sync cable into an available USB port or into a
powered USB hub on your computer.

3. With the USB cable on the left, connect the sync cable to the bottom
of your smartphone.

4. Connect the charger cable to the connector on the sync cable.

Using Your Treo 700w Smartphone
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Setting up your computer CHAPTER 1

Xk Tip

For best performance,
plug your sync cable
directly into a USB
port on your
computer. If your
computer has USB
ports on both the front
and back, we suggest
using the back port. If
you use a USB hub,
make sure it is a
powered hub.

USB sync
cable

This button has

no function with
your Treo 700w

smartphone

Using Your Treo 700w Smartphone 17
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Moving around on your
smartphone

Moving around the screen

To move around the Palm® Treo™ 700w smartphone screen, you can
use the 5-way navigator or you can tap items on the screen with the
stylus. As you become familiar with your smartphone, you’ll find your
own favorite way to scroll, highlight, and select items.

The 5-way includes the Right b, Left 4, Up 4, Down ¥, and Center
buttons.

Center

CHAPTER 2

¥k Tip

Some third-party
applications may not
work with the 5-way
navigator, and you
must use the stylus
instead.

<4 Did You Know?
Custom navigation
features are available
when you browse the
web using Internet
Explorer. See
“Viewing a web
page” on page 104.

* Tip

The arrow icons that
indicate directions on
the 5-way are
different from the
onscreen scroll
arrows and the
arrows that indicate a
list is available (see
“Selecting options in
a list” on page 25).




When you are in
applications such as
Messaging, Internet
Explorer, and Word
Mobile, press and
hold Option while
pressing Left or Right
on the 5-way to
automatically go to
the top and bottom of
a screen.

Scrolling through screens

As on a computer, on your smartphone you scroll to move from field
to field or page to page, or in some cases to highlight an item or option
in a list.There are several methods of scrolling:

Press the 5-way on the front of your smartphone. Press Right >,
Left 4, Up 4, or Down ¥ to move to the next field, button, or action
in that direction.

Press and hold Option ) while pressing Up 4 or Down ¥ to scroll
one screen at a time. These keys work just like the Page Up and
Page Down keys on your computer keyboard.

Press and hold Option Q) while pressing Left 4 or Right I to jump

to the top or bottom of the current document or entry.

When viewing a screen with tabs,
such as when adding a contact,
press Down ¥ to scroll to the tabs,
and then press Left €4 or Right » to
move between tabs.

Scroll arrows

/4 | calendar Y [\ |
i os,05 [SMEwTEs B oa|r
Submit Final Draft

Meet with Donna 8 Nancy
10:00a-11:00a (Conference Call)

When inside a text field, press ~
Right » or Left € to move to the Lunch with Greg

next character, and press Up a or 12:00p-1:00p

Down ¥ to move between lines. Team meetiy H
1:00p-2:00p
When inside a list, press and hold Elgss

Up 4 or Down ¥ to rapidly scroll

through the list.

Scroll arrows

Tap an onscreen scroll arrow.

Tap and drag the slider of an onscreen scroll bar.

20
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Closing screens

To accept the information you entered on a screen and to return to the
previous screen, do one of the following:

e Press OK (@],

e Use the stylus to tap or in the upper-right corner of the
screen.

Highlighting and selecting items

On most screens, one item—a button, a list entry, or a check box—is
highlighted by default. The highlight identifies which item is affected by
your next action. Use the 5-way to move the highlight from one item to
another before opening or selecting it.

The highlight can take one of two forms, depending on what is
highlighted:

e Border glow: This rectangular border
highlights items such as an onscreen button [ Stop |
(such as OK, Dismiss, or Hide), a check box, o]
an option, or a web link.

* Reverse type (light text on B
a dark background): This Excel Mobie =
L

highlights items such as a phone g;‘tti'\?gskyﬁ'cma"
number, an email address, text, or
an itemin a list.

After highlighting an item with the 5-way, you can select or activate it by
pressing Center or by tapping the item with the stylus.

The bestway to learn
to use the 5-way is to
experiment. Press
the 5-way buttons
and as you do, follow
the movement of the
border glow around
the screen. The
behavior of the
5-way varies slightly
in each application.

Using Your Treo 700w Smartphone
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When text is
highlighted, you
can press Backspace
to delete the
highlighted text.

Highlighting text
You can use the 5-way or the stylus to highlight text on the screen:

e 5-way: Press and hold Shift Gy while pressing Right >, Left 4,
Up 4, or Down ¥ to extend the highlight in that direction.

e Stylus: Tap and drag the stylus across the text you want to
highlight. To highlight a word, double-tap it. To highlight a
paragraph, triple-tap it.

Using the action keys

The left and right action keys give you quick access to tasks that you can
do on the current screen, so the action key items vary from application
to application and from screen to screen. Look on the screen directly
above the action key to see the action that it does in the current context.
In some contexts, these keys may do nothing at all. In most cases the
right action key T opens the menu, and the left action key T
activates a specific command, such as New or Edit. Remember that
action key functions vary from screen to screen, so be sure to check the
onscreen label before pressing the action keys.

22
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Left action key
activates this
command

Right action key
activates this
command

Left action key

Selecting menu items

In many applications, a menu provides access to additional features.
The menu is hidden until you press Menu 2 (right action key). To get
the most out of your smartphone, it's a good idea to familiarize yourself
with the additional features available through the menu in various
applications.

1.

Press Menu 2 (right action key) to
display an application’s menu.

Press Up to highlight a
menu item.

or Down

If an arrow appears next to a menu item,
press Center or Right I to display
additional options for that item, and then
press Up a or Down ¥ to highlight a
menu item. To return to the main menu
without making a selection, press Left

Right action key

7 | calendar [ Y o=
wlos,0s [SMEwTEs B 9 b
Submit Final Draft

Meet with Dd
10:00=-11:004

New Appointment

Lunch with G
12:00p-1:00p

view »
Edit »
Options...

Class Filter »

Team meetin,
1:00p-2:00p

You can select most
menu items by
pressing a key on the
keyboard. To quickly
access a menu item,
press Menu (right
action key) followed
by the underlined
letter in the menu
item’s name.

Using Your Treo 700w Smartphone
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4. Press Center to select the menu item, or press Left € or
Menu —— (right action key) to close the menu and cancel your
selection.

Selecting options in a shortcut menu

Most applications also provide access to context-sensitive, shortcut
menus—similar to the right-click menus on a computer. The shortcut
menu options vary based on the highlighted selection.

1. Highlight the item you want to open N v

the shortcut menu for. Trs B 40
2. Press and hold Center to open the Submit Final Draft

Shortcut menu Meet with Donna & Nar

. New Appointment
. . Beam Appointment...

3. Press Up 4 or Down ¥ to highlight a Bricte Anmpicionars

menu item. =
4. Press Center to select the menu item Copy

or press Left € to cancel your selection.
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Selecting options in a list

Lists let you select from a range of options.
You can identify whether a list is available
when you select the field. If a rectangle
appears around the field along with a
downward-pointing arrow, a list is available.
Lists are different from the menus described
earlier in this section.

To select from a list, do any of the following:

e Use the 5-way to highlight the field, and
then press Center to display the
items in the list. Press Up 4 or Down
to highlight the item you want, and then
press Center to make your selection.

e Use your stylus to tap the arrow, and
then tap the item in the list.

e To exit the list and cancel your selection,
press Left

74 | calendar
Subject:
Location:

Starts: 7/5/05
Ends: 7/5/05
Al Day: Mo
Gceurs: Once
Reminder: Remind me
15 minuteds)
Cateqories; Mo cateqories...

12:00 PR
1:00 P

]

Appaintment: | Motes

enda EV|

Subject:

Menu

Lacation: [Meet with
starts: [Lunch
Ends: S‘HQEV
isi
All Day: icall
Oeuns: |Bjrtiyciay

Reminder: |Camplete

[Conference

Categories; MO cateqories...
Appainkment | Kotes

Menu

You can also tap and
hold an item with the
stylus to open the
shortcut menu.

When selecting fields
you might not see the
downward-pointing

arrow until you press
Center on the 5-way.

In fields where you
see a downward-
pointing arrow but
no rectangle, you
must tap the arrow
with the stylus to
expand the field.
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When using the
keyboard, most
people find it easiest
to hold the
smartphone with two
hands and to use the
tips of both thumbs
to press the keys.

You can change the
backlight shut-off
interval. Press Start
and select Settings.
Select the System
tab, and then select
Backlight. Set the
time interval on the
Battery Power tab
and on the External
Power tab.

You can turn off the
first letter
capitalization setting.
For details see
“Setting input
options” on

page 187.

The keyboard
backlight dims in
parallel to the screen
backlight.

Using the keyboard

) Left Right
action key action key
Phone/Send Power/End
Start OK
Backspace
Option Return
Shift Shift

Understanding the keyboard backlight

Your smartphone includes a keyboard backlight for low light
conditions. The keyboard backlight activates automatically when the
screen turns on. The backlight turns off automatically when the screen
turns off or when you are on a call or playing music in the background
for longer than the time specified in Backlight Settings. You can set
different time intervals depending on whether the smartphone is
operating on battery power or is connected to an external power
source. The backlight also turns off when an application’s power-saving
features turn it off.
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Entering lowercase and uppercase letters

By default, the first letter of each sentence or field is capitalized and the
remaining text you enter is lowercase. To enter other uppercase letters,
do one of the following:

e Press Shift Gy, and then enter a letter. You don’t need to press and
hold Shift while entering a letter.

e Press Shift G twice to turn on Caps Lock, and then enter a series of

letters. When Caps Lock is on, this symbol appears at the bottom of
the screen: #. To turn off Caps Lock, press Shift G again.

Entering numbers, punctuation, and symbols

Numbers, punctuation, and symbols appear above the letters on
the keys. To enter these characters, do one of the following:

e Press Option (), and then press the key of the desired character.
You don’t need to hold Option while pressing the key.

e Press Option () twice to turn on Option Lock, and then press the
desired keys to enter a series of characters. When Option Lock is on,
this symbol appears at the bottom of the screen: #. To turn off
Option Lock, press Option () again.

Entering other symbols and accented characters

You can enter symbols and accented characters that don't appear on
the keys using the alternate characters list.

The alternate
characters are
grouped according to
their similarity to the
corresponding key.
For example, the
alternate characters
available for the e key
are é, ¢, &, andé. If
you press the wrong
key, press Backspace
to return to the full list
of alternate
characters. You can
then press another
key.

If you don’t know
which key to press to
narrow the list when
entering a symbol,
you can scroll
through the full list
until you find the
character you want.
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1. Press Alt to display the alternate character list.
2. Narrow the list by pressing the key that corresponds to the character you want. For

example, to enter an é, press e. See the table on the next page for a list of corresponding

characters.
3. Press Up a or Down ¥ to highlight the desired character.
4. Press Center to insert the character.
Symbols and accented characters
Press Alt | to select... Press Alt to select... Press Alt | to select...
and and and
enter... enter... enter...
a daaddaadee o 60060ceo 0 o
A AAAAAAE || O 0000EO |1 i e
b orB K3 porP q 2 2
c ce¢eO© rorR ® 3 $ %
C C¢O© s RBSs§
e éeéeé S RSSs
E EEEE torT ™ $ £ f¥¢
i it u auda ! i
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Using the keyboard CHAPTER 2

Symbols and accented characters

Press Alt | to select... Press Alt to select... Press Alt | to select...

and and and

enter... enter... enter...

I it U uuiou ? ¢

lorL £ x or X xa ; =) -(5-)

n A y )7\7 L@+ | & _0%=+ANE
. -*/#(or | £¥¢[]1{}<>«»

N N Y Y v ) ©®° ~\g@yu|
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With the Start menu
open, you can press
the letter underlined in
the application’s name
to open the app. For
example, press H to
open Help. You can
also select the
shortcut icons at the
top of the Start menu
to open recently used
applications.

You can open apps by
pressing Option and
then pressing Phone/
Send, Start, or OK.
You can customize the
apps assigned to
these button
combinations; see
“Reassigning
buttons” on page 185
for details.

You can also open
Memory Settings from
the Start menu. Press
Start, select Settings,
select the System tab,
and then Memory.

Opening and closing applications

Opening applications
You can access all the applications on your smartphone through the
Start menu:

1.

Press Start (%) to open the
Start menu.

Use the 5-way navigator to
highlight the application
you want to use. To view . lorer @ %
additional applications, < "
select Programs. (G e
Press Center to open
the highlighted
application.

Download Downloads
Agent

Camera

Excel Mobile File Explorer Notes

(Optional) Press OK to return to Programs and open another
application. The current application continues to run in the
background.

Closing applications

You can have several applications open at once, so you don’t need to
exit an application to open another one. In most cases, applications
close automatically when available memory is low, but you can also
close applications manually.
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Using your Today screen CHAPTER 2

1. Press and hold OK to open Memory Settings. % Tip
2. On the Running Programs tab, do one of the following: If you press Phone/
e Select the application you want to close, and then select Stop Send while a number
to close it is highlighted, your
' smartphone dials the
e Select Stop All to close all of your open applications. number. If a number
is highlighted,
[ * ] NOTE If you press OK to return to Programs, the current deselect the number,
application continues to run in the background. or use the Start menu
to access the Today
screen.
Using your Today screen * Tip

Your Today screen is your home base. From your Today screen you can You can select a
quickly look up a contact, dial a phone number or speed dial button, see picture for your

your latest calendar appointments, see the number of unread email Today screen
background and

messages, and even display a web page. select which items

To access your Today screen, press Phone/Send (&]. appear in the Today
screen. See “Today

screen settings” on

. 73 | start il o 2:
Title bar and J b ] page 173 for details.

status info Yerizon Wireless i g

Speed dial
entries

@ Mo unread me

| Dial Lookup field

1 Web search field

@0 [search...

Messaging
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We recommend that
you download and
install the free backup
and restore app from
http://
www.palm.com/us/
support/enterprise/
software/. A backup
and restore app
preserves your data
and settings if your
smartphone is ever
lost or stolen, and it
protects your data
during a hard reset.

e Title bar and status info: See “What are all those icons?” on
page 38 to learn about the icons that appear in this area.

¢ Dial Lookup field: Begin typing the name or number you want to
look up. See “Dialing by contact name” on page 41 for more info.

e Web search field: Enter a word you want to find on the Internet
and press Center to begin the search (data services connection
required).

e Speed dial entries: Select the picture or button you want to dial.
See “Defining speed dial buttons” on page 54 to create your own.

Synchronizing contacts and other info

Each time you connect your smartphone to your computer, it
automatically synchronizes the items that are set to sync. You can
synchronize using a cable or you can sync wirelessly.

To use ActiveSync, you must first install the software from the Getting
Started CD that came with your smartphone. See “Installing the
desktop synchronization software” on page 16 for instructions.

To use Direct Push Technology, make sure you are accessing an
Exchange Server 2003 upgraded to Service Pack 2. See “Setting up an
Exchange Server email account” on page 88.

You can customize the sync settings (see “Setting synchronization
options” on page 161) or use the default settings to synchronize your
info in the following applications:

B3] Contacts 5] Calendar (= E-mail Tasks [C5iFavorites
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1. Connect your smartphone to your
computer. You should hear the
ActiveSync® tone.

2. Look for the ActiveSync icon +% at
the top of your smartphone’s
screen and the ActiveSync icon @
in the taskbar on your computer.

e |f you don't see the ActiveSync
icon, make sure the desktop
synchronization software that
came with your smartphone is
running on your computer.

e If you have any problems
synchronizing, see

This button has
no function with
your Treo 700w
smartphone

“Synchronization (ActiveSync® software)” on page 224 for

troubleshooting suggestions.
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You must charge your
smartphone fully
before using it the
first time. Wait until
the indicator light
turns solid green,
which may take up to
3.5 hours.

If the battery is fully
drained, it may take a
few moments for the
indicator light to turn
on while charging.

Battery life

Battery life depends on individual usage. When used as a smartphone,
your smartphone battery provides up to 4.7 hours of talk time or up to
15 days of standby time.

Maximizing battery life

You can increase your smartphone’s battery life by following a few easy
guidelines. Remember that battery life depends on how you use your
smartphone.

Charge your smartphone whenever you're at your desk, or charge
it overnight each day. The battery in your smartphone has a much
longer useful life when it is topped off frequently, versus charging
it after it is fully drained.

If you spend a lot of time using the camera (if included), games,
media players, eBooks, or other applications, keep an eye on the
battery icon and charge when necessary.

Your smartphone’s wireless features (phone, email, messaging, and
web) generally consume more power than the organizer features.
If you don’t plan to use the wireless features on your smartphone
for a while, turn off your wireless services (see “Turning Wireless
Services On/Off” on page 200). You can forward calls to a different
number or let all calls be picked up by voicemail (see “Forwarding
calls” on page 53). To see if your wireless services are on, tap the
phone-off icon Yy, and then select Wireless Manager.

Turn off your smartphone’s Bluetooth® wireless technology feature
when you do not need to make a Bluetooth connection.
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e As with any mobile phone, if you are in an area with no wireless
coverage, your smartphone searches for a signal, which consumes
power. If you cannot move to an area of better coverage,
temporarily turn off your phone (see “Turning your phone on and
off” on page 11).

e Turn down the screen brightness (see “Adjusting the brightness”
on page 183).

e Set your screen to turn off automatically after a shorter period of
inactivity (see “Viewing and optimizing power settings” on
page 199).

¢ Keep your battery away from direct sunlight and other sources of
heat. Temperatures over 120 degrees Farenheit (50 degrees Celsius)
can permanently reduce the capacity and life span of any
lithium-ion battery.

Where to learn more

For a quick introduction

¢ Quick Tour: The Quick Tour highlights many of your smartphone’s
features. It is already installed on your smartphone, and you can
open it at any time. Press Start (%), select Programs, and then select
Quick Tour g;ﬂ

If the battery drains
to the point where
your smartphone
doesn’tturn on, your
smartphone stores
your info safely until
you recharge the
battery. To avoid
draining the battery,
we recommend that
you charge and
synchronize every
day, especially if you
use your
smartphone often.
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While using your smartphone

Help: Many of the built-in applications include on-device Help, so
that you can learn about the tasks you can perform in that
application. To access Help, go to the application or screen you
want help with, press Start (%), and select Help.

Online support from Palm: For up-to-date downloads,
troubleshooting, and support information, check out
www.palm.com/us/support/Treo700w\Verizon.

If you need more information

Books: Many books on Windows Mobile devices are available in
local or online book retailers (look in the computers section), or visit
www.palm.com/mytreo700wVerizon.

Online forums: Consult online Treo 700w smartphone user
discussion groups to swap information and learn about
topics you may find nowhere else. Visit
www.palm.com/us/support/Treo700wVerizon for details.

Verizon Wireless Customer Care: For questions about your
mobile account or features available on the network, contact
Verizon Wireless Customer Care or visit www.verizonwireless.com
for the latest information and help.
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Using Your Phone

Phone overview % Tip
. . . . If you press Phone/
You can make and receive calls and store speed dial entries right from Send while a number

your Today screen. Be sure you know how to turn on your phone before is highlighted, your

reading this section (see “Turning your phone on and off” on page 11). device dials the
number. If a number

X X is highlighted,
[ ! TIMPORTANT Depending on where you are on a network and certain dese%ectgthe number,
coverage conditions, you might experience interruptions with your oruse the Start menu
phone operation while using a Wi-Fi card. Palm recommends that you to access the Today
screen.

turn off the phone radio when using any Wi-Fi card or remove the Wi-Fi
card when not in use to ensure that you can always make and receive
phone calls. For EMERGENCY calls, always remove the card from your
smartphone to ensure optimal connectivity.
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CHAPTER 3

)»» Key Term

1xRTT (Single carrier
[1x] radio
transmission
technology): A
wireless technology
that can provide fast
data transfer and
Internet access with
average speeds of 60-
80Kbps and bursts up

Accessing your Today screen
Press Phone/Send (&).

i | Start [ T = o:59

Verizon Wireless Sls

5| Type a name or number

B No

to 144Kbps.
Messaging

What are all those icons?

You can monitor the status of several items using icons at the top of

your Today screen:

L.! You missed an incoming call.

ﬁm You have a voicemail message.

You have a new email, text, or multimedia message.

@ An error occurred during synchronization.

@ You have more than one of the conditions listed above.

ZI] Your phone is on. The bars display the signal strength.
The stronger the signal, the more bars appear. If you are
outside a coverage area, no bars appear.
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bed

e

B

Your phone is off.

You are outside a Verizon Wireless coverage area and
roaming on another mobile service provider’s network.

A voice call is in progress.

You are in an area that supports NationalAccess (1xRTT)
data services.

You are in an area that supports BroadbandAccess (EVDO)
data services.

A NationalAccess data call is in progress. You can make
calls, but you cannot receive calls; any incoming calls go
to voicemail. When you make a call, the data transmission
is automatically interrupted.

A BroadbandAccess data call is in progress. You can still
make or receive calls. When you make or receive a call,
the data transmission is automatically interrupted.

Your phone is connected to a NationalAccess network, but
you are not actively transmitting data. You can still make
or receive calls.

Your phone is connected to a BroadbandAccess network,
but you are not actively transmitting data. You can still
make or receive calls.

Your Palm® Treo™ 700w smartphone is connected to a
computer or network which is providing a data
connection.

A data connection is not available or your phone is off.

During a voice call
you can send text
messages, but you
cannot use data
features such as such
as web browsing,
email, and MMS.

Data services may not
be available when
you are roaming on
partner networks.

EVDO (Evolution Data
Optimized): A
wireless broadband
technology that is
designed for very
high-speed data
transfer with average
download speeds of
400-600Kbps,
capable of reaching
speeds upto1.8Mbps,
and upload speeds up
to 156Kbps.
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To quickly turn the
Bluetooth feature on
and off, tap the
Bluetooth icon to
access the Bluetooth
Settings screen.

5

E

Your smartphone’s battery is low.

Your smartphone’s battery is charging.

Your smartphone is connected to a power outlet and
the battery is fully charged.

Your phone is on and you are in a Verizon Wireless
coverage area. If you are outside a coverage area, No
service or Roaming appears instead. When you turn
off your phone, Phone Off appears instead.

Voice privacy is preventing over-the-air eavesdropping.
Appears during a call when this option is turned on and
available on the Verizon Wireless network.

Location privacy is off and your location is available to
the Verizon Wireless network and other applications.

The Bluetooth® wireless technology status indicator
appears in gray when this feature is off, in blue when this
feature is on, and in reverse blue when your smartphone
is communicating with another Bluetooth device.

A call is in progress and your smartphone is connected to
a Bluetooth headset or car kit.
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Making calls

Your smartphone offers several ways to make phone calls. Try them all

and you’ll discover which methods you prefer.

Dialing with the number pad

1. Go to your Today screen (see
“Accessing your Today screen”
on page 38).

2. Using the numbered keys on the
keyboard, enter a phone number.

3. Press Phone/Send (&) to dial.

[ * TNOTE You do not need to press
Option to access the numbers on the
keyboard. However, when dialing short numbers, such as 411, the
number may conflict with a contact name. If this occurs, press
Option () to avoid starting a contact lookup. You can always dial 911
without pressing Option first.

Dialing by contact name

You can look up contacts quickly by entering just a few letters of a
contact’s name or phone number directly from your Today screen.
Before you can dial a call by contact name, you must create some
contacts (see “Adding a contact” on page 61) or import them by
synchronizing (see “Synchronizing contacts and other info” on
page 32).

Make sure your phone
is on (see “Turning
your phone on and
off” on page 11) and
that you're inside a
coverage area.

To see a contact’s
address, company,
and other details,
highlight the name
and press Center on
the 5-way.

To clear the Dial
Lookup field and start
another Contacts
search, press OK. To
delete letters when
correcting a
misspelled name,
press Backspace.

Afteryouinitiate acall,
you do not need to
press Option to access
the * and # keys when
responding to further
dialing instructions.
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After you look up a
contact, you can
select how you want
to communicate with
that person. Press
and hold Center on
the 5-way, and then
select the
communication
method you want

to use.

You can dial an
alternate number for
a contact with a
speed dial button.
Highlight the speed
dial button, press and
hold Center on the
5-way, and then
select a number from
the shortcut menu.

You can customize
the default speed dial
buttons. See “Editing
a speed dial button”
on page 56.

Go to your Today screen (see “Accessing your Today screen” on
page 38).

Using the keyboard, begin entering one
of the following for the contact you want

to call:

First name (JOH for John)
Last name (SMI for Smith)

First initial, a space, and then last initial

(J S for John Smith)

First name and last name
(JOH SMI for John Smith)

| | 23] 2ndlersan, Shla

| Saith, John
. Yoil (212) 555-4623 w

&

£ (2_’ Search... I[+]

Phone number (you don’t need to press

Option to access the number keys)

For example, entering SM finds both Smilla Anderson and John
Smith. Entering SM A finds only Smilla Anderson.

Select the number you want to dial.
Press Phone/Send (&) to dial.
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Dialing with a speed dial button
Before you can use a speed dial button, you
must create some speed dial entries. See
“Defining speed dial buttons” on page 54.

73| start [0 T e 2:41

63

I@ ‘Tvp.e.a name or number

You can make a call with your speed dial
buttons by doing any of the following:

R
=

i g_ql;nnnad C |
e Select a speed dial button with the 5-way, | s

and then press Center

e Tap a speed dial button with the stylus.

Messaging

e Press and hold a Quick Key that you
assign to the speed dial button.

To see more speed dial buttons, highlight the picture speed dial area
and press Right > or Left 4 repeatedly, or highlight the text speed dial
area and press Up 4, Down ¥, Right >, or Left

Dialing by company name
1. Press Start (&) and select Contacts.

2. Press Menu — (right action key) and
select View By > Company.

3. Press Phone/Send &) to go to your Today  |BEeEmr=
screen. [E=] Balm, Gaved
: . . Voi (650) 555-3599 m
4. Using the keyboard, begin entering the = 2o, Mana
first few letters of the company name. & {408) S55-2607 w
5. Select the number you want to dial. * B I~

6. Press Phone/Send (&) to dial.

You can hide your
speed dial buttons on
your Today Screen
and still use your
Quick Keys to call a
speed dial number.

Until you change the
View By setting, your
contact list (in the
Contacts application)
is also sorted by
company name.
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Dialing from a web page or message

If you can’t dial a Your smartphone recognizes most phone
phone number numbers that appear in web pages or in

directly from a web (text il lti dia)
page or a message, messages (text, email, or multimeadia).
Yellow Pages s

then highlight the 1. Use the 5-way to highlight the phone Yeloursoes.con

number, press and S
i
hold Center on the 5- number you want to dial in the web page Canadadll
or message.

way, and select Copy. white Pages s=
Open the Dial Pad, and 2. Press Center to open the Phone dialog = 2
then press and hold box, and then select Yes to dial.
Center on the 5-way to

Paste. Press Phone/ -
Send to dial. Redialing a recently called number

e To dial the last number you called:
Go to your Today screen, and then press

You can also access
the Call Log and Dial and hold Phone/Send &),
Pad from the Today e To select from your most recently

screen by pressing dialed numbers: Go to your Today
Menu (right action

key) and selecting Call screen, press Phone/Send (&), highlight

Log or Dial Pad. the number or contact name you want
to call, and then press Phone/Send (&)
to dial.

- - 3 Spear, Midyne
* To select from a chronological list of WQ (331) 555-3563 w
calls: Go to your Today screen, press fte fg;q‘;';g;j;"sgw
Phone/Send (&), and then select Call Log. [ L Spear, Midyne
Highlight the number you want to call, P (6:1) 5553563 w

and then press Call T (left action key)

'(f Spear, Midyne 7{3{05
] (Ba1) 5553560 w

to dial. : 7/2i05
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Making calls CHAPTER 3

Dialing using the onscreen Dial Pad + Did You Know?
The onscreen Dial Pad is useful when you need to dial numbers that are You can paste

expressed as letters, such as POPCORN to check the time, and when numbers directly into

. ) the Dial Pad. Copy a
you need large numbers that you can tap with your finger or stylus. number from another

1. Go to your Today screen. application, switch to
. Dial Pad, and then

2. Press Phone/Send (&) and then select Dial Pad from the menu. press and hold Center

3. Tap the onscreen Dial Pad to enter the number. on the 5-way to paste

4. Press Phone/Send (&) to dial. the number.

=+ Did You Know?
When you are on a
plane, you can turn off
your phone and all
wireless services
using Wireless
Manager (see
“Turning Wireless
Services On/Off” on
page 200). But you
Delete can still wake up the
screen and use any
app that doesn't
require wireless
services, like your
smartphone's
calendar, music
player, and games.
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See a picture of the
person calling you!
Learn how to assign a
caller ID picture in
“Assigning a picture
and ringtone ID to a
contact” on page 176.

You can also ignore a
call and send a text
message. Press Menu
(right action key) and
select Ignore with text
message.

If music is playing
when a call arrives,
the smartphone rings
softly. You can answer
the phone as you
normally would. The
audio pauses during
your call.

Receiving calls

To receive calls, your phone must be on.

To answer a call, do one of the following:

e  Press Phone/Send ).

e Press Answer —) (left action key).

e If the headset is attached, press the headset button.

To ignore a call and send it to voicemail, do one of the following:
* Press Power/End (9.
e Press Menu 2 (right action key) and select Ignore.

To silence the ringer while your smartphone is ringing:

e Press the Volume button or any key on your smartphone except
Phone/Send, Power/End, or the 5-way.

e To immediately silence all system sounds including the ringer, slide
the ringer switch to Sound Mode Off . All sounds remain off until
you slide the ringer switch back to Sound On ).

When you silence the ringer, you can either answer the call or let it ring
through to voicemail.
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Using voicemail

Setting up voicemail

1. Go to your Today screen.

2. Press and hold 1 on the keyboard to dial
Verizon Wireless's voicemail system.

3. Follow the voice prompts to set up
your voicemail.

Messaging

Voicemail notification

When you have a new voicemail message,
a notification screen appears. To hear your
message now, press Listen < (left action
key). To retrieve your message later, press
Dismiss C——— (right action key). When you
have unretrieved voicemail messages, a
Voicemail icon #2 appears at the top of your screen and the left action
key is labeled Voicemail.

New Yoicemail

L Mew woicemail 137 PM 7/5/05

Listen i Dismiss

Retrieving voicemail messages
1. Go to your Today screen.

2. Press and hold 1 on the keyboard to dial Verizon Wireless's
voicemail system.

3. Enter your voicemail password using the keyboard, or press Extra
Digits T (left action key) if you defined this option (see “Creating
a speed dial button” on page 54 for details).

4. Select Play ©» to listen to your messages.

When a Voicemail
icon appears at the
top of the screen,
you can tap this icon
to retrieve your
voicemail.

You do not need to
press Option to enter
numbers, %, or #
while on an active
call.

If you have trouble
accessing a
voicemail system, try
changing the Dial
Pad tone setting. See
“Selecting your call
settings” on

page 177.
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When a call lasts
longer than one
minute, the screen
dims and then turns
itself off. Press

any key, except
Power/End, to wake
up the screen.

You can send and
receive text messages
during a call. This is
a great way to stay
connected with
colleagues during

a long call.

Managing active calls

When you make or receive a call, the active call info appears on your
Today screen.

73| start [0 €] mm o:59

! ‘Type aname ar number

Midyne Spear
(831) 555-6737 m —

Current duration of call

Caller's name and number

During a call, you can do any of the following:

¢ Put the call on hold: Press Hold T (left action key). To take the
call off hold, press Off Hold = (left action key).

e Use the built-in speakerphone: Press Menu 2 (right action
key) and select Speakerphone. To return to the earpiece, press
Menu — (right action key) again and select Speakerphone Off.

¢  Mute the microphone so you can’t be heard: Press Menu ——
(right action key) and select Mute. To turn the microphone back on,
press Menu 2 (right action key) again and select Cancel Mute.

e Switch to another application: Press Start [#) and select the
application.
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Ending a call
Do one of the following:
* Press Power/End.(?).

e Press the headset button (if the headset is attached and has a button
on it). Some headsets do not have a button.

Returning to an active call from another application

You can use many other applications on your smartphone while
holding a phone conversation, including the organizer and SMS
features. You cannot browse the web or send and receive email or MMS
messages while on a voice call.

From any application, press Phone/Send @ to return to your
Today screen.

Saving phone numbers

Add Contact

After you complete acall, you are prompted (B31) B18-69G0 is not stared in contacts. Yau
ep ey . can create a new contact with this number or
to add the number if it is not already in your [copytandsddi to an existing contect.

Contacts list. Copy and Add...
Deont show this again,

e To create a new contact for this number,

select Create New Contact. Dismiss =)

e To add this number to an existing contact, select Copy and Add, and
then select a contact name.

e To decline adding the number, press Dismiss T (left action key).

e To permanently disable the Add Contact prompt, select Don’t show
this again.

You can also save
contact info from
other applications,
such as Messaging.

If an incoming call
uses caller ID
blocking, you do not
see the Add Contact
prompt.
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When the second call
is outgoing, you can
conference the two
calls, but you cannot
swap between them.

When the second call
is incoming, you can
swap between the
two calls, but you
cannot conference
them.

When two calls are
active and you press
Power/End, you hang
up both calls. To
return to the first call,
wait for the person on
the second call to
hang up.

If you don’t add a number right away, follow these steps to add it later:

1. Go to the Call Log (see “Redialing a recently called number” on

page 44).
2. Highlight the number you want to save.

3. Press and hold Center
select Save to Contacts.

4. Enter the information for the entry.
5. Press OK (@],

More ways to manage calls

Your Treo 700w smartphone offers many advanced telephone features,
including call waiting, three-way calling, and call forwarding.

Making a second call

You can make a second call while your first
call is still active. When you dial a second
number, the first call is automatically placed
on hold.

To dial a second number, use any of the
methods described in “Making calls” on
page 41. If you're dialing by contact name or
with the keyboard, you must first use the
5-way to select the Dial Lookup field.

£ | start [ ) =

to open the shortcut menu, and then

l@ ‘Tvp; a n;r‘-ne or number.

Active
00:04

Jane Faraola
(B31)555-7534 w

T

When two calls are active, your Today screen includes two call status

sections, each representing one of the calls.
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Answering a second call (call waiting)
When you're on a call and you receive a second call, the call-waiting
notification appears. You can do any of the following:

¢ Place the current call on hold and answer the new call:
Press Answer —— (left action key) or Phone/Send (&).

e Send the new call to voicemail: Press Menu 2 (right action
key) and select Ignore.

¢ Send the new caller a text message: Press Menu — (right
action key) and select Ignore with text message. The second call is
sent to voicemail.

* Hang up both calls: Press Power/End [¥). The second call is sent
to voicemail.
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If %72 and %73

do not turn call
forwarding on and
off, please contact
Verizon Wireless to
obtain the forwarding
codes for your area.

After you turn on call
forwarding, call your
smartphone to
confirm that call
forwarding is active.

Making a conference call

When the second call is outgoing, you can join two calls in a conference
session. Additional charges may apply and minutes in your mobile
account may be deducted for each active call. Please contact Verizon
Wireless for more information.

1. Put the first call on hold, and then place a
second call.

2. Press Conference T (left action key);
this joins the two active calls in a
conference.

3. When you're done, press End
Conference = (left action key); this
ends the second call and returns you to
the first call. If you're ready to hang up
both calls, press Power/End [¥) instead.

73| start [0 6| 4:40

Call in Progress

U Tvpe a name or number

Group Conference Active
00:51

<8
-8

End confer...

Using Flash mode during an Active call

Flash mode is an alternate way to manually manage your calls while
one or more calls are active. The preferred methods are described in
“Making a second call” on page 50, “Answering a second call (call
waiting)” on page 51, and “Making a conference call” on page 52.
When these methods don’t work, you can use Flash mode. This mode is
often used during a conference call when one of the calls has ended but
the other remains connected.

1. Press Phone/Send (&) from the Active Call screen.
2. Select Send Key (Flash).
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3. Press Flash < (left action key). Depending on the state of your
active call, pressing Flash does one of the following:

e If you have two active calls, you can swap between them.
e If you have one active call, you can dial another number.

e If you have one active call, you can dial another number. You can
press Flash ©——— (left action key) again to set up a conference
call.

e If you have two calls in conference, press Flash ———) (left action
key) to hang up the second call, and then dial another number.

4. Press Power/End (@) to exit Flash mode and end all calls.

Forwarding calls

You can forward calls to another phone number. Please check with
Verizon Wireless about availability and pricing of forwarded calls;
additional charges may apply.

1. Go to your Today screen.

2. Dial ¥72 followed by the number where you want to forward your
calls. For example: ¥72 415-555-1234.

3. Press Phone/Send (&) to dial.

4. When you're ready to turn off call forwarding, dial *73, and then
press Phone/Send (&).
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Viewing minutes usage
Keepinmindthatyour 1 Go to the Call Log (see “Redialing a recently called number” on

billing statement may

vary slightly from the page 44). . . . .
information you see 2. Press Menu 2 (right action key) and select Call Timers to view
onscreen. Usage is voice minutes or Data Log to view data minutes.

charged based on 3. (Optional) To reset the counters to zero, select Reset.

your calling plan, and

calling plans vary. 4. Press OK (@],

Defining speed dial buttons

Your smartphone lets you create both picture and text speed dial
buttons so that you can select a button on the Today screen to quickly
dial a number.

Creating a speed dial button
You can create up to 20 picture buttons and 50 text buttons.

1. Go to your Today screen.

2. Press Menu 2 (right action key) and
select New Speed Dial.

3. Do one of the following:

e Select Link to contact, select the contact
you want to link to this button, and then

74| start ] Y| &= z:06

Link:  Spear, Midyne

Lobel: e ) ]

Murnber: |(E31) 555-3563

Quick Key:

(7 Text Speed Dial

ial wi
select the number you want to dial with @ Picure Spoed
this button. spocddl [amd] |
Cancel i Delete

e Select Label and enter a name for this
button, and then select Number and
enter the phone number you want to dial with this button.
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4. (Optional) Enter a Quick Key. When the Today screen is showing,
you can press and hold the Quick Key to instantly dial this number
5. If this button is linked to a contact entry with a picture, select either

Text Speed Dial or Picture Speed Dial to indicate which type of

button you want to create. If this button is not linked to a contact or

the contact doesn’t have a picture, the Picture Speed Dial option is
not available.

6. (Optional) Select the Advanced tab and set
any of the following options:

e Extra Digits: Defines additional
numbers to dial, such as a password or
extension. In addition to numbers, you
can enter the following symbols: star
(%) and pound (#). To enter a one L]

74| start

G0 Y a=213 R

Exira Digts:

(Comma = pause 1 second)

Dial extra digits automatically
Show voice mail buttons
N@DTE

second pause, enter a comma (,). B e |

¢ Dial extra digits automatically: [ [=] Delete
Dials predefined Extra Digits
immediately after dialing the phone number. If you do not check
this box, you need to press Extra Digits —— (left action key) to
dial these digits.

e Show voice mail buttons: Displays the voicemail playback
controls after you dial this speed dial number. When this option
is checked, you can enter numbers below each control to tailor
the controls to your voicemail system.

% Plays the previous message.
Saves the current message.
[» Plays the current message.
i Deletes the current message.

You can add a special
ringtone to a contact
associated with the
speed-dial button. See
“Adding a contact” on
page 61.

Quick Keys can be
letters or numbers,
but you can’t use both
the letter and number
for the same key. For
example, the
voicemail Quick Key is
1. The letter
equivalentforthat key
is E, so you cannot
assign E as a Quick
Key to another speed
dial button.
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% Tip ®m Repeats the current message.
The playback controls > Plays the next message.
for the Verizon 7 Press OK _

Wireless Voicemail
speed dial button are

already set up for the Edltlng a speed dial button

Verizon Wireless 1. Go to your Today screen.

voicemail system. o . i
2. Highlight the speed dial button you want to edit.

* Tip ) 3. Press and hold Center to open the shortcut menu, and then
You can also edit a select Edit Speed Dial.

speed dial button by .

pressing Menu and 4. Make the desired changes.

selecting Speed Dial 5. Press OK (@].
Options, and then

lecting the butt . .
Souwmtioedi.  Deleting a speed dial button

1. Go to your Today screen.
2. Highlight the speed dial button you want to delete.

3. Press and hold Center to open the shortcut menu, and then
select Edit Speed Dial.

4. Press Delete — .
5. Select Yes to confirm deletion.
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Arranging your speed dial buttons

1.
2.

3.

Go to your Today screen.

Press Menu —— (right action key) and
select Speed Dial Options.

Highlight the button you want to move.

Press Option ) + Left < or Right ) to
move the button in that direction.
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You can use the
headset that came
with your
smartphone or
compatible third-
party headsets.

The headsetdesigned
for Treo 180/270/300
smartphones is not
compatible with the
Palm Treo 700w

Using a phone headset

You can connect a phone headset for hands-free operation. If you need
to use your smartphone while driving and this is permitted in your area,
we recommend using a phone headset or a hands-free car kit (sold
separately).

Headset button
Microphone

smartphone.
The headset button is context sensitive and it performs different actions
based on the situation. You can press the headset button to perform any
of the following tasks:
e Answer an incoming call
e Respond to call waiting
e Hang up all calls
e Swap between calls if the second call is an incoming call
e Create a conference call, if the second call is an outgoing call
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Headset specifications

Your smartphone works with headsets that have a 2.5mm, 3-pin
connector (look for two black bands on the plug). When in doubt, ask
the third-party headset manufacturer if the product is compatible with
Palm Treo 700w smartphones. If you hear a headset buzz or poor
microphone performance, your headset may be incompatible with your
smartphone.

Using a hands-free device with Bluetooth wireless
technology

Your Treo 700w smartphone is also compatible with many headsets and
car kits enabled with Bluetooth wireless technology version 1.1 or 1.2.
Please note, however, that you cannot use a Bluetooth headset to listen
to MP3 files on your smartphone.

For a list of compatible hands-free devices with Bluetooth wireless
technology, go to http://www.palm.com/us/products/smartphones/
treo700w/bluetooth.epl.

To learn how to set up and connect to Bluetooth devices, see
“Connecting to devices with Bluetooth® wireless technology” on
page 110.

Here are tips for working with a Bluetooth hands-free device:

e To transfer a call from the handset to a Bluetooth hands-free device
during a call, press Menu ——— (right action key) and select Connect
Bluetooth. To transfer the call back to the headset, press Menu ——
(right action key) and select Cancel Bluetooth.

e To transfer a call from a wired headset to a Bluetooth headset or car
kit that is within range and with which you‘ve previously set up a

To hear stereo
through the jack (such
as music), you need
to use a stereo
adapter or other
accessory (sold
separately). For info
on compatible audio
accessories, visit

www.palm.com/
mytreo700wVerizon.

If you have both a
compatible Bluetooth
headset and car kit,
the one you
connected to your
smartphone last
becomes the active
device.

To find out how to
transfer your contacts
from your
smartphone to your
car kit, go to http://
www.palm.com/us/
products/
smartphones/
treo700w/
bluetooth.epl.
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partnership (Bluetooth headset or car kit required, sold separately),
unplug the wired headset and press the button on the Bluetooth
headset or car kit.
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Staying Organized

Contacts

Adding a contact

1.
2.
3.

~N

Press Start and select Contacts.

Press New ———(left action key). Name:

. Picture:
Use the 5-way navigator to move between T
fields as you enter information. Department:

. . Company:
To add a caller ID picture that displays work tsh
when that person calls, select Picture, work Fax:
and then select Camera and take a picture, [ “"**
or select an existing picture from Details

the Thumbnail screen. E Menu

To assign the entry to one or more
categories, select Categories and then check the categories under
which you want this entry to appear.

To add a note to an entry, select the Notes tab.
To assign a ringtone to the entry, select Ring tone and select a tone.
After you enter all the information, press OK (@],

Install the latest
software from your
Getting Started CD.

If you have many
contacts to enter, it's
best to enter them in
Microsoft Office
Outlook on your
computer and then
sync. See
“Synchronizing
contacts and

other info” on

page 32 for details.

Be sure to enter
mobile numbers and
email addressesinthe
correct fields.
Otherwise Messaging
can't find this info
when you address a
message and
Calendar can't find
your contacts to invite
them to meetings.
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In the Contacts list,
press Up and Down
on the 5-way to move
to the previous or next
contact.

You can find a contact
by company name.
Press Menu and select
View By > Company.
Select a company
name to see the
contacts who work
there.

To view a particular
group of contacts,
press Menu, select
Filter, and then select
the category you want
to view.

Viewing or changing contact information

1.

o, wnDN

In the Contacts list (name view), begin entering one of the following
for the contact you want to view or edit:

* First name

e Last name

e First initial and last initial separated by a space

e Phone number

Select the entry you want to open.

Press Menu 7 (right action key) and select Edit.

Make changes to the entry as necessary.

Press OK [@].

Deleting a contact

1.
2.
3.

In the Contacts list, highlight the contact you want to delete.
Press Menu —— (right action key) and select Delete Contact.
Select Yes.

Customizing Contacts

1. Go to the Contacts list.
2. Press Menu 2 (right action key) and select Options.
You can also open 3. Set any of the following options:
%’g:,c;ir:g: g:ausrs ¢ Show alphabetical index: Displays the alphabet at the top of
Menu and select the Contacts list. You can use this index to find a contact.
Contacts. ¢ Show contact names only: Lets you fit more names on the
Contacts list by hiding everything but the contact’s name.
e Area code: Sets the default area code for new contact entries.
4. Press OK (@].
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Finding a contact in an online address book

In addition to having contacts on your device, you can also access
contact information from your organization’s online address book or
Global Address List (GAL). For more information, see “Adding an online
address book” on page 95.

1. Press Start [#) and select Contacts.

2. Press Menu —— (right action key), and select Find Online.

Calendar

Displaying your calendar
1. Press Start [#) and select Calendar.
2. Press Menu 2 (right action key) and select View.
3. Select one of the following views:
e Agenda: Shows your daily schedule in list format. Upcoming
appointments are bold, past appointments are dimmed.
¢ Day: Shows your daily schedule in day-planner format.
o Week: Shows your schedule for an entire week.
¢ Month: Shows your schedule for a whole month.
FF A morning appointment
4 An afternoon appointment
[l Both morning and evening appointments
[ An all-day event

e Year: Shows a calendar for a 6-month period.

Make sure you are
accessing an
Exchange Server
2003 upgraded to
Service Pack 2. Add
access to the online
address book to your
smartphone. See
“Adding an online
address book” on
page 95. After adding
the online address
book, you must
synchronize with the
Exchange Server in
order for the Find
Online option to
appear.

If you have several
appointments to
enter, it's most
efficientto enter them
in Microsoft Office
Outlook on

your computer and
then synchronize
your smartphone
with your computer.
Formoreinformation,
see “Synchronizing
contacts and

other info” on

page 32.
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4. Use the 5-way to move to another day, week, month, or year (based

To pencil in an on the current view).
appointment, open
the appointment, Creating an appointment
select Status, and then
select Tentative. 1. Press Start (&) and select Calendar. 22| calendar _
2. Press Menu — (right action key) and Subject: Wiriters' mesting
. select New Appointment. rocaton: Sonference cal
gztﬂgﬂgeﬁﬁ;’ﬁgtg:; 3. Enter'a Subject (description) and a A"ES:; i.m AM
Location. O\:curs; Every Wednesday
4. Select Starts and select the starting date Reminder: [Mene ]
and time. T
5. Select Ends and select the ending date Appointment: IR
and time.

6. Press OK [®].

Creating an untimed event

An untimed event, such as a birthday, anniversary, or vacation does not
occur at a particular time. These events appear as banners at the top of
your calendar; they don’t occupy blocks of time. For example, “Submit
Final Draft” in the screenshot shown here is an untimed event.
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-

Press Start (&) and select Calendar.

Press Menu —— (right action key) and
select New Appointment.

Enter a Subject (description).

Select the starting and ending dates.
Select All Day, and then select Yes.
Press OK (@].

N

B

/4 | calendar [ Y =

i os,05 [SMEwTEs B o

Submit Final Draft

Meet with Donna 8 Nancy =
10:00a-11:00a (Conference Call)

Lunch with Greg
12:00p-1:00p

Team meeting
1:00p-2:00p

<

Class

o
1
5
B

ay Menu
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To enter a birthday or
an anniversary, create
an untimed event that
repeats every year.

You can also add an
alarm when you
create the event.

Scheduling a repeating appointment

1.
2.
3.

4.

Create an appointment or untimed event, and then select it.
Press Edit ——.

Select Occurs, and then select a repeat pattern. To create a repeat
pattern, select Edit pattern and follow the onscreen instructions.

Press OK [@].

Adding an alarm reminder to an event

1.

2.
3.
4

Create an event, and then select it.
Press Edit ——.
Select Reminder, and then select Remind Me.

Enter the number of minutes, hours, days, or weeks before
the event you would like to receive the alarm.

Press OK (@],

£ | calendar

Subject: Birthday - Chris
Lacation:
Starts: may recurring
s Alldayrecuring 5
All Day: Yes

aceurs: [Every July 20 -

Reminder: Rermind me

3 dme — | Type of time units
Cateqaries;_Hersonal . .
pecintment | Hbtes] Number of time units
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Sending a meeting request

You can email meeting invitations to contacts who use Microsoft® Office

Outlook® or Outlook Mobile.

1. Create an event, and then select it.

2. Press Edit —— (left action key).

3. Select Attendees, and then select the name of the contact you want
to invite. To invite other attendees, select Add and select the names.

4. Press OK (@].

The next time you synchronize, the meeting request is sent to the

attendees. When attendees accept your meeting request, the meeting is

automatically added to their schedules. When you receive their
response, your calendar is updated as well.

Marking an event as sensitive

If other people have access to your Microsoft Office Outlook calendar
on your computer and you don’t want them to see an appointment, you
can mark that appointment as private to hide it from other Microsoft
Office Outlook users.

1. Create an event, and then select it.
2. Press Edit —— (left action key).
3. Select Sensitivity, and then select one of the following:

¢ Private: Displays the event on your smartphone and on your
computer. Meeting attendees or recipients see “Please treat this
as Private” near the top of an open appointment. If you sync with
Exchange Server, other users who can access your folders can’t

Create contact entries
with email addresses
for the people you
want to invite to a
meeting. You can’t
access contact entries
without email
addresses from your
calendar.

If you are using an
Exchange 2003 Server
with Service Pack 2,
you can use your
corporate Global
Address List to find
contact information
for an attendee. Select
Attendees, press
Menu, and then select
Find Online. Enter the
name of the attendee
and select Find.

If you don’t see an
option on the screen,
press Down on the
5-way to scroll to
other options. For
example, when
editing an event, you
don’t see the
Sensitivity option
until you scroll toward
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see your private events; they see private events as unavailable
time slots.

e Personal: Displays the event on your smartphone and on your
computer. Meeting attendees or recipients see “Please treat this
as Personal” near the top of an open appointment.

e Confidential: Displays the event on your smartphone and on
your computer. Meeting attendees or recipients see “Please treat
this as Confidential” near the top of an open appointment.

4. Press OK [@].

Organizing your schedule
Use categories to view different types of events.

1. Create an event, and then select it. T
2. Press Edit —— (left action key). [W[Business
3. Select Category, and then check the
categories which apply to this event.
To add a new category, press
New T (left action key), enter the
category name, and then press OK [@].

4. Press OK (&) two more times.

5. After you assign events to categories,
press Menu > (right action key) and
select Filter.

6. Select the type of events you want to view.
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Deleting an event

1. Highlight the event you want to delete. Not all icons appear in
. . . all Calendar views.

2. Press Menu —— (right action key) and select Delete Appointment.

3. Select Yes.

Customizing Calendar
1. Press Menu 2 (right action key) and
select Options.
2. On the General tab, set any of the
following options:
¢ 1st day of week: Sets Sunday or
Monday as the first day of the week
for all Calendar views.
¢ Week view: Sets whether five, six, or
seven days appear in Week View.
¢ Show half hour slots: Sets whether
time slots appear in one hour or half-hour increments in Day
View and Week View.
e Show week numbers: Sets whether week numbers (1-52)
appear in Week View.

74 | calendar

Options

1t day of wesk:

Wk view: S-day wesk -

[ show half hrour shots
[ show week numbers

General | Appaintments
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3. Select the Appointments tab and set any
of the following options:

e Set reminders for new items: Sets
whether a reminder is automatically
added to new events and how long
before the event the reminder appears.
You can override this setting for
individual events.

e Show icons: Sets which icons appear
next to events.
i The event has a reminder.
S The event repeats in a specified pattern.
& The event has a note attached.
@ A location has been assigned to the event.
#@ The event is a meeting.
# The event is marked private.

£ 4| calendar [ Y| =GR
Dptions

Set reminders For new items

‘15 v‘ |mmute(s) v‘
sowies: [RIB|EE]B]P]
S
—

¢ Send meeting requests via: Sets the Messaging method used
to send meeting requests: email, MMS, or SMS.

4. Press OK (@],
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Tasks

You can use Tasks to remind you of tasks you need to complete and to
keep a record of completed tasks.

Adding a task

1. Press Start (&) and select Programs.

2. Select Tasks .
3. Press New — ).
4. Enter a description of the task as the Subject.
5. Set any of the following: oy T
. . . - K
¢ Priority: Sets the priority level for this Subject: Create chart
task. Later you can arrange your tasks "S':"t'Wj :z;rgz‘m e
based on the importance of each task. R
e Status: Indicates whether the task is Dus: ;fﬂfZUUS
cCurs: nce
now compIEted' R:ninder: Remind me
e Starts: Specifies when the task T/A5/2005 800 AM
begins. Cateanries;

¢ Due: Sets the due date for the task.

e Occurs: Indicates if the task repeats
at regular intervals and how often it repeats.

e Reminder: Sets an alarm for this task and indicates when you
want to be reminded.

e Categories: Assigns the task to one or more categories.

e Sensitivity: Marks this task as Normal, Personal, Private, or
Confidential.

* Notes: Lets you enter additional text for the task.

6. Press OK (@].

If you want to use
Tasks Over the Air
(OTA)
synchronization,
install the software
from your Getting
Started CD. OTA
features also require
an Exchange Server
2003 upgrade to
Service Pack 2. The
option to synchronize
tasks wirelessly inthe
ActiveSync
application appears
only if you have the
appropriate sever.

You can also add a
task by selecting the
Tasks entry bar at the
top of the screen.
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You can also mark a
task complete by
tapping the check box
next to the task on the
Tasks list.

Overdue tasks appear
in red.

Checking off a task 23| Tasks Y=

1.

2.
3.
4.

Organizing your tasks

1.

Select the task you want to check off. [t[+][tanheretoadd anewtask |

. . @ Ccall Becky
Press Edit —— (left action key). Rick i oy EIEBRITiE
d dad d
Select Status and select Completed. ot et
Update glossary
Press OK (@], Create chart

In the Tasks list, press Menu —— (right
action key) and select Filter.

Select which tasks you want to view: All Tasks, Recently Viewed,
No Categories, Active Tasks, Completed Tasks, or a specific
category, such as Business or Personal.

Press Menu > (right action key) and select Sort By.

Select the sort method: Status, Priority, Subject, Start Date, or
Due Date.
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Deleting a task

1. Highlight the task you want to delete.

2. Press Menu —— (right action key) and select Delete Task.
3. Select Yes.

Customizing Tasks

1. Go to the Tasks list.

2. Press Menu 2 (right action key) and select Options.
3. Set any of the following options:

e Set reminders for new items: Automatically adds a reminder
to new tasks. The default reminder is set to 8:00 on the morning
the task is due. You can override this setting for individual tasks.

e Show start and due dates: Displays task start and due dates in
the Tasks list.

¢ Show Tasks entry bar: Displays the Tasks entry bar at the top
of the Tasks list.

4. Press OK (@].
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Install the software
from your Getting
Started CD that came
with your
smartphone.

You can add several
voice notes within a

Notes

Notes are a great way to capture thoughts, questions, and meeting
notes on your Palm Treo 700w smartphone.

Creating a note
1. Press Start [#) and select Programs.

2. Select Notes [.
3. Press New T (left action key).
4.

single note.
Do one of the following:
e Type the text with the keyboard.
e Write the text with the stylus.
e Draw a sketch with the stylus,
crossing at least three ruled lines.
5. Press OK (@],
Recording a voice note
You can create a new voice note or add a recording to an existing note.
1. Press Start [#) and select Programs. 22 | Notes
2. Select Notes [_].
3. To add a recording to a note, open the
note you want to add the recording to. To
create a new voice note, skip this step.
4. Press Menu 2 (right action key) and
select View Recording Toolbar.
5. Select [#] to begin recording. . Ew ‘ ‘ ol
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8.

Speak into your smartphone's microphone or hold it close to
another sound source.

When you finish recording, select [=] to stop recording. A Recording
icon appears in the note or note list, depending on where you
recorded the note.

Press OK (@].

Creating a note from a template

oo pON =

Go to the Notes list.

Select the Show list in the upper-left, and then select Templates.
Open the template you want to use.

Enter the information.

Press OK (@].

Rename the note and move it to the appropriate folder. See
“Organizing your notes” on page 75 for details.

Organizing your notes

You can rename your notes, move notes to another folder, and move
notes between your smartphone and an expansion (storage) card.

IZIRE

Go to the Notes list and highlight a note you want to move.

Press Menu C—— (right action key) and select Rename/Move.
Select Name, and then enter a new name for the note.

Select Folder, and then select the folder you want to store the note.
Select Location, and then select Main memory or Storage Card.
Press OK [@].

To play a recording,
select the voice note
in the Notes list or
open the note
containing the
recording and select
the Recording icon.

To create a new
template, open the
note you want to save
as a template. Press
Menu and select
Rename/Move. Select
Name, and then enter
a name for the
template. Select the
Show list, and then
select Template.
Press OK.
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To create a new folder,
go to the Notes list,
select the Show list in
the upper-left, and
then select Add/
Delete. Select New,
enter a name for

the folder, and then
press OK.

Select the Show list in the upper-left, and then select the folder you
want to view.

Select the Sort By list in the upperright, and then select whether
you want to sort your notes by Name, Date, Size, or Type.

Deleting a note

1.
2.
3.

Go to the Notes list and highlight the note you want to delete.
Press Menu —— (right action key) and select Delete.
Select Yes.

Customizing Notes

1.
2.
3.

Go to the Notes list.

Press Menu T (right action key) and select Options.

Set any of the following options:

¢ Default mode: Sets the default entry mode to Writing or
Typing.

e Default template: Sets the default template for new notes.

e Save to: Sets the default location where new notes are stored.

* Record button action: Sets whether the Side button opens the
Notes application or stays in the current application.

Press OK (@],
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Calculator

You can use Calculator for basic arithmetic
calculations, such as addition, subtraction,
multiplication, and division.

Performing calculations
1.
2.
3.

Press Start (&) and select Programs.
Select Calculator .

Enter numbers and perform calculations,
including the following:

[«] Clears the last digit in a multi-digit
entry.

() Clears the current calculation or the displayed number.
@ Calculates the reciprocal of a number.

(% Calculates percentage.

= Calculates the square root of a number.

) Switches a number between negative and positive.

Using the Calculator memory

To store a number, select the box to the left of the entry box. An M
appears in the box.

To add the displayed number to the number stored in memory,
select (%),

To display the number stored in memory, select @?}

To clear the memory, select @

You can tap the
screen or use the
keyboard to input
numbers.

When you store a
numberin memory, it
replaces the one that
is currently stored.

To paste a number
you copied in another
application, press
Edit and select Paste.
To copy a number,
press Edit and select
Copy. You can paste
the copied number in
another application.

For more advanced
calculations, use
Excel Mobile. See
“Excel Mobile” on
page 142 for details.
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Using Email and Other
Wireless Services

Sending and receiving messages
and emalil

You can use the Messaging application to exchange email, brief text
messages (SMS), and multimedia messages (MMS) with other mobile
devices and email addresses that support these forms of messaging.
You can also exchange instant messages (IM) with Pocket MSN. Before
you use your smartphone to send or receive messages, consult Verizon
Wireless for pricing and availability of email, text, multimedia, and IM
messaging services.

Creating and sending a text message

Each text message can hold up to 160 characters. To save time, you can
select from predefined My Text phrases, such as “Call me” or “On my
way.” You can add your own My Text phrases, and if you prefer, you
can enter the full message text too.

1. Go to your Today screen.

2. Press Messaging ——) (left action key).

3. Press Left €4 until you see Text Messages in the title bar.

4. Press New T (left action key).

Do the following:

e Make sure your
phone is on before
you send or receive
messages.

e For delivery of
Outlook email using
Direct Push
Technology, install
the software from
your Getting Started
CD. This feature also
requires an Exchange
Server 2003 upgrade
to Service Pack 2.

When addressing a
message, you can
enter the first few
numbers of a
contact’s mobile
phone number or the
contact’s first and last
initials separated by a
space.
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You can send and
receive text messages
even while you are on
a phone call. This is
easiest when using a
hands-free headset or
the speakerphone.

Some symbols can’t
be used in text
messages. Invalid
characters are
automatically
replaced by the
Messaging
application.

Do one of the following to address the

/| Text Messages G0 ) == BR
message:

To: 'Midyne Spear" <(531
e [f the recipient’s name and mobile 255-3563

number are in your Contacts list, type
the first few letters of the first or last on my way. |
name or simply enter the first initial, 4170
followed by a space, and then the last
initial to find a name.

e [f the recipient’s name is in an online
address book, press Center , enter
the name, press Menu 2 (right action key), and then select
Find Online. Select the name, and then select to use either the
phone number or email address. For more information, see
“Adding an online address book” on page 95 and “Using an
online address book” on page 96.

e |f the recipient’s name and mobile number are not in your
Contacts list, enter the full mobile number or email address.
Enter your message, or press Menu — (right action key), select

My Text, and then select a predefined phrase you want to insert.

(Optional) Press Menu —— (right action key) and select Spell

Check.

(Optional) Press Menu 2 (right action key) and select Message

Options. Enter a callback number and then select OK.

Press Send T (left action key).
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Creating and sending a multimedia message

Multimedia messages consist of pictures, videos, text, and sounds
presented as one or more slides. Even if your smartphone does not
include a camera, you can still send, receive, and view pictures and
videos. You can include any of the following items:

Ringtones
e MIDI

Sound clips

o WAV

e QCELP
Pictures

e JPEG

e GIF
Videos

e 3G2

1. Go to your Today screen.
2. Press Messaging ©—) (left action key).
3. Press Left € until you see MMS in the title bar.

To address a message
to multiple recipients,
separate the
addresses with a
semicolon (;). If you
address a single text
to three people, you
are billed for three
messages; if you
address a multimedia
message to three
people, you are billed
for one message.
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To add a new My Text
phrase, select Edit My
Text Messages in the
list.

A multimedia
message can contain
up to 350KB that
consists of multiple
items (up to 16
slides).

While creating a
message, select the
arrows at the bottom
of the screen to move
between slides.

~N

Press New T (left action key).

Do one of the following to address the
message:

To: jane@anycorp.com
Subject: Yow!

If the recipient’s name and mobile
number are in your Contacts list, type
the first few letters of the first or last
name; or simply enter the first initial,
followed by a space, and then the last
initial to find a name.

If the recipient’s name is in an online

address book, press Center , enter the name, press

Menu —— (right action key), and then select Find Online. Select
the name, and then select to use either the phone number or
email address. For more information, see “Adding an online
address book” on page 95 and “Using an online address book”
on page 96.

If the recipient’s name and mobile number or email address are
not in your Contacts list, enter the full mobile number or email
address.

NEW SLIDE

Preview [»

Select Subject and enter a title for the message.
Select New Slide.

Press Center

and select one of the following:

Add Picture: Lets you insert a picture. You can take the picture
with the built-in camera or insert an existing picture.

Add Video: Lets you insert a video. You can capture a video
with the built-in camera or insert an existing video clip. If you
insert a video, you cannot add any more pictures, videos, or
sounds to that message.
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e Add Sound: Lets you record a message, such as a voice caption
for a picture, or insert an existing sound, such as a ringtone. You
can add one sound per slide; to send more than one sound in a
message, add another slide to your message. If you capture a
picture with the built-in camera and save it with a voice caption,
the voice caption does not count as a sound file.
9. Enter a text caption or message for the item you inserted.
10. Select Next [:] and repeat steps 8-9 to add other items in this
message.
11. (Optional) Select Preview [> to view the message as the recipient
will see it.
12. When you're done creating the message, press OK (el.
13. Press Send T (left action key).

Receiving text and multimedia messages

When your phone is on and in a wireless coverage area, you
automatically receive new text messages. For multimedia messages,
you can set your smartphone to automatically download new messages
or to notify you that messages are ready to download. You can also
set your smartphone to notify you when a new text or multimedia
message arrives.

The new message notification may include any of the following options:

e View: Opens the message so you can view its full contents.

e Download: Downloads the rest of the message from the server.

e Reply: Opens a message addressed to the sender’s phone number.
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When viewing a
message, you can
press Right on the
5-way to move to the
next message in that
account, or press Left
on the 5-way to move
to the previous
message in that
account.

When you respond to
a text message from
the SMS list view,
you can change the
phone number
before sending the
response. Open the
text message and
enter your reply.
Press Send. Edit the
phone number, or
add an area code or
county code. Select
Call to send the

Dismiss: Closes the notification and puts the message in your
Inbox.

Menu: Opens a menu where you can select other options.

New Text Message New Media Message

6245 You have a new media message
555-1234@vtaxt.com (Ross) Check out the From:

5555551111
Subject: Take alook at this...
Size:  31KB

Date:  7/22/07 8:10 AM

cool accessories at www, palm.com

E Dismiss

Viewing/playing a multimedia message

1.

2.
3.
4

Go to your Today screen.
Press Messaging T (left action key).
Press Left 4 until you see MMS in the title bar.

From the Inbox, select the message you
want to view.

If you're viewing the message for the first
time, playback begins automatically.
Otherwise, select an item to play.

Do any of the following:

Thig i the flower you gave me.

* Go the previous or next slide: o
Tap Previous |¢] or Next [].

message.
¢ Pause or resume playback:
Tap Pause [|[] or Play [
e Save the item that is playing: Press Menu C— (right action
key) and select Save.
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¢ Go to the top of the message: Press Menu 2 (right action
key) and select Message Overview.

¢ Reply to the message: Press Menu (0 (right action key) and
select Reply or Reply All.

e Call the sender: Press Menu 2 (right action key) and select
Call Sender.

e Save the message as a template for other messages:
Press Menu 2 (right action key) and select Save to Template.

7. Press OK (@],
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If you are out of a
coverage area or if
your phone is off, your
outgoing messages
go into the Outbox.
When you return to a
coverage area, your
pending messages are
sent automatically
and transferred to the
Sent folder.

If your email account
requires a VPN
connection to
establish a secure
connection, you must
install a VPN
application (sold
separately) on your
smartphone before
you can access

your email. See
“Connecting to a
VPN" on page 207
for more info.

You can receive email
messages in different
formats, including
HTML, RTF, and plain
text.

Setting up an email account

You can use your smartphone to access several types of email
accounts. Before you set up your email account on your smartphone,
you must determine which type of account you want to access, as the
steps vary for each of the following account types:

Exchange Server: Enables you to wirelessly synchronize your
email and other information directly with the information stored on
a Microsoft Exchange 2003 Server.

When the Exchange Server 2003 is upgraded to Service Pack 2, new
features are available that allow you to access online address books
and use Direct Push Technology. These features include Global
Address List, Tasks Over The Air (OTA), and IP-based push updating
of Outlook information.

Direct Push Technology is the two-way wireless delivery method
used between Microsoft Exchange 2003 with SP2 (Service Pack 2)
servers and a smartphone with Windows Mobile 5.0 with MSFP
(Messaging and Security Feature Pack) for Outlook information
(Email, Calendar, Contacts, and Tasks).

Direct Push Technology uses an Internet Protocol (IP)-based
methodology rather than SMS-based methodology resulting in
lower network overhead, lower costs, and more efficient
communications.

Wireless Sync: Enables you to use a Verizon Wireless Sync
account to wirelessly synchronize your email and other information
with the information stored on your computer (Verizon Wireless
Sync account required, additional charges may apply).
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e IMAP or POP: Enables you to send and receive email messages with
a corporate email account or an account that you have with an
Internet service provider (ISP).

e Hotmail: Enables you to send and receive email messages with an
MSN Hotmail account. See”Using Pocket MSN"” on page 103 for
information on setting up an MSN Hotmail account.
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Do the following:

¢ |nstall the software
from the Getting
Started CD.

e For delivery of
Outlook email using
Direct Push
Technology, make
sure that your
Exchange Server 2003
is upgraded to
Service Pack 2.

If you already set up
an Exchange Server
account, Add Server
Source does not
appear on the menu;
Configure Server
appears on the menu
instead.

The Exchange Server
settings are case-
sensitive. Be sure to
enter uppercase and
lowercase letters
properly.

Setting up an Exchange Server email account

You can use your smartphone to sync directly with Exchange Server
using Exchange ActiveSync. You may have already set up your
Exchange Server email settings when you installed the ActiveSync®
desktop software. If you did not set up an Exchange Server email
account, work with your system administrator to gather the following
info, and then follow the steps in this section to set up an account now.

PN

Mail server address and domain name

Your username and password

Press Start (&) and select Programs.

Select ActiveSync @.

Press Menu —— (right action key) and select Add Server Source.
Enter the Server address, and then press Next ——— (right action
key).

Enter your username, password, and domain. The password is
case-sensitive. Your password can use numbers and text. Check if
your Caps Lock and Option Lock are active because that can affect
the password you are entering. See “Entering lowercase and
uppercase letters” on page 27 and “Entering numbers, punctuation,
and symbols” on page 27.

If you want to enter your password each time you access this
account, do not check the Save password box. If you want your
password entered automatically, check this box.
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£ 2 | activesync

Edit Server Settings

[l Y| &=

(7]

74 | Activesync ] Y| &=

Edit Server Settings

Server address:

[This server requires an encrypred (5511
lconnection

Cancel

7. (Optional) Select Advanced to set the
rules for fixing sync conflicts.

8. Press Next —_— (right action key) and
check the boxes for the types of
information you want to synchronize

with Exchange Server.

9. (Optional) Highlight one of the items
and select Settings to change the
synchronization settings for that type

of information.

User narme:

Password:

L 1
L 1
L 1

Darnair:

[1 save password
(required for sutomatic sync)

72 | activesync

Edit Server Settings

0 Y| &=

Choose the data you want to synchronize:

10. Press Finish —— (right action key).

11. Synchronize with your Exchange Server and set your sync schedule.
See “Setting a sync schedule with an Exchange Server” on page 90.

Finish

[ * ] NOTE Settings are not available for all items. If you want to

download more than the email message header, select E-mail in step 9
and increase the KB setting. If you don’t increase this setting, you can

manually download the rest of the message at your convenience.

Ask your system
administrator if it is
OK to store your
corporate email
password on your
smartphone. You
may need to enter
your password each
time you access your
email for increased
security.

If you have problems
sending mail, try
using the following
outgoing mail
settings:

Username: (9-digit
phone
number)@vzmail.net

Password: (Your
www.vtext.com
password)
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Set up an Exchange

Server email account.

See “Setting up an
Exchange Server
email account” on
page 88.

Setting a sync schedule with an Exchange Server

Follow these steps to set your sync schedule:
1.
2.
3.

Press Start (&) and select Programs.
Select ActiveSync @.

Press Menu > (right action key) and
select Schedule.

Set your schedule for peak and off-peak
times. To conserve power it is
recommended to change your settings
to synchronize every 30 or 60 minutes
instead of as items arrive.

Set your roaming preference. By

£ 2 | activesync
Schedule [7]

sync during
Peak times:

Off-peak times: |Every 4 hours -
[[] use above settings when raaming
Send outgaing items immediately

Adjust peak times to it your scheduls.
Set up device bo sync when new items artive.

default, a scheduled sync does not work while you are roaming.
This is to prevent roaming charges on your account. If roaming
charges are not a concern, select Use above settings while roaming.

Press OK (@],
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Setting up a Wireless Sync email account

Wireless Sync lets you sync your email and other information when
you're away from your computer. To use Wireless Sync, you must first
install the desktop synchronization software that came with your
smartphone, and you must subscribe to Verizon Wireless's Wireless
Sync feature (additional charges may apply).

1. If you haven't already done so, go to
http://www.wirelesssync.vzw.com to do the following:

e Create your Wireless Sync account. Click Register and then Setup
Wireless Sync Now.

e Click Next and then follow the onscreen instructions.

e When prompted, enter a temporary password and then select an
official password.

¢ Indicate which email accounts you want to use with this feature.
(This may require info about your mail server from your system
administrator.)

¢ Install the Wireless Sync desktop software.
2. On your smartphone, press Start (&) and select Programs.
Select Wireless Sync #$\v.

4. Press Start —— (left action key) and then wait a few minutes for
the installation to complete.

5. When the following message appears on your smartphone screen:
Have you created your Wireless Sync account yet?, select Yes.

6. Select Sync near the top of the screen.

7. When the Authentication dialog box appears, enter the password
for your Wireless Sync account.

w

Make sure your phone
is on.

For corporate email
accounts, the default
settings do a wireless
sync whenever info
changes in Microsoft®
Office Outlook®. To
find out how often you
can expect message
delivery, contact your
system administrator
and ask about your
company'’s server
settings. For Internet
email accounts, the
default settings do a
wireless sync every 30
minutes. To customize
your Wireless Sync
settings, select Setup
at the bottom of the
screen, and then
select Push/
ReadySync.
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Work with your
system administrator
to gather the
following info:

e Accounttype (POP3
or IMAP)

® Mail server name
for receiving mail

e Mail server name
for sending mail

¢ Yourusername and
password

e Domain name

e Any special
security requirements

If you have problems
configuring your
account, go to
www.palm.com/

emailsetup for more
information.

8. When the First Synchronization dialog box appears, do one of the
following based on the type of email account you set up:

e Corporate email or both: Select Refresh.
¢ Internet email: Select Merge.

Setting up an IMAP or POP email account

You can send and receive email messages
with an email account that you have with an

72| pop3

[l Y| &=

E-mail Setup (2/5) 9

Internet service provider (ISP), an email
account that you access using a VPN server
connection (such as a work account), or any
other IMAP (Internet Message Access
Protocol) or POP email account.

1. Go to your Today screen.
2. Press Messaging ——) (left action key).

3. Press Menu 2 (right action key) and
select Tools > New Account.

4. Enter the email address that you want to

g |rora

Auto configuration

Attempting to automatically configure your
e-mail sethings.

To skip this step, tap Next.

Status:

[ V)| =

E-mail Setup {3/5)

set up, and then press Next —— (right
action key).
Wait until the Status box displays
Completed, and then press Next ——
(right action key).

6. Enter your name, username, and
password.

User information

[ save password
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10.

1.

12.

13.

If you want to enter your password each time you access this
account, do not check the Save password box. If you want
your password entered automatically, check this box.

Press Next ——— (right action key).

Select the Account type list, and then
select POP3 or IMAP.

Enter a name for this account, and then
press Next 2 (right action key). For
example, if this is your work email
account, enter “Work” or your company'’s
name.

Enter the name of the Incoming mail and
Outgoing mail servers. Do not enter
anything in Domain. It is not needed for
POP3 or IMAP accounts.

(Optional) Select Options to select
download settings for this account.

Press Finish —— (right action key).

/2| outlook E-mail Fodh |

E-mail Setup (4/5)

]

Account information

Account bype: [POP3 -

Back Next

ig|PoOP3 E V)| =

E-mail Setup (5/5)

®

Server information
Incoming mail:
Oubgoing mail:

Domain:

1l

Back B

Finish

To delete an email
account, press Menu
and select Tools >
Options. Highlight the
account you want to
delete. Press and hold
Center on the 5-way,
and then select Delete.

You can set up more
than one email
account. Press Menu,
select Tools, and then
select New Account.
Enter the account
information in the
E-Mail Setup wizard.
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Not ready to send
that message yet?
You can save it
without sending it.
While creating a
message, press
Menu and select
Save to Drafts. To
access the draft,
selectthe Show listin
the upper-left, and
then select Drafts.

You can also access
the Messaging
application from the
Start menu.

You can receive
email messages in
different formats,
including HTML, RTF,
and plain text.

Creating and sending an email message

1.
2.
3.

Go to your Today screen.
Press Messaging T (left action key).

Press Left € to cycle through your Messaging accounts until
you see the email account you want to use in the title bar.

Press New ———) (left action key).

Do one of the following to address the

message:

e |f the recipient’s name and email
address are in your Contacts list,
enter the first few letters of the
recipient’s first or last name, and then
select the recipient’s name.

e |f the recipient’s name is in an online
address book, you can find the name
and add it. For more information, see
“Adding an online address book” on page 95 and “Using an
online address book” on page 96.

e |f the recipient’s name and email address are not in your
Contacts list, enter the full email address.

Select Subject and enter a title for the message.

Enter your message, or press Menu —— (right action key), select
My Text, and then select a predefined phrase you want to insert.
(Optional) Do any of the following:

e Press Menu —— (right action key) and select Insert. Select the
type of item you want to attach, and then select the file or record
a voice note.

e Press Menu —— (right action key) and select Spell Check.

74 | butiook E-mail

B | = &

From: Midyne
<midyne@anycorp.com:
{(Dutlook E-maily

To: donna@anycorp.carm
Subjerct: Files

When do you need those files?

Midyne
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9.

e Press Menu 2 (right action key) and select Message Options.

Select the Priority list, select a setting for the message, and then
press OK (@].
Press Send " (right action key).

Adding an online address book

Many email servers, including servers running Exchange Server, can
verify names with an online address book, also called a directory
service or a Global Address List. After you create and enable an email
account, Messaging checks your contact list and then the directory
service to verify names that you enter in the To, Cc, and Bcc fields.

1.

8.

[ &] OPTIONAL

In the message list, press Menu C_— (right action key) and select
Tools > Options.

Select the Address tab.

Select the address book you want to check for email addresses,
and then select Add.

Enter the name of the Directory service.
Enter the Server name.

If your server requires authentication, check the box, and then
enter your username and password.

(Optional) Check the Check name against this server box to
enable this directory service.

Select OK.

To delete a directory service, highlight it, press and

hold Center on the 5-way, and then select Delete.

Do the following:

e Ask your system
administrator for the
name of the directory
service and the server,
and whether
authentication is
required for accessing
an online address
book.

e If your company is
using an Exchange
Server 2003 upgraded
to Service Pack 2, you
must first synchronize
with the Exchange
Server to enable the
Global Address List to
find a Contact.

When you sync your
Microsoft Office
Outlook E-mail
account, disable your
online address books
to avoid errors. Press
Menu and select Tools
> Options. Select
Address and uncheck
the Check name
against this server
box.
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Add an online address
book to your
smartphone. See
“Adding an online
address book” on
page 95.

You can use the
Global Address List to
find a contact. In
Contacts, press Menu,
and then select Find
Online. When sending
a meeting request,
select Attendees,
press Menu, and then
select Find Online.

By default, email
messages you send
are saved in the Sent
folder. If you want to
save memory on your
smartphone, you can
turn this option off. In
the Messaging list,
press Menu and select
Tools > Options.
Select Message, and
then uncheck the Keep
copies of sent items in
Sent folder box.

Using an online address book

You can access contact information, such as an email address or phone
number, from your organization’s online address book or Global
Address List (GAL). To access a GAL, make sure you are accessing an
Exchange Server 2003 upgraded to Service Pack 2.This feature is useful
only if you know the exact name as it appears in the directory.

1. In a new message, tap the To box.

2. Press Menu 2 (right action key), and select Add Recipient.
3. Press Menu 2 (right action key), and select Find Online.
4

Enter the contact name as it appears in the directory and tap Find.
You must spell the contact name correctly.

Synchronizing your default email account

To send and receive messages for your default email account, simply
synchronize your smartphone with your computer. See “Setting the
synchronization schedule” on page 164 for details. During
synchronization, new messages are copied to your smartphone’s Inbox,
and messages in the smartphone’s Outbox are sent.

Synchronizing your other email accounts

To send and receive email messages for additional email accounts,
such as an Internet Service Provider (ISP) account or an account that
you access using a VPN server connection (typically a work account),
follow these steps:

1. Go to your Today screen.
2. Press Messaging ©—) (left action key).
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Press Left 4 to cycle through your Messaging accounts until
you see the account you want to download in the title bar.
Press Menu 2 (right action key) and select Send/Receive to
synchronize your smartphone with your email server.

Receiving attachments

1.
2.

3.

Select the attachment (below the subject) to mark it for download.

Synchronize the email account that contains the message as
described in the previous sections.

Select the attachment to open it.

If you have an Microsoft Office Outlook E-mail account and want to
download attachments automatically, do the following:

1.

2L Sl

Press Start (&) and select Programs.

Select ActiveSync @.

Press Menu 2 (right action key) and select Options.
Select E-mail, and then select Settings.

Check the Include file attachments box.

Press OK (@].

You can receive and
open attachmentsin a
number of different
formats, including
Word, Excel,
PowerPoint, and PDF
To view PDF files, you
must first install
Picsel PDF Viewer
from the Getting
Started CD.
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To store attachments
on an expansion card,
press Menu, select
Tools > Options.
Select Storage and
then check the Store
attachments on a
storage card box.

Embedded images
and objects cannot be
received as
attachments, unless
you have an IMAP4
email account with
TNEF disabled. Note
that TNEF must be
enabled to receive
meeting requests.

Onthe Accountstabin
Messaging Options,
an asterisk appears
next to the accounts
you create.

To automatically download attachments from an IMAP4 email account

(typically an ISP account) or an account that you access using a VPN

server connection (typically a work account), do the following:

Go to your Today screen.

Press Messaging ) (left action key).

Close any open messages.

Press Menu 2 (right action key) and select Tools > Options.

On the Accounts tab, select the IMAP4 account name.

Press Next ——— (right action key) until you reach Server

information, and then select Options.

7. Press Next twice, and then select Get full copy of messages and
When getting full copy, get attachments.

R

Using links in messages

When you receive a text message that contains a telephone number,
email address, or URL, you can dial the number, send an email
message, or go to the web page immediately. Your smartphone
automatically opens the appropriate application from the link.

1. Select a message in the list.

2. Select the phone number, email address, or URL (appears as
underlined blue text).
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Forwarding a message

1. Open the message you want to forward.

2. Press Menu —— (right action key) and select Forward.
3. Address the message and enter any text you want to add.
4. Press Send — (right action key).

Managing your messages

The status icons that appear next to each message in the Inbox and
Outbox indicate the following:

£ An unread text message.

@ An unread message with pictures or videos.
[12 An unread message with sound.

E%I A read text message.

EEI A read message with pictures or videos.

% A read message with sound.

I An urgent message. This icon appears below the message size on
the right side of the screen.

[E A message that was delivered (Sent folder only).
You can rearrange the messages in any folder or account.

1. Go to the Messaging account you want to arrange.

2. Select the Sort by list in the upper-right, and then select the sort
method you want to use.

Unread messages
appear in bold.
Messages you've
read appear in
plain text.

If you are working
offline, messages
that you deleted from
the server are deleted
from your
smartphone the next
time you connect, or
according to the
options you selected.

To permanently
remove messages
from the Deleted
Items folder, press
Menu and select
Tools > Empty
Deleted Items.
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You can delete several messages at once from any folder.
1. Go to the Messaging account you want to delete the
messages from.

2. Highlight the message(s) you want to delete. To select multiple
messages, tap and drag the stylus across the messages.

3. Press Menu 2 (right action key) and select Delete.
4. Select Yes to move the items to the Deleted Items folder.

Adding a signature to your messages

You can use a different signature with each Messaging account.
1. Go to the Messaging list.

2. Press Menu 0 (right action key) and select Tools > Options.
3. On the Accounts tab, select Signatures.

4. Select the account you want to create a

. /2 | Messaging [0 Y| &= R
signature for. p—
5. Checkthe box to add this signature to new | ... .- sccount:
messages you create with this account. s -]
6. (thional) Check the box to add this EZ:zir;‘:tf;m:::';?:f:::m
signature to messages you reply to or I SoaE ek
forward with this account.
7. Select the default signature text and enter

the signature text you want to use.
8. Press OK (@,
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Customizing your Messaging settings

1. Go to the Messaging list.

2. Press Menu —— (right action key) and
select Tools > Options.

3. Select the Message tab and set any of the
following options:

e When replying to e-mail, include
body: Indicates if the body of a
message you received appears in your
response to that message.

¢ Keep copies of sent items in Sent

/2 | Messaging [0 Y| &= R

Options

wihen replying to e-mail, include body/

Keep copies of sent ikems in Sent Folder

After deleting or moving & message:
‘Shnw next message v|

Accounts ‘ Message ‘ Address | Storage
E

folder: Indicates if messages you send are stored in the Sent

folder.

¢ After deleting or moving a message: Specifies what you

want to appear after you delete or move a text or email message.

4. Select the Address tab and set any of the following options:

¢ In Contacts, get e-mail addresses
from: Indicates whether you want to
check Contacts in addition to any

directory services for email addresses.

e Verify names using these address
books: Indicates which directory
services you want to check for email
addresses.

e Add: Lets you add directory services
to the list of online address books.

/2 | Messaging [0 Y| &= R

Options

+ e-mail addresses from;

In Contact:

Werify names using these address books:

Add...

Accounts ‘ Message ‘ Address | Storage
E

Using Your Treo 700w Smartphone

101



5.

6.

Select the Storage tab and set any of the following options:

e Store attachments on storage
card: Indicates whether you want to
automatically store email attachments

. Main memary (S9963KE free)

on an expansion card. Storage card (not installed)

e Empty deleted items: Indicates
whether you want to automatically
empty the Deleted folder, and when
you want this to occur.

Accounts | Message | Address | Storage
Press OK ().

7 4 | Messaging ] Y| &=

Options

Current size of attachments (37KB)

Empty delsted tems:

Customizing your multimedia
messaging settings

1.
2.

Go to the Messaging list.

Press Menu _—— (right action key) and

select Tools > Options.

On the Accounts tab, select MMS.

Set either of the following options:

¢ Automatically Collect Messages:
Indicates if you want to automatically
receive multimedia messages.

e Confirm Message Deletion:
Indicates if you want deletion
confirmation messages to appear.

Press OK [@].

7 4 | Messaging ] Y| ==

MMS Options

\automatically Collect Messages

Confirm Message Deletion
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Using Pocket MSN

Pocket MSN provides quick access to the following:

e MSN Hotmail: Lets you read, write, send, and delete email. You
can also manage your Hotmail folders.

e MSN Messenger Contacts list: Lets you see who's online and
exchange instant messages (IM). Subscribe to status updates for
selected contacts so you're notified when they're online.

e Options: Lets you customize your Pocket MSN experience.

Signing in to Pocket MSN

1. Press Start [#) and select Pocket MSN.
2. Select MSN Mobile Home.

3. Select Sign in.
4

Enter the email address and password
for your Passport account or your
Hotmail account.

72 | Pocket MsN [0 ) =

.a MSN Messenger

MSN Hotmail

y Compose Hotmail
/l‘ MSN Mobile Home
@ Pocket MSN Help

Done Options

e To create a Passport (IM) account,
go to www.passport.com.

e To create a Hotmail account, go to
www.hotmail.com.

You must subscribe
to data services from
Verizon Wireless.

You can add Pocket
MSN to your Today
screen. See
“Selecting which
items appear on your
Today screen” on
page 174 for details.

When you set up a
Pocket MSN Hotmail
account, you can
access that accountin
the Messaging
application. To access
your instant
messages, use the
MSN application or
the MSN plug-in on
the Today screen.
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You can also start a
web search from your
Today screen by
selecting the Web
search field, entering
the item you want to
find, and then
pressing Centeron the
5-way.

To return to a recently
viewed page, select
the address line list,
and then select the
web address.

If you browse to a
secure web page, the
Lock icon in the
address line appears
closed instead of
open.

Browsing the web

Internet Explorer Mobile provides quick and easy access to web pages.
You can view most sites you use on your computer, including those
with security and advanced features, such as JavaScript and frames. To
browse the web, you must subscribe to data services from Verizon
Wireless.

Viewing a web page

By default, Internet Explorer Mobile scales web page content to fit your
smartphone screen so that you can view most of the information
without scrolling left or right.

1. Make sure your phone is on (see
“Turning your phone on and off” on
page 11). T
2. Press Start (&) and select Internet i
Explorer.
3. Highlight the address line, enter the g nble _
a_dd ress of the web page you want to L EAe s Ao o P Tl
view, and then press Center .  Make Your Own Ring Tong

4. Press Menu 2 (right action key),
select View, and then select any of the
following:

e One Column: Arranges web pages into one column that is as
wide as the screen, so that you don’t have to scroll horizontally.

¢ Default: Maintains a layout similar to what you see on a desktop
computer, but it makes items smaller and arranges the content
so that you can see most of it without scrolling horizontally.
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Desktop: Keeps the same layout and size as on a desktop
computer, which requires both horizontal and vertical scrolling.
Full Screen: Hides the status and navigation areas and fills the
entire screen with the web page. To exit full screen mode, press
——— (right action key), or tap and hold anywhere on the screen
and uncheck Full Screen.

Show Pictures: Shows or hides pictures on web pages. Hiding
pictures speeds up the time it takes to load pages.

5. Do any of the following:

To view the previous page, press Back T (left action key) or
Backspace@.

To refresh the page with the latest content from the Internet,
press Menu 2 (right action key) and select Refresh.

To scroll through the page in One Column View or Default View,
press Up a4 or Down ¥. In Desktop View, press Up 4, Down v,
Left €, or Right » to scroll in all directions.

To follow a link to another web page, press Up 4 or Down ¥ to
highlight the link, and then press Center to go to the selected
page. You can also tap the link on the screen with your stylus.

To adjust the size of the text on web pages, press Menu — 2

(right action key), select Zoom, and then select the size you want.

To view a web page's properties, press Menu ——— (right action
key) and select Tools > Properties.

To view each item in a list, select the list and scroll using Up 4 or
Down

In a list, press Left
press Center

or Right I to cycle between items, and
to accept the change.

You can send email
from a web page.
Email addresses
appear as links on
web pages. After you
configure an email
application on your
smartphone, you can
select an email link to
create a message to
that address.

To send a link, press
Menu and select
Tools > Send Link via
E-mail. Select the
Messaging account
you want to use to
send the link.
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Create the folders
where you want to
store your favorites
first. Once you create a
favorite, you can’t
move it to another
folder.

To delete a favorite or
folder, press Menu
and select Favorites.
Select the Add/Delete
tab, highlight the item
you want to delete,
and then select Delete.
Select Yes to confirm
deletion, and then
press OK.

¢ Inaform, such as a browser search field, press Center to
interact with the form, and then press Center to stop

interacting with the form.

6. Press OK to close Internet Explorer Mobile.

Creating a favorite

Favorites let you bookmark a web page so that you can instantly access

it without entering the web address.

1. Go to the page you want to mark as

a favorite.

2. Press Menu 0 (right action key) and
select Add to Favorites.

3. (Optional) Select Name and enter a

different description.

4. (Optional) Select the folder where you
want to create the favorite.

5. Select Add.

Viewing a favorite

1. Press Start (&) and select Internet Explorer.
2. Press Favorites T (left action key).
3. Select the page you want to view in the list.

73| addFavorite

Add Favorite

Address (URL):
hitp:  fumsnas micrasoft, comjwindowsmob:
Create n:

Mobile Favarites hé

106

Using Your Treo 700w Smartphone



Organizing your favorites

You can create folders to organize your favorites. For example, you can
store travel links in one folder, stock links in another, and business links
in a third folder.

Press Start (&) and select Internet Explorer.

Press Menu T (right action key) and select Favorites.

Select the Add/Delete tab.

Select New Folder.

Enter a name for this folder, and then select Add.

Press OK [@].

AL

Downloading files and images from a web page

You can download files that are usable on your smartphone, such
as new applications, MIDI ringtones, or pictures that are specifically
tagged for download.

1. Go to the page that contains the link to the file you want to
download.

2. Press Left € or Right I to highlight the link to the file.

3. Press and hold Center , and then select Save As to download a
file, or tap and hold, and then select Save Image to download an
image.

4. Select Name and enter a new name for the file.

5. Select the Folder list, and then select the folder where you want to
save the file.

6. Select the Location list, and then select where you want to store
the file: Main memory or Storage card.

7. Press OK [®].

You can select the
Downloads favorite to
access the Verizon
Wireless downloads
page.

If Internet Explorer
Mobile does not
recognize a
smartphone number
as dialable, you can
copy the phone
number (as text) and
pasteitinto the Phone
Dial Pad.

Using Your Treo 700w Smartphone

107



Copying text from a web page

The security You can copy text from a web page and paste it in other applications.
certificates and 128-bit

SSL strong encryption 1. Use the stylus to highlight the text you want to copy.

let you browse secure 2. Press Menu — (right action key) and select Edit > Copy.
sites, such as online

shopping, banking, 3. Go to the application in which you want to paste, and then position
and email. Remember, the cursor where you want to paste the text.

it | . . .
fggﬁ?rseeg:gsizlces also 4. Press Menu — (right action key) and select Edit > Paste.

browsers, and may

not work with Internet USing the History ||St

Explorer Mobile. Ask The History list stores the addresses of the pages you visited recently.
the organization for an

alternate access point 1. Press Menu 2 (right action key) and select History.

thatiscompatiblewith 5 = (Qptional) Select the Show list in the upper-left, and then select how
Internet Explorer . f
Mobile. you want to sort the History list.

3. Select the web page you want to view.

Youcan copy thetext  Customizing your Internet Explorer Mobile settings

from the entire web . . .
page. Tap and hold on 1. Press Menu 2 (right action key) and select Tools > Options.

the page, and tap 2. On the General tab, set any of the

Select All Text. Tap following options:

Zg:i:iiﬁ;ﬁggf e Home Page: Sets the page that
appears when you open Internet
Explorer Mobile. To use the page you
were on when you opened the menu,
select Use Current. To select the
original home page, select Use Default.

¢ Encoding: Sets the character set for

the web pages you view.

£ | internet Explarer

Options

Home page
http:/fhomepage

Use Default
Encoding

Default character set

‘Western European

Gensral | Memory | Security
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3. Select the Memory tab and set any of the £2|
. A # ¢ | Internet Explorer
following options: Options Internet Explorer
¢ Save links to pages visited in the Save ks o pages visked i the past Mobile supports
past: Sets how many days of activity | B4 Jsi‘éigg'l_p;y if(cgéeu
i i | h hat has b k ’
the History list stores. et vimbeman o e ™ | and cookies, but does
e Clear History: Empties the not support plug-ins
History list. (Flash, Shockwave,
. . etc.) or Java applets.
¢ Delete Files: Removes web files that erory [ Securiy PP

you synchronized with your computer.
4. Select the Security tab and set any of the
following options:
e Allow cookies: Sets whether your
smartphone accepts cookies (small files  [7ine
containing info about your identity and [ coouies
preferences). The page sends the file (] Ao cankiss

£ | internet Explarer

and stores it on your smartphone. R —
e Clear Cookies: Deletes any cookies [ an e ot s pad hat
stored on your smartphone. Wern when page content i blocked

due to security settings

e Warn when changing to a page e \ys
that is not secure: Sets whether a
message appears when you switch
from a secure page to one that is not secure.

e Warn when page content is blocked due to security
settings: Sets whether a message appears when you attempt to
open a page that does not meet your smartphone’s security
standards.

5. Press OK (@].
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If you're using a
hands-free Bluetooth
device and it is within
range, your
smartphone routes all
calls to the hands-free
device instead of to
your smartphone’s
earpiece. Bluetooth
range is up to 30 feet
in optimum
environmental
conditions.

Your smartphone only
supports call audio
with Bluetooth
headsets. It does not
support stereo music
playback with
Bluetooth headsets
(enabled with
Bluetooth A2DP

Connecting to devices with Bluetooth®
wireless technology

With your smartphone’s built-in Bluetooth® wireless technology, you
can connect to a number of Bluetooth devices such as a headset,
hands-free car kit, or GPS receiver, as well as to other phones,
handhelds, or piconets. For a list of hands-free devices with Bluetooth
wireless technology that are compatible with your smartphone, go to
www.palm.com/mytreo700wVerizon.

If your computer is enabled with Bluetooth wireless technology, you
can also synchronize wirelessly.

Setting up a Bluetooth connection

After you set up a connection with a Bluetooth device, you can
communicate with that device whenever it is within range (about
30 feet) and your smartphone’s Bluetooth feature is turned on.

1. If necessary, prepare the device you
want to connect with to accept a new
connection. Check the device's
documentation for details.

74 | settings ] Y| ==

Bluetooth

[Turn on Bluetooth)
[ Make this device discoverable to other

profile). 2. Go to your Today screen, and then tap devees
Bluetooth
3. Check the Turn on Bluetooth box to
turn on your smartphone’s Bluetooth toce [ Devices | CoM ports |
feature.
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4. Select the Devices tab, and then select
New Partnership.

5. Wait for your smartphone to search for
devices and to display the device list.

6. Select the device you want to connect
with, and then press Next —— (right
action key).

7. Enter an alphanumeric passkey between
1 and 16 characters long, and then press
Next ——— (right action key).

[ TTIMPORTANT Some Bluetooth devices
have a built-in passkey; others let you
choose the passkey. See the documentation
for the Bluetooth device for more info.

8. If the passkey is not built-in, enter the
same passkey on the smartphone and
the other Bluetooth device, and then
press Finish —— (right action key).

73| settings ] Y| ==
Bluetooth

Tap New Partnership b scan For other
Blustoth devicss. Tap on a device bo modify
its settings.

Devices | COM Ports

74 | settings G Y| ==

Select a Bluetooth Device [2)

Select a device to connect with and tap
Hext.,

Palm Device

Cancel

9. If you're connecting to a headset or hands-free car kit, check the
Hands Free box, and then press Finish —— (right action key).

10. If you're connecting to a GPS device, press Finish ——— (right action
key), select the COM Ports tab, select the GPS device you selected in
step 6, and then select New Outgoing Port. Press Finish ——— (right
action key). After you set the partnership and COM port, you can
configure the GPS settings (see “Setting up a GPS device” on
page 197). Be sure to select the same port you have assigned for

GPS here.

The Bluetoothicon on
your Today screen
indicates the status of
your smartphone'’s
Bluetooth feature:
Gray = Bluetooth off.
Blue = Bluetooth on.
White = Connected to
a Bluetooth device.
Headset = Call in
progress with a
Bluetooth headset or
car kit.

To delete the
established
partnership with a
device, go to the
Bluetooth Settings
screen and select
Devices. Highlight the
connection you want
to remove, press and
hold Center on the
5-way, and then
select Delete. The
deleted device can no
longer automatically
connect with your
smartphone.
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Check your battery
level before
establishing a
Bluetooth connection.
If the battery level is
low, you can’t make a
Bluetooth connection.

If you have trouble
receiving info over a
Bluetooth connection,
press Start and select
Settings. Select the
Connections tab, and
then select Beam.
Make sure the Receive
all incoming beams
box is checked.

11. Press OK (@],

You can now communicate with this device whenever it is within range
(about 30 feet) and your smartphone’s Bluetooth feature is turned on
(see steps 1 and 2 earlier in this section).

Sending information over a Bluetooth connection
You can send an individual entry or file.

1.

4.

Make sure the receiving device is ready
to receive a Bluetooth connection.
Highlight the entry or file you want to
send.

Press Menu —— (right action key) and
select Beam... (the menu item changes
names based on the type of item you
highlighted). A red icon indicates an IR
connection, and a blue icon indicates a
Bluetooth connection.

Select the receiving device in the list.

/¢ | contacts G0 Y & bk

[E5] 2bbi

To beam, select a device.

i) Treo Tap to send
i) Wayne Tap to send

When the transmission is complete, “Done” appears next to the name
of the receiving device.

Receiving information over a Bluetooth connection
Go to your Today screen, and then tap Bluetooth
Check the Turn on Bluetooth box to turn on your smartphone’s

1.
2.

Bluetooth feature.

If you have already set up a partnership with the transmitting
device, your smartphone is ready to receive the info. If you haven’t
set up a connection, check the Make this device discoverable to
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other devices box to let the device find your smartphone and
request a connection.

When your smartphone is receiving info, a notification tells you that
a transmission is in progress. To stop the transmission, press
Cancel T (left action key); to close the notification, press Dismiss
C—— (right action key).

Synchronizing over a Bluetooth connection

1.

9.

Set up your computer for Bluetooth wireless communication. See
the documentation that came with your computer for details. In
most cases your computer must support the Virtual Serial Port
profile and this profile must be turned on.

Set up ActiveSync on your computer for Bluetooth wireless
communication. See ActiveSync Help on your computer for details.
Go to your Today screen, and then tap Bluetooth

Check the Turn on Bluetooth box to turn on your smartphone’s
Bluetooth feature.

Press Start (#) and select Programs.

Select ActiveSync @.

Press Menu 2 (right action key) and select Connect via
Bluetooth.

If this is the first time you’re making a Bluetooth connection to this
computer, follow the onscreen prompts to set up a Bluetooth
partnership with this computer.

Select Sync.

10. When synchronization has finished, press Menu 2 (right action

key) and select Disconnect Bluetooth.

Make sure your
computeris equipped
with Bluetooth
wireless technology
and that you installed
the synchronization
software on the CD
that came with your
smartphone.

Wi-Fi® routers,
microwaves, and
wireless telephones
using the 2.4GHz
band may interfere
with Bluetooth
connections. For best
results, move away
from this equipment
when making a
Bluetooth
connection. If you
cannot move away,
move the Bluetooth
devices closer to
improve the
reception.
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CHAPTER 5

% Tip

For best results, the
path between the two
devices must be clear
of obstacles, and both
devices kept
stationary. If you have
difficulty beaming,
shorten the distance
and avoid bright
sunlight.

The type of
information you can
beam depends on the
type of device you are
beaming to. Windows
mobile devices are
always compatible
with the Treo 700w
smartphone.

Using Email and Other Wireless Services

Beaming information with IR

Your smartphone is equipped with an IR (infrared) port that lets you
beam information to another device with an IR port. The IR port is
located on the top of your smartphone, between the antenna and the
ringer switch, behind the small dark shield.
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Beaming a record

1.

Highlight the entry or file you want to

beam. 4 | contacts U Y = BR

Press Menu > (right action key) and Bl Abbi
select Beam... (the menu item changes
names based on the type of item you Toheam selectd device:

. . i) Treo Tap to send
hlghllghted) ) Wayne Tap to send
Point the IR port on your smartphone
directly at the IR port of the receiving
device.
When the name of the receiving device
appears, select it to begin the transfer.

A blue icon indicates a Bluetooth connection, and a red icon
indicates an IR connection.

Wait for “Done” to appear next to the name of the receiving device
before you continue using your smartphone.

Receiving beamed information

1.
2.

Turn on your screen.

Point your smartphone’s IR port directly at the IR port of the
transmitting device.

When the Receiving Data message appears, select Yes to receive
the beam.
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CHAPTER 5 Using Email and Other Wireless Services

% Tip Synchronizing over an infrared connection
If you can't receive 1. Set up your computer to receive infrared beams. See ActiveSync
beamed info, press Help on your computer for details.

Start and select . )
Settings. Select the Point your smartphone’s IR port directly at the IR port on your

Connections tab, and computer.

then select Beam.

Make surethe Receive On your srnartphone, press Start (&) and select Programs.
Select ActiveSync @.

all incoming beams
box is checked. If you Press Menu — (right action key) and select Connect via IR.
Select Sync.

N

still can’t receive info,
try a soft reset (see
“Resetting your
smartphone” on
page 213).

2B
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Playing Media Files

Pictures & Videos

Your Palm® Treo™ 700w smartphone comes with an easy-to-use, built-
in, 1.3-megapixel camera with 2x digital zoom (camera not included
with all smartphones). You can use the camera to take and view pictures
and videos and send them to your friends and family. To add a personal
touch to your smartphone, use your pictures as your Today screen
background, and as caller ID images, or use your videos to create video
ringtones.

Even if your smartphone does not have a camera, you can still receive
and view pictures and videos, and send pictures and videos as
attachments or multimedia messages. You can also personalize your
smartphone by using a picture as a background or by adding a picture to
a contact; see “Assigning a picture and ringtone ID to a contact” on
page 176 for details). You can also move pictures and videos to a
computer by synchronizing your smartphone with your computer.

Taking a picture

By default, pictures are stored in the My Pictures folder on your
smartphone. If you want to store your pictures on an expansion card,
see “Customizing your Camera settings” on page 124 to change where
pictures are stored. For information on accessing your pictures on your
computer, see “Viewing pictures and videos on your computer” on
page 126.

Pictures are captured
and stored in 16-bit
color, JPG format.
Resolution settings
range from

1280 x1024 to 160 x
120 pixels (1.3-
megapixels to VGA).
You can change the
default setting. See
“Customizing your
Camera settings” on
page 124 for details.
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If you see acamcorder
icon below the
preview image, video
mode is on. Toturn on
the still camera, press
Menu and select Still
Mode.

You can also adjust
the zoom and
brightness by
pressing Menu and
selecting Zoom or
Brightness.

Videos are captured
and stored in 3G2
format. Video
resolution settings
range from 352 x 288
to 176 x 144 pixels.

After three minutes of
inactivity when
previewing an image,
the camera goes into
standby mode. Press
any key or tap the
screen to return to the
image preview.

1. Press Start (&) and select Pictures & Videos.

2. Select Camera ([@.

3. Adjust the position of your smartphone
until you see the subject you want to
photograph on the screen.

4. (Optional) Adjust any of the following:

e Zoom: Press Up 4, tozoom in or
Down ¥ to zoom out.

e Brightness: Press Right > to
increase the brightness or Left € to
decrease the brightness.

¢ Resolution: Press Menu C—— (right action key) and select
Resolution to change the image quality.

5. (Optional) Set a 5-second timer: Press Menu ——— (right action key),
select Mode, and then select Timer.

6. Press Center to capture the picture or start the timer.

7. Hold your smartphone still until the picture renders, and then do
one of the following:

£ |Pictures & videos [0 ;| o

Thumbnails

e Press Camera ——) (left action key) to take another picture.
e Press OK (@] to return to the Thumbnails View.

Taking pictures in burst mode

Burst mode takes five pictures in quick succession, with one button
press.

1. Press Start [#) and select Pictures & Videos.

2. Press Camera —) (left action key).
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3. Press Menu — (right action key) and select Mode > Burst.
4. Press Center

Recording a video

Videos can be any length, provided you have ample storage space
available. By default, videos are stored in the My Pictures folder on your
smartphone. If you want to store your videos on an expansion card, see
“Customizing your Camera settings” on page 124 to change where
videos are stored. For information on accessing your videos on your
computer, see “Viewing pictures and videos on your computer” on
page 126.

1. Press Start (&) and select Pictures & Videos.

2. Select Camera(J@l.

3. Press Menu 2 (right action key) and select Video Mode.
4

Adjust the position of your smartphone until you see the subject
you want to record on the screen.

5. (Optional) Adjust any of the following:

e Brightness: Press Right I to increase the brightness or Left € to
decrease the brightness.

You must have
QuickTime Player
version 6.5 or later
installed on your
computer to play
videos recorded by
your smartphone and
downloaded from an
expansion card or
accessed by clicking
on the video
thumbnail after
syncing the files.

If you don’t like a
video you recorded,
delete it. See
“Deleting a picture or
video” on page 123
for details.

Your smartphone has
a self-portrait mirror
next to the camera
lens on the back of
yoursmartphone. Use
the mirror when
you're taking a picture
orvideo and you want
to be in the picture
too.
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To view pictures or
videos in a different
folder, select the
Show list in the
upper-left, and then
select the album you
want to view.

You can also press
Right and Left on the
5-way to move
forward or backward
through the slides.

You cannot send
copyrighted pictures
or videos that appear
with a Lock icon in the
Thumbnail View.

You can send pictures
and videos as email

¢ Resolution: Press Menu 2 and
select Quality to change the video
resolution.

6. Press Center to start recording.

7. When you're finished recording, press
Stop <) (left action key) or Center
to stop recording.

8. (Optional) To review the video in
Windows Media Player Mobile, press
Thumbnails T (left action key),
highlight the video, and then press Center
return to the Thumbnail View.

74 |Pictures & videos I )|

Thumbnails

. Press OK to

Viewing a picture or video
1. Press Start [#) and select Pictures & Videos.

2. Select the picture or video you want to view. For more info on
viewing videos, see “Playing media files on your smartphone” on
page 128.

3. Press OK to return to the Thumbnail View.

Viewing a slide show

attachments. 1. Press Start (&) and select Pictures & Videos.
2. Press Menu 7 (right action key) and select Play Slide Show. The
slide show plays automatically.
3. Press Center to display the slide show toolbar, which you can
use to Rotate 4, Play @, Pause @, Reverse @, Forward @, and
Stop €3 the slide show.
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Sending a picture or video

You can send a picture or video to other picture-enabled mobile
smartphones or to an email address.

1. Press Start [#) and select Pictures & Videos.

2. Highlight the picture or video you want to send.

3. Press Menu 2 (right action key) and select Send.

4

Select the email or MMS account you want to use to send the
picture or video.

5. When the Messaging application opens, address and send the
message. (See “Creating and sending a multimedia message” on
page 81 for details.)

Creating a video ringtone

You can save a video that you record as a ringtone.

1. Press Start [#) and select Pictures & Videos.

2. Highlight the video you want to use as a ringtone.

3. Press Menu 2 (right action key) and select Save to Contact Ring
Tone.

4. Select the contact to whom you want to assign the ringtone.

Organizing pictures and videos

You can move or copy pictures and videos to other folders or between
your smartphone and an expansion card.

1. Press Start [#) and select Pictures & Videos.
2. Highlight the picture or video you want to move or copy.
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4,

5.

Do one of the following:
* To move the picture or video to another location, press Menu
—— and select Edit > Cut.

e To keep the picture or video in two locations, press Menu ——
and select Edit > Copy.

Select the Show list in the upper-left, and select the location where
you want to place the picture or video you selected in step 3.

Press Menu > (right action key) and select Edit > Paste.

You can also view a specific folder or expansion card and arrange the
pictures and videos by name, date, or size.

1.
2.

Press Start (&) and select Pictures & Videos.

Select the Show list in the upper-left, and then select the folder you
want to view.

Select the Sort By list in the upper-right, and then select the sort
method: Name, Date, or Size.
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Using a picture as the Today screen background

1.
2.
3.

4.

5.

Press Start () and select Pictures & Videos.
Highlight the picture you want to use.

Press Menu 2 (right action key) and select Set as Today
Background.

Select the Transparency level list and select the appropriate level.
Use a higher percentage for a more transparent picture and a lower
percentage for a more opaque picture.

Press OK to return to the Thumbnail View.

Editing a picture

1.

2.
3.
4

Press Start (&) and select Pictures & Videos.

Highlight the picture you want to edit.

Press Menu —— (right action key) and select Edit.

Do any of the following:

* To rotate a picture 90 degrees counterclockwise, select Rotate.

e To crop a picture, press Menu 2 (right action key) and select
Crop. Tap and drag the stylus to highlight the area to crop. Tap
outside the box to stop cropping.

* To adjust the brightness and contrast levels of a picture, press
Menu ——— (right action key) and select AutoCorrect.

Deleting a picture or video

1.
2.
3.
4.

Press Start (&) and select Pictures & Videos.
Highlight the picture or video you want to delete.
Press Menu 7 (right action key) and select Delete.
Select Yes.

To undo an edit, press
Menu and select
Undo. To cancel all
unsaved edits you
made to the picture,
select Revert to
Saved.

For more extensive
edits, just download
your picture or video
to your computer and
edit it in your favorite
graphics program.
Then sync the picture
or video back on your
smartphone.
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If your smartphone
does not have a built-
incamera, the Camera
and Video options do
not apply to you.

Customizing your Camera settings

1. Press Start (&) and select Pictures & Videos.

2. Press Mequ > (right action key) and £ | pictures tovideos O T B
select Options. BiHions

3. On the General tab, set any of the
following options:

e Use this picture size: Sets the size
of pictures you send with the
Messaging application.

e When rotating a picture, rotate 90
degrees: Sets the direction in which
pictures rotate.

4. Select the Slide Show tab and set any of the following options:
¢ During slide shows, optimize for
viewing: Sets whether pictures are
optimized for portrait or landscape
format during slide shows.

¢ Play screensaver when connected
to my PC and idle for 2 minutes:
Sets whether the pictures in your My
Pictures folder are used as a
screensaver when your smartphone is
connected to your computer and
ActiveSync® software is not running.

When sending pictures in e-mall, pictures can
be resized so that they transfer Faster.
Use this picture sk

When ratating a picture, rotats 90 degress:

() Left
() Right

General

Slide Shows | Camera | Yideo

73| Pictures & videos [0 Y| == @R

Options

During slide shows, optimize for viewing:
@® [Portrait pictures
() Landscape pictures

[ Play scresnsaver when connected ko my
PC and idle for 2 minutes

| General | side show [ camer [ video
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5. Select the Camera tab and set any of the
following options:

e Save files to: Determines if pictures
and videos are stored on your
smartphone or on an expansion card.

¢ Type filename prefix: Assigns a
name to a series of pictures to be
captured, such as Seattle001,
Seattle002, and so on.

e Still image compression level:

73| Pictures & videos [0 Y| == @R

Options

Save files b

Type Fllename prefix:

stillimags comprassion level:

High quality -

General | Side Show | Camera [ video
BH

Sets the default size for newly captured pictures.

6. Select the Video tab and set any of the
following options:
¢ Include audio when recording
video files: Turns the microphone on
and off so that you can record videos
with or without sound.
¢ Time limit for videos: Limits the
length of videos you record. You can
also select the No limit option.
7. Press OK to return to the
Thumbnail View.

g | Pictures & videos [0 V)@= GR

Options

[include audio when recording video files.|

Time limit for videos:

General | Side Show | Camera | video
BE
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CHAPTER 6 Playing Media Files

+ Did You Know? Viewing pictures and videos on your computer

You can also When you synchronize your smartphone, your pictures and videos are
download animated copied to your desktop computer. You can view pictures in JPEG, GIF,
GIF files and view BMP, and PNG format and videos in 3G2 and WMV format. You can also

them in Internet

Explorer Mobile. send them to friends using your desktop email application.

To find all synchronized pictures and videos, look in C:\Documents and
Settings\<Username>\My Documents\Treo My Documents.
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Windows Media Player Mobile

Windows Media Player Mobile can play music, audio, and video files
that are stored on your smartphone or on an expansion card (sold
separately) in any of the following file formats:

e WMA
e WMV
e MP3
e 3G2

You can listen to these music, audio, and video files through the
speaker on the back of your smartphone or through a stereo headphone
(3.5mm stereo headphone adapter or 2.6mm stereo headphone
required, sold separately).

Transferring media files to your smartphone

Use the Sync feature in the desktop version of Windows Media Player
10 to transfer digital music, audio, video, and playlist files from your
computer to an expansion card or your smartphone. Using Sync
ensures that the files transfer correctly.

1. On your computer, open Windows Media Player 10.

2. (Optional) Insert a 32MB or larger expansion card into your
smartphone.

3. Connect your smartphone to your computer with the USB
sync cable.

4. When the Device Setup Wizard opens on your computer,
click Automatic.

5. Check the Customize the playlists that will be synchronized box.

Do the following:

* You must have
Windows Media
Player 10 or later
installed on your
computer. See “My
media files won’t
sync” on page 226.

e To sync media files
with your computer,
you must set the
Media sync option.
See “Selecting which
info to sync” on
page 161.

For tips on using the
desktop version of
Windows Media
Player, go to the Help
menu in Windows
Media Player 10 on
your computer.

Be patient;
transferring media
files to an expansion
card can take several
minutes.
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If you can't find a
media file on your
expansion card,
update the library (see
“Working with
libraries” on

page 129).

To play afile that is not
in a library, go to the
Library screen, press
Menu, and select
Open File.

To play a file from the
web, press Menu on
the Library screen, and
then select Open URL.
Select URL and enter
the website address,
or select History and
select a site you've
visited before.

To repeat the current
song, press Menu and
select Repeat Song.

Select the playlists you want to sync.

Click Finish to begin the transfer. The next time you connect your
smartphone to your computer while the desktop version of
Windows Media Player 10 is running, synchronization starts
automatically.

Playing media files on your smartphone

1.
2.
3.

Press Start (&) and select Windows Media.
Press Menu > (right action key) and select Library.

Select the Library list in the upper-left, and then select the library
you want to use.

Select the item you want to play (such as a song, album, or
artist name).

Press Play T (left action key).
Use any of the following onscreen controls during playback:

Center or » Plays the current file.
Center or Il Pauses the current file.
Left <4 « Skips to the beginning of the current file or to the

previous file.
Right » ¥ Skips to the next file.
o Sets the point from which playback begins. Tap and drag
the slider to change the current position.
Volume button or @ Increases the volume level.
Volume button or < Decreases the volume level.
< Turns the sound on or off.
Displays a video using the full screen.
% Displays a website where you can find music and videos to play.
#* Indicates the rating of the current file. Select the star to change
the rating.
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7. Press Menu 2 (right action key) and select any of the following

during playback:

e Library: Displays the Library screen so you can select a different
song to play.

¢ Shuffle/Repeat > Shuffle: Plays the Now Playing playlist
in random order. A check appears next to this command when
itis on.

e Shuffle/Repeat > Repeat: Plays the Now Playing playlist
repeatedly. A check appears next to this command when it is on.

e Stop: Ends playback.

Working with libraries

A library represents each of the storage locations available to Windows
Media Player Mobile, so you should have two libraries: My Device and
My Storage Card. Each library contains links to the media files in that
location. Windows Media Player Mobile usually updates the My Device
library automatically, but you must manually update the My Storage
Card library.

1. Press Start [#) and select Windows Media.

2. Press Menu 2 (right action key) and select Library.

3. Press Menu 2 (right action key) and select Update Library.
4. Wait for the files to be added, and then select Done.

When you update a
library, it
automatically
updates video files
(WMV and 3G2) and
audio files (WMA,
MP3, QCP, and WAV).

To delete an item
from a library:
Highlight the item
and then press and
hold Center on the
5-way to open the
shortcut menu. Then
select Delete from
Library. Select Yes to
confirm the deletion.

If you don’t see a
media file that you
added, manually
update the library.
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You can also move a
file in the Now Playing
playlist by tapping
and dragging itto a
new position.

If you move files
between your
smartphone and an
expansion card, be
sure to update your
libraries, or you won't
be able to see the files
in their new location.

Working with playlists

A playlist is a list of media files that play in a specific order. You can use
playlists to group audio files together or video files together for
convenient playback. For example, in the desktop Player, you can create
a playlist of upbeat songs for when you exercise and a playlist of
soothing songs for a long flight. When you synchronize, your favorite
playlists are automatically copied to your smartphone. Your playlists
appear in your libraries (in the My Playlists category).

A temporary playlist, called Now Playing, appears on the Now Playing
menu. It lists the currently playing file, as well as any files that are
queued up to play next. You can add to, modify, or clear the files on the
Now Playing playlist.
1. Go to the Now Playing screen:
e If you are on the Library screen, select the Now Playing category.
e If you are on the Playback screen, select Now Playing.
2. Do any of the following:
e To move a file up or down one slot,
highlight the file, and then select Move
Up 4 or Move Down %.

¢ To add afile, select Add [-§, press
Menu — (right action key), and then

73 | windows Media

Falling Angel
Electric Angel

select Queue Up. Q0L 40 100%
e To delete a file from the playlist, )

highlight the file, and then select HosElaving

Remove X.
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* To view more info about a file, highlight the file and select
Properties [4].

e To remove all items from the Now Playing playlist, press Menu
—_— and select Clear Now Playing.

Customizing Windows Media Player Mobile

1. If necessary, go to the Playback screen by pressing OK to close
the current screen.

2. Press Menu — (right action key) and select Options.

3. On the Playback tab, set any of the following options:
¢ Show time as: Sets whether the time

.. X X 73 | Windows Media
remaining or time elapsed appears in

0 Y| ==

Options

the Playback screen.

¢ Pause playback while using
another program: Sets whether
playback continues if you switch to
another application.

Show

O Pause playback while using another
program

Resume playback after a phone cal

¢ Resume playback after a phone
call: Sets whether playback continues
after you finish a phone call.

4. Select the Video tab and set any of the following options:

¢ Play video in full screen: Sets whether videos automatically
play in full screen format.

e Scale to fit window: Sets whether videos are automatically
scaled to fit the Playback screen.

Playback | videa | metwork | Library | skind 4]0 ]

You can also
customize your
smartphone so that
pressing and holding
the Side button on the
side of your
smartphone opens
Windows Media
Player Mobile. See
“Reassigning
buttons” on page 185
for details.
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If you close the
Windows Media
Player Mobile
window, your music
continues to play in
the background.

Select the Network tab and set the following options:

¢ Protocol: Enables and disables the available protocols.
You must select at least one protocol. You can also set a UDP
Port.

¢ Internet Connection Speed: Sets the speed of your network
connection, and sets whether you want the device to detect
connection speed.

Select the Library tab and set whether you want to see the Library

or Playback screen when you open Windows Media Player Mobile.

Select the Skins tab and select Previous or Next to set the player’s

background.

Select the Buttons tab to change any of

the available button settings: e
e To assign a button, highlight the item Play/Pause =
A ENTER =|
you want to set, select Assign, and then ston M
press the button you want to use for P Nt assion=d
that item. ot assigned =
e To restore an item’s factory setting,
highlight the item and select Reset. Network] Ubrary | Skins | suttors [ (4] ¥
* To unassign an item, highlight the item &=

and select None.
Press OK (@],
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Staying Productive

Word Mobile

You can create and edit documents and templates and save them as
DOC, RTF,. TXT, and DOT files. You can also edit Microsoft® Office Word®
documents and templates that you create on your computer. However,
keep in mind that some of the information and formatting may be lost
when you save the document on your smartphone.

The following features are not supported in Word Mobile:

Backgrounds

Bidirectional text

Document protection

Metafiles

Artistic page borders (lined page borders are supported)

Password-protected files (remove password protection on your
computer before opening the file on your smartphone)

Shapes and text boxes
Smart tags

The following features are partially supported in Word Mobile:

Picture bullets (regular bullets are supported)

Revision marks (documents appear as though all revisions were
accepted; if the document is saved, revision marks are lost)

To copy a file from
your computer to
your smartphone,
open My Computer
or Windows Explorer
on your computer,
copy the file into the
Mobile Device folder,
and then sync.
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When you save a new
document, it is
automatically named
after the first several
words in the file.

Table styles (some or all of the formatting is lost if the document
is saved)

Underline styles (unsupported styles are mapped to one of the four
supported styles: regular, dotted, wavy, or thick/bold/wide)

Legacy Pocket Word files (you can open PSW files, but if you edit a
file, you need to save it in DOC, RTF, TXT, or DOT format)

The following features are not supported on your smartphone, but they
remain in the file so that when you open the file on your computer, they
appear as expected:

Fonts and font sizes (original fonts are listed on your smartphone
but are mapped to the closest font available.)

Footnotes, endnotes, headers, footers

Lists (indented lists are mapped to the closest indentation level
supported by Word Mobile.)

Page breaks (although undisplayed, all page breaks, except a break
placed at the end of a document, are retained in the document.)

Creating a document

1.

o pwN

Press Start (&) and select Programs.
Select Word Mobile E

Press New T (left action key).
Enter the text of the document.
Press OK (@] to save the file.
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Opening an existing document

1.
2.
3.

Press Start [#) and select Programs. gvouldon’t Ses
. emplates in the
Select Word Mobile [#]. o e e

In the document list, select the document you want to open. More Folders to
access this folder.

Creating a document from a template

1. Go to the documents list. To create a new
2. Select the Show list in the upper-left, and then select Templates. template, open the
. R document you want
3. Open the template you want to use and enter the information. to save as a template.
4. Press OK (@], Press Menu and
. . select Rename/Move.
5. Rename the document and move it to the appropriate folder. Select Name, and
See “Organizing your documents” on page 138 for details. then enter a name for
the template. Select
Finding or replacing text in a document the Show list, and
. . then select Template.
1. Open the document containing the text you want to find. Press OK.
2. Press Menu 2 (right action key) and select Edit > Find/Replace.
3. Select Find what and enter the text you want to find.
4. (Optional) Check the Match case box to find text that matches
the capitalization in the text you entered step 3.
5. (Optional) Check the Match whole words only box to find only
full words that match the text you entered in step 3.
6. Select Find to locate the first instance of the text you entered in
step 3, or select Replace and enter the replacement text.
7. Select Next to find the next instance of the text, or select Replace
to replace it. To replace all instances of the text, select Replace All.
8. When you see a message that the search is done, press OK (@].
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To zoom in or out,
open a document,
press View, select
Zoom, and then select
the zoom level.

If a document was
previously saved on a
computer, any
unsupported
formatting may be
lost when you save
the file.

Moving or copying text

1.
2.
3.

4.

5.

Open the document containing the text you want to move or copy.
Highlight the text you want to move or copy.

Press Menu 2 (right action key) and select Copy to copy the text,
or select Cut to move the text.

Open the document where you want to insert the text and position
the insertion point where you want the text to appear.

Press Menu . (right action key) and select Paste.

Saving a copy of a document

1.

2.
3.
4

6.

7

Open the document you want to copy.
Press Menu > (right action key) and select File > Save As.
Select Name and enter a new name for the file.

Select the Folder list, and then select the folder where you want to
save the file.

Select the Type list, and then select the format in which you want to
save the file.

Select the Location list, and then select whether you want to store
the file on your smartphone or an expansion card.

Select Save.

Formatting text

1.
2.
3.

Open the document you want to format.
Highlight the text you want to format.
Press Menu > (right action key) and select Format > Font.
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Set any of the following options for the highlighted text:

Font: Sets the typeface.

Font color: Sets the color.

Size: Sets the point size.

Bold: Indicates whether the text appears normal or thick.

Italics: Indicates whether the text appears upright or slanted.

Underline: Indicates whether the text appears with an
underscore.

Highlight: Indicates whether the text appears with a
yellow highlight.

Strikethrough: Indicates whether the text appears with a
line through it.

5. Press OK to return to the document.

Formatting paragraphs and lists

1.

2.
3.
4

Open the document you want to format.

Position the insertion point in the paragraph you want to format.
Press Menu —— (right action key) and select Format > Paragraph.

Set any of the following options:

Alignment: Aligns the text with the left, right, or center of
the paragraph.

List: Creates a bulleted or numbered list.

Indentation: Changes the paragraph margins.

— Left: Sets the left margin for the entire paragraph.

— Right: Sets the right margin for the entire paragraph.

You can also use the
Formatting toolbar to
create a list and to
align text. To indent
text in lists, you must
use the Formatting
toolbar.
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To check the spelling
of specific text,
highlight it before you
select the Spelling
command.

To create a new folder,
go to the documents
list, select the Show
list in the upper-left,
and then select the
Add/Delete tab. Select
New, enter a name for
the folder, and then
press OK.

When you go to a
folder, you can easily
search your
documents by sorting
by type.

— Special: Lets you indent the first line or set a hanging indent.
— By: Sets the size of the Special indentation.
5. Press OK to return to the document.

Checking spelling in a document

1. Open the document you want to check.

2. Press Menu — (right action key) and select Tools > Spelling.
3. If an unknown or misspelled word is encountered, do one of the

following:
e Select the correct word in the list if the word is spelled
incorrectly.

e Select Ignore if the word is spelled correctly.
e Select Add to add a new word to the spelling dictionary.

Organizing your documents

You can rename your documents, move your documents to another

folder, and move your documents between your smartphone and an

expansion (storage) card.

1. Go to the documents list.

Highlight a file.

Press Menu 2 (right action key) and select Rename/Move.

Select Name, and then enter a new name for the document.

Select the Folder list, and then select the folder you want to move

the document to.

6. Select the Location list, and then select Main memory or
Storage card.

o~ WD
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7. Press OK (@],
8. Select the Show list in the upper-left, and then select the folder you
want to view.

9. Select the Sort By list in the upper-right, and then select the
sort method.

Deleting a document

1. Go to the documents list.

2. Highlight the document you want to delete.

3. Press Menu —— (right action key) and select Delete.
4. Select Yes.

Customizing Word Mobile
1. Go to the document list.
2. Press Menu 2 (right action key) and select Options.
3. Set any of the following options:
e Default template: Sets the default template for new
documents.
e Save to: Sets the default location where new documents
are stored.
e Display in list view: Sets the types of files that appear in the
documents list.

4. Press OK (@],
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To copy a file from
your computerto your
smartphone, open My
Computer or
Windows Explorer on
your computer, copy
the file into the Mobile
Device folder, and
then sync.

If a presentation is set
up as a timed slide
show, the slides
advance
automatically.
Presentations pause
during zooming.

PowerPoint Mobile

With PowerPoint Mobile, you can open and view slide show
presentations created on your computer. Many presentation elements
such as slide transitions, animations, and URL links are also supported.
Microsoft® Office PowerPoint® features not supported on your
smartphone include the following:

Notes written for slides

Rearrangement or editing of slides

Files created in PPT format earlier than Microsoft PowerPoint '97
HTML files in HTM and MHT formats

Playing a presentation

1.

o wn

Press Start (&) and select Programs.

Select PowerPoint Mobile .

In the presentation list, highlight the presentation you want to play.
Press Center

Do any of the following:

Press Right » to advance to the next slide or Left € to view the
previous slide.

Press Menu 2 (right action key), select Go to Slide, and select
the slide you want to view.

Select Next or Previous to play animations.

Press Menu ——— (right action key), select Zoom In, and then
select /¥ to zoom in or & to zoom out. To scroll within the
current slide, tap and drag the slide. To return to the slide show,
select &.

Press Menu —— (right action key) and select End Show.
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Setting presentation playback options

1.
2.
3.

Open the presentation for which you want to change the settings.
Press Menu —— (right action key) and select Show Options.

On the Orientation tab, select the orientation you want. To select the
orientation that best fits your smartphone’s screen, select Default.

Select the Playback tab, and check the Override playback options for
all files box.

Set any of the following options:

e Show without animation: Turns off builds and other
animations.

e Show without slide transition: Turns off transition effects
between slides.

e Use slide timings, if present: Enables the timings recorded
with each slide in a presentation.

¢ Loop continuously: Advances to the first slide after playing the
last slide in a presentation.

Press OK (@],

To turn the
presentation into a
continuously looping
slide show, check
both the Use timings,
if present, and the
Loop continuously
boxes.

You can purchase
SDIO presentation
modules that let you
project your
PowerPoint Mobile
presentations
through an LCD
projector.
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For simple
calculations, use the
Calculator
(see“Calculator” on
page 77).

To copy a file from
your computer to your
smartphone, open My
Computer or Windows
Explorer on your
computer, copy thefile
into the Mobile Device
folder, and then sync.

Excel Mobile

With Excel Mobile you can create and edit workbooks and templates on
your smartphone. You can also edit workbooks and templates that you
create on your computer. However, keep in mind that you may lose
some of the information and formatting when you save the workbook
on your smartphone.

Note the following formatting considerations:

Alignment: Vertical text appears horizontal.
Borders: Appear as a single line.
Cell patterns: Patterns applied to cells are removed.

Fonts and font sizes: The original font is listed on your
smartphone and mapped to the closest font available. Original
fonts reappear on your computer.

Number formats: Microsoft® Excel® 97 conditional formatting
displays in Number format.

Formulas and functions: Unsupported functions are removed,
and only the returned value of the function appears. Formulas
containing the following are also converted to values:

e An array or array argument, for example, =SUM({1;2;3;4})

e External link references or an intersection range reference

e References past row 16384 are replaced with #REF!

Protection settings: Most protection features are disabled but
not removed. However, password protection is removed. You must

remove the password protection in Microsoft® Office Excel® on your
computer before opening the file on your smartphone.
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Zoom settings: Worksheet-specific zoom settings are not retained.
The zoom setting applies to the entire workbook.

Worksheet names: Names that refer to other workbooks, arrays,

array formulas, or intersection ranges are removed from the name
list, causing those formulas to be resolved as “#NAME?" All hidden
names are not hidden.

AutoFilter Settings: AutoFilters that cause rows to be hidden are
supported. Use the Unhide command to display hidden rows. Other
AutoFilters are removed, but you can use the AutoFilter command
in Excel Mobile to perform similar functions.

Chart Formatting: All charts are saved as they appear in Excel
Mobile. Unsupported chart types are changed to one of these
supported types: Column, Bar, Line, Pie, Scatter, and Area.
Background colors, gridlines, data labels, trend lines, shadows,
3D effects, secondary axes, and logarithmic scales are turned off.

The following features aren't supported in Excel Mobile and are
removed or modified when you open a workbook on your smartphone:

Hidden, dialog, and macro sheets
VBA modules

Text boxes

Drawing objects and pictures

Lists

Conditional formats and controls

Pivot table data (is converted to values)
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When you save a new
workbook, it is
automatically named
and placed in the
workbook list.

To insert a symbol,
place the insertion
point where you want
the symbol. Press
Menu and select Insert
> Symbol. Highlight
the symbol you want
to insert, and then
select Insert.

To create a new
template, open the
workbook you want to
save as a template.
Press Menu and select
Rename/Move, and
then enter a name for
the template. Select
Folder, and then select
Template. Press OK.

Creating a workbook

Press Start (&) and select Programs.

Select Excel Mobile |§|

Press New T (left action key).

Highlight a cell where you want to enter text or other info.
Enter the info in the cell, and then press Enter (@).

Repeat steps 4 and 5 to enter the remaining info.

Press OK (@] to save the file.

NooswN -

Creating a workbook from a template

1. Go to the workbook list.

2. Select the Show list in the upper-left, and then select Templates.
3

Open the template you want to use and enter the information you
want to include in the template.

4. Press OK (@].

5. Rename the workbook and move it to the appropriate folder.
See “Organizing your documents” on page 138 for details.

Viewing a workbook

1. Press Start [#) and select Programs.

Select Excel Mobile [2].

In the workbook list, select the workbook you want to view.

Press View T (left action key), and then select any of the

following:

¢ Full Screen: Shows as much data as possible on the screen.
To return to the normal view, select Restore in the upper-right.

PwNDd
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Zoom: Sets the magnification level so that you can easily read
the worksheet.

Sheet: Lets you switch to a different worksheet.

Split: Divides the window into two scrollable areas. To move the
split bar, tap and drag the split bar. To remove the split bar, select
View > Remove Split.

Freeze Panes: Locks rows and columns so they remain visible
while you scroll. Highlight the cell at the juncture you want to
lock before you select this command. To unlock the rows or
columns, select View > Unfreeze Panes.

Toolbar: Sets whether the toolbar appears onscreen.

Status Bar: Sets whether the status bar appears onscreen.
Show: Sets whether headings and scroll bars appear onscreen.

Calculating a sum

NEmooAeN e

Press View T (left action key) and select Toolbar.
Highlight the cell where you want to insert the sum.
Select [F.

Tap and drag the stylus across the cells you want to add.
Press Enter @.

ntering a formula
Highlight the cell where you want to enter the formula.
Enter an = sign followed by any values, cell references, name

references, operators, and functions.
Example: =(B4/25)+100=Revenue-Expenses

3. Press Enter (@.

To jump to a cell or
region, press Menu
and select Edit > Go
To. Select Cell
reference or name
and enter the target
cell info or select
Currentregion. Select
OK.

You can also switch
worksheets by
selecting the sheet list
at the bottom of the
screen.
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Select Autofill as the
series type to quickly
fill cells with repetitive
data such as numbers
or repeated text.
Autofill takes the
content of the first cell
in the highlighted row
or column and copies
it down or across the
rest of the selection.

Inserting a function

1.

Open the workbook where you want to

h - £ | Excel Mobile
insert the function.

Ol Y| ==

Insert Function

Press Menu T (right action key) and
select Insert > Function.

Select the Category list, and then select
the type of function you want to insert.
Select the Function list, and then select the
specific function you want to insert.
Select OK.

Category:

Function:

‘AES(numher) -

Returns the absoluts value of a number.

Entering a sequence automatically

1.

Highlight both the cells containing the info
you want to automate and the adjacent
destination cells.

Press Menu 2 (right action key) and
select Edit > Fill.

Select the Direction list, and then select
the direction you want to populate.

Select the Fill type list, and then

select Series.

Select the Series type list, and then select
the type of series you want. If you select Date or Number, enter a
Step value increment.

Select OK.

73 | Excel Mabile 1 Y =

Insert Function

Categary!

-
Functon;
\AES(number) -
Returns the absolute value of a number.
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Adding cells, rows, and columns

1.

2.
3.
4

5.

Open the workbook you want to add to.

Highlight the area where you want to insert elements.

Press Menu 2 (right action key) and select Insert > Cells.
Select how you want to insert the elements:

¢ Shift cells right: Inserts a new cell. The highlighted cell and all
cells on its right move one column to the right.

e Shift cells down: Inserts a new cell. The highlighted cell and all
cells below it move down one row.

e Entire row: Inserts a new row. The entire row in which the
highlighted cell is located and all rows below it move down
one row.

e Entire column: Inserts a new column. The entire column in
which the highlighted cell is located and all columns to its right
move one column to the right.

Select OK.

Formatting cells

1.

2.
3.
4

Open the workbook you want to format.

Highlight the cells you want to format.

Press Menu —— (right action key) and select Format > Cells.
Select any of the following:

e Size: Sets the row height and column width.

e Number: Sets the type of information the cells contain.

¢ Align: Sets whether text wraps within the highlighted cells, and
sets horizontal and vertical alignment position.

To add a new
worksheet, press
Menu and select
Format > Modify
Sheets. Select Insert,
enter a name for the
worksheet, and then
press OK. To change
the order of the
worksheets, highlight
aworksheet you want
to move, and then
select Move Up or
Move Down. Press OK
to finish.

To name the
highlighted cell or
range of cells, press
Menu and select
Insert > Define Name.
Enter the name and
select Add. Press OK.
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You can adjust the
column and row size
by tapping and
dragging the right
edge of the column or
the bottom edge of
the row. To
automatically fit rows
and columns to their
contents, double-tap
the lower edge of the
row heading or the
right edge of the
column heading.

5.

¢ Font: Sets the typeface, color, size, and style attributes.

e Borders: Turns borders on and off for various cell edges, and
sets the border and background colors.

Press OK [@].

Formatting rows and columns

1.
2.
3.

4.

Open the workbook you want to format.
Highlight the rows or columns you want to format.

Press Menu —— (right action key), and then select Format > Row
or Format> Column.

Select any of the following:

¢ AutoFit: Adjusts the size of the highlighted rows or columns to
their contents.

e Hide: Hides the highlighted rows or columns.

e Unhide: Displays hidden rows or columns in the highlighted
area.

Renaming a worksheet

1.
2.

Open the workbook containing the worksheet you want to rename.

Press Menu 2 (right action key) and select Format > Modify
Sheets.

In the Sheets list, highlight the worksheet you want to rename.

Select Rename, enter a new name for the worksheet, and then press
OK (@] twice.
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Sorting info in a worksheet

1.

2.
3.
4

6.

7

Highlight the cells you want to sort.

Press Menu —— (right action key) and select Tools > Sort.

Select the Sort by list, and then select the primary sort column.
Check or uncheck the Ascending box to indicate if you want to sort
in ascending or descending order.

(Optional) Select the Then by lists, and then select second and third
level sorting options.

Check or uncheck the Exclude header row from sort box to indicate
if you want to sort the header row.

Select OK.

Filtering info in a worksheet

1.
2.

4.

Highlight the cells that contain the info you want to filter.

Press Menu > (right action key) and select Tools > AutoFilter.
A list appears at the top of each related column.

Select one of the new lists, and then select a filter. This hides all
rows that do not include the selected filter.

(Optional) Select the other lists, and then select other filters.

Creating a chart

1.

2
3.
4

Open the workbook you want to create a chart from.
Highlight the cells you want to include in the chart.
Press Menu —— (right action key) and select Insert > Chart.

Select the type of chart, and then press Next —— (right action key).

You can also create
custom filters where
you specify
comparisons. Select
the filter lists, and
then select Custom.

To display all rows
again, select the filter
lists, and then select
All. To turn off
filtering, press Menu
and select Tools >
AutoFilter again.
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9.

Confirm the area you want the chart to include, and then press
Next —— (right action key).

Select the data layout, and then press Next ——2 (right action key).
Check the boxes to indicate whether the first row and column
represent labels.

Select whether you want the chart to appear as a separate
worksheet within the current workbook, or as part of the current
worksheet.

Press Finish —— (right action key).

Formatting or changing a chart

1.

2.
3.
4.

Open the workbook that contains the chart you want to format.

Open the chart.

Press Menu 2 (right action key) and select Format > Chart.

Select any of the following:

e Titles: Sets the title of the chart and headings, whether a legend
appears, and the placement of the legend.

e Scale: Sets the minimum and maximum scales for charts with
an x or y axis.

¢ Type: Sets the chart style. You can use this setting to convert
your chart to a different format.

e Series: Lets you add, modify, format, or delete related data
points without affecting the info in your worksheet.

Press OK (@],
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Finding or replacing info in a workbook

1.

2.
3.
4

Open the workbook containing the info you want to find.

Press Menu C— (right action key) and select Edit > Find/Replace.
Select Find what and enter the info you want to find.

(Optional) Check the Match case box to find text that matches the
capitalization in any text you entered step 3.

(Optional) Check the Match whole words only box to find only full
words that match any text you entered in step 3.

Select Find to locate the first instance of the info you entered in step
3, or select Replace and enter the replacement info.

Select Next to find the next instance of the info, or select Replace to
replace it. To replace all instances of the info, select Replace All.
When you see a message that Excel Mobile is done searching,

press OK (@],

Organizing your workbooks

You can rename your workbooks, and move them to another folder and
between your smartphone and an expansion (storage) card.

1.

o0

Go to the workbook list.

Select a file.

Press Menu 2 (right action key) and select Rename/Move.
Select Name, and then enter a new name for the workbook.
Select the Folder list, and then select the folder you want to move
the workbook to.

Select the Location list, and then select Main memory or Storage
card.

When you go to a
folder, you can easily
search your documents
by sorting by type.
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To delete a workbook,
go to the workbook list
and highlight the
workbook you want to
delete. Press Menu and
select Delete. Select
Yes to confirm.

To delete a worksheet,
press Menu and select
Format > Modify
Sheets. Highlight the
worksheet you want to
delete, and then select
Delete. Select Yes, and

then press OK to finish.

Press OK (@],

Select the Show list in the upper-left, and then select the folder you
want to view.

Select the Sort By list in the upper-right, and then select the sort
method.

Deleting cells, rows, and columns

1.

2.
3.
4

Open the workbook containing the elements you want to delete.

Highlight the area you want to delete.

Press Menu 2 (right action key) and select Edit > Delete Cells.

Select how you want to remove the elements:

¢ Shift cells left: Deletes the highlighted cells and moves all cells
on their right one column to the left.

e Shift cells up: Deletes the highlighted cells and moves all cells
below them up one row.

¢ Entire row: Deletes the entire row in which the highlighted cells
are located, and moves all rows below it up one row.

¢ Entire column: Deletes the entire column in which the
highlighted cells are located, and moves all columns on their
right one column to the left.

Select OK.
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Customizing Excel Mobile

1. Go to the workbook list. Excel Mobile adjusts
2. Press Menu —— (right action key) and select Options. ;ergleﬁlslfc;ejloenc:he
3. Set any of the following options: However, a formula
¢ Template for new workbook: Sets the default template for that refers to
Kkbook deleted cell displays
new workbooks. the #REF! error value.
e Save new workbooks to: Specifies where new workbooks are
stored.

¢ Files to display in list view: Sets which types of files appear in
the workbook list.

4. Press OK [@].

Using Your Treo 700w Smartphone 153



CHAPTER 7 Staying Productive

154 Using Your Treo 700w Smartphone



Managing Files and
Applications

Using Find

With the built-in search features on your smartphone, you can find

information quickly:

e Lookup: Helps you find and dial your contacts by name or phone
number. See “Dialing by contact name” on page 41 for details.

e Search: Looks through the text in all the applications on your
smartphone.

¢ File Explorer: Lets you browse through the files and folders on
your smartphone or an expansion card.

e Global Address Lookup: Enables you to look up names in your
online corporate address list.

Using Search

Search for files and other items stored in the My Documents folder on
your smartphone or on an expansion card. You can search by file name
or by words located in the item. For example, you can search for words
within notes, appointments, contacts, and tasks.
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You can also open the
Search screen by
pressing Option + left
Shift.

If you've looked for an
item before, select the
Search for list, and
then select the item in
the list.

You can sort the
contents of a folder by
name, date, size, or
type. Select the Sort
by list in the upper-
right, and then select
the sort method.

The storage card
symbol appears next
to the names of files
that are stored on an
expansion card.

Press Start (&) and select Programs.
Select Search 0.
Select Search for, and then enter the file

name, word, or other info you want to
find.

74| search 1 Y =

Searchfor: jane b

Type: Al data -

Select the Type list, and then select the @:nvgss;gmg 7/3/05 304 K8
kind of information you want to find.
Press Search —— (left action key).

Search E Advanced

Use the 5-way to select and view an item
from the results of the search.

Exploring files and folders

File Explorer lets you browse the contents of folders on your
smartphone. The root folder on your smartphone is named My Device.
My Device is similar to My Computer on your computer.

1.
2.
3.

4.

Press Start (&) and select Programs.

Select File Explorer %)

Select the Show list in the upper-left, and then select the folder

you want to explore.

Do any of the following:

e To open an item, select it.

* To quickly delete, rename, beam, or email an item, highlight the
item, press and hold Center to open the shortcut menu, and
then select the appropriate command.
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* To move a file to another folder, highlight the item, press and
hold Center to open the shortcut menu, and then select Cut
or Copy. Open the destination folder, and press and hold Center

to open the shortcut menu, and then select Paste.

e To highlight multiple items, tap and drag the stylus.

[ ' TIMPORTANT Do not delete any files that you cannot identify.
These files may be required for your smartphone to function properly.

Installing applications

Your Palm® Treo™ 700w smartphone comes with several built-in and
ready-to-use applications. You can also install any of the additional
software included on the Getting Started CD as well as other third-party
applications that are compatible with Windows Mobile 5.0 devices,
such as business software, games, and more. To learn more, go to
www.palm.com/mytreo700wVerizon.

Applications you download to your computer are likely to be in a
compressed format such as ZIP. If the file is compressed, you need to
use a decompression utility on your computer, such as Winzip, before
you install applications on your smartphone.

These instructions tell you how to install basic files onto your
smartphone. Some software uses an installer or wizard to guide you
through the process. Consult the documentation that came with the
software for details.

If an application does
not have a Microsoft
Mobile to Market
certificate, you will
see a message
indicating that the
application is
untrusted. If this
occurs, you can
indicate whether you
want to continue the
installation.

Be sure to select and
install Microsoft
Windows Mobile 5.0
software for Pocket PC
Phone Edition.
Microsoft Windows
Mobile 5.0 software
for Smartphone is not
compatible with your
Treo 700w
smartphone.
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To install an
application from your
computer to your
smartphone,

you must first install
the ActiveSync
software on

your computer

(see “Installing the
desktop
synchronization
software” on

page 16).

You can purchase a
third-party application
that lets you run Palm
0S® applications on
your Treo 700w
smartphone.

Before purchasing a
third-party program,
try the free version

Installing applications from the Internet

You can use Internet Explorer Mobile to install Windows Mobile apps
in the CAB file format directly from the Internet. You must use your
computer to install apps in other file formats.

1.

® N oo

Make sure your phone is on (see “Turning your phone on and off”
on page 11).
Press Start [#) and select Internet Explorer.

Go to the page that contains the link to the application you want
to download.

Press Left 4 or Right P to highlight the link to the file, and then
press Center to start the download process.

Press Start [#) and select Programs.
Select File Explorer %
Go to the My Documents folder in File Explorer.

Tap the file you downloaded to start the installation program.

Installing applications from your computer

1.
2.
3.

Open My Computer or Windows Explorer on your computer.
Copy the application file(s) into the E Mobile Device folder.

Connect your smartphone to your computer to synchronize and
install the application(s) on your smartphone.
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Installing applications onto an expansion card

1. Insert the expansion card into the expansion card slot (see
“Removing and inserting expansion cards” on page 167).

2. Open the ActiveSync® window on your computer.

Click Tools and select Explore Device. )

4. Double-click My Windows Mobile-Based Device B to open the
Mobile Device folder.

5. Copy the application file(s) into the Storage Card folder inside the
Mobile Device folder.

w

Getting help with third-party applications

If a you encounter a problem with a third-party application (such as an
error message), contact the application’s author or vendor. For general
troubleshooting of third-party applications, see “Third-party
applications” on page 236.

Make sure that the third-party application supports 240x240 screen
resolution. Some older applications have screen-size limitations. Third-
party applications should also be written for Windows Mobile version 5
or later. Programs written for earlier versions do not support 5-way
navigation or action keys and can have performance problems. If you
can try a free version of the software before purchasing it, you can test
it first to make sure it works properly.
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Removing applications

Some applications L.
To free up memory on your smartphone, you can remove applications

are factory-installed

on your smartphone that you no longer use. You can remove only applications, patches, and
and cannot be extensions that you install; you cannot remove the built-in applications
de'ﬁﬁe?-grnetsseare that reside in the ROM portion of your smartphone.
EZ:‘nIOSvZ Programs 1. Press Start (&) and select Settings.
list. 2. Select the System tab, and then select Remove Programs 9.

3. Highlight the application that you want to remove.

4. Select Remove.

5. Select Yes to confirm deletion.

Remove Programs

Programs in storage memoary:

Remove

Tokal storage memory avalable: 59564k
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Setting synchronization options

Selecting which info to sync

1.
2.
3.

Press Start and select Programs.

Select ActiveSync @

Press Menu —— (right action key) and

select Options.

Do any of the following:

* Check the box next to any items you
want to synchronize. If you cannot
check a box, you might have to
uncheck a box for the same
information type elsewhere in the list.

e Uncheck the box next to any items you want to stop
synchronizing.

e Select an item and then select Settings to customize the
settings for that item. Settings are not available for all items.

e Ty

73 | Activesync

Options

Choose ths data you wank to sync:

B Contacts
M calendar

T IS

_| Notes he

Synchronizing with Exchange Server

You can sync directly with Exchange Server using a connection to
either a wireless network or a computer.

1.
2.
3.

Press Start (&) and select Programs.

Select ActiveSync @.

Press Menu C—— (right action key) and select Configure Server. If
you have not yet set up sync with Exchange Server, this says Add
Server Source.

To stop synchronizing
with one computer
completely, select the
computer name and
then select Delete.

You can also use the
Sync Setup Wizard to
set up your
smartphone to
synchronize remotely
with Exchange Server.
This wizard starts
when you connect
your smartphone to
your computer after
installing ActiveSync
on your computer.
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6.

7

Select Server address, enter the name of the server running
Exchange Server, and then press Next ——— (right action key).
Enter your name, password, and domain, and then press Next 2
(right action key). To change the rules for resolving synchronization
conflicts, select Advanced.

Check the boxes next to the type of info that you want to
synchronize with Exchange Server.

Press Finish —— (right action key).

Synchronizing with multiple computers

You can set up your smartphone to synchronize with more than one
computer as well as Exchange Server. When synchronizing with
multiple computers, the items that you synchronize appear on all of the
computers with which they synchronize.

For example, if you set up to sync different items with two computers
named C1 and C2, when you sync Contacts and Calendar on your
smartphone with both computers, you see the following result:

The contacts and calendar appointments that were on C1 are now
also on C2.

The contacts and calendar appointments that were on C2 are now
also on C1.

The contacts and calendar appointments from both computers are
on your device.

[ * 1 NOTE Microsoft® Office Outlook® E-mail can synchronize with only
one computer.
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Synchronizing using Bluetooth wireless technology
The PC with which you connect must have Bluetooth® wireless
technology, either built-in or through a Bluetooth card. Make sure that
the PC's Bluetooth setting is discoverable.

1.

® N U s ®

9.

On your PC, right-click on the ActiveSync icon in the system tray,
and select Connection Settings.

Check the Allow connections for one of the following box, and then
select Bluetooth.

On your smartphone, press Start (#) and select Settings.
Select the Connections tab, and then select Bluetooth
Check the Turn on Bluetooth box.

Press Start (&) and select Programs.

Select ActiveSync @.

Press Menu _—— (right action key) and select Connect via
Bluetooth. If this is the first time you're making a Bluetooth
connection to this PC, follow the onscreen prompts to set up a
Bluetooth partnership with the PC.

In ActiveSync, select Sync.

10. When synchronization is finished, press Menu ——— (right action

key) and select Disconnect Bluetooth.

[ & ] OPTIONAL Go to your Today screen, select Bluetooth [, and
then uncheck the Turn on Bluetooth box to conserve power by turning
off your smartphone's Bluetooth feature.
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You can also connect
your smartphone to
your computer with an
infrared (IR) or a
Bluetooth® wireless
connection.

If synchronization
doesn’t start
automatically, press
Start and select
Programs. Select
ActiveSync and then
select Sync to start
synchronization.

To end
synchronization
before it completes,

Starting and stopping synchronization

If ActiveSync is running on your computer and you connect your
smartphone to your computer, synchronization begins automatically.
If you ever need to manually start or stop synchronization follow
these steps:

1. Connect your smartphone to your computer (see “Connecting
your smartphone to your computer” on page 16). If you are only
synchronizing wirelessly with Exchange Server, you do not have
to connect the device.

2. Press Start [#) and select Programs.

3. Select ActiveSync @.

Setting the synchronization schedule

You can schedule wireless synchronization to occur automatically at
regular intervals. If you prefer to synchronize manually, do not turn
on these settings.

1. Connect your smartphone to your computer (see “Connecting

select Stop. your smartphone to your computer” on page 16). If you are only
synchronizing wirelessly with Exchange Server, you do not have
to connect the device.
2. Press Start [#) and select Programs.
3. Select ActiveSync @.
4. Press Menu —— (right action key) and select Schedule.
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5. Set any of the following options:

¢ Peak times: Sets the frequency for high-traffic time periods
such as when you are at work or when email volume is high.

o Off-peak times: Sets the frequency for low-traffic time periods
such as late at night.

¢ Use above settings while roaming: Sets the frequency while
you are roaming outside the Verizon Wireless network. To
minimize roaming charges, uncheck this box and synchronize
manually while roaming.

¢ Send outgoing items immediately: Sets whether items are
sent as soon as you select Send in the Messaging application,
or whether they are held until the next synchronization.

6. Press OK (@).

Sharing info

Your smartphone comes equipped with a variety of options for sharing
information, so that you can choose the quickest, most convenient way
to send your info or to receive info from another device.

e When you have a file open in a program such as Notes or
PowerPoint Mobile, you can easily share a file by selecting the
Menu, and then selecting Send via E-Mail or Beam File.

e |n Outlook, you can insert a picture or attach a note or other file to
an email. You can also receive pictures and attachments.

e ActiveSync® enables you to share files with your computer. You can
add or remove files directly from the Treo My Documents folder,
located in your My Documents directory on your computer. These
files are updated the next time you sync.

The auto shut off
timer resets each time
you synchronize. If
your sync interval is
shorter than the auto
shut off interval, your
smartphone doesn’t
turn off.

Decreasing the sync
frequency settings
conserves battery
power.
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Check with the card
manufacturer to
confirm compatibility
before purchasing an
SDIO card.

We recommend that
you purchase
preformatted
expansion cards. To
format a card on your
own, you need to
connect a card reader
(sold separately) to
your computer.

If you are near someone, you can beam files and applications
between your smartphone and your neighbor’s device using the IR
port or Bluetooth® wireless technology.

You can also store files on an expansion card and share the
expansion card.

Using expansion cards

The expansion card slot on your smartphone enables you to add SD
cards and MultiMediaCard cards to extend the storage capacity of your
smartphone. For example, SD or MultiMediaCard expansion cards can
store the following:

Pictures

Videos

MP3 audio files
Email attachments
Games

eBooks
Applications
Databases

When purchasing an SDIO card, make sure the card is compatible with
the Treo 700w smartphone.
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Expansion cards are sold separately. Your smartphone comes with a
dummy card inside the expansion card slot, to protect the slot. When
you do not have a functioning card inside the slot, reinsert the dummy SD cards are faster

. than MultiMediaCard
card to protect the slot opening. cards for reading and

writing information.

Removing and inserting expansion cards
1. Press down and release the dummy card.

2. After you feel the expansion card slot eject the dummy card,
remove the card from the slot.

3. To insert an expansion card, hold your smartphone with the screen
facing you and the card with the label facing you. The notch on the
card should be in the lower-left corner next to the antenna.

4. Insert the card into the expansion card slot until you feel it lock into
place and hear the confirmation tone.
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% Tip

In order to run an
application on an
expansion card, your
smartphone must
have enough free Notch

space in the internal \
memory to run the

application.

Opening applications on an expansion card

After you insert an expansion card in the expansion card slot, you can
open any of the applications stored on the expansion card.

1. Insert the expansion card into the expansion card slot.

Press Start [#) and select Programs.

Select File Explorer.

Select the Show list in the upper-left, and then select Storage Card.
Select the application you want to open.

o prwN
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Saving files to an expansion card

You may find it helpful to automatically save the info on an expansion
card. For example, when you create new Word Mobile documents,
notes, Excel Mobile workbooks, pictures, videos, and audio files, you
can save them directly to an expansion card. (Some applications may
not support this feature.)

1.

o wN

Insert an expansion card into the expansion card slot.
Open the application you want to save the info from.
Press Menu > (right action key) and select Options.
Select the Save to list, and then select Storage Card.
Press OK [@].

Moving info between your smartphone and
an expansion card

1.

oW

Insert an expansion card into the expansion card slot.

Open the application from which you want to move the info.
Go to the list view.

Press Menu 7 (right action key) and select Rename/Move.

Select the Location list, and then select where you want to move the

info: Storage Card or Main Memory.
Press OK (@].

If you don’t see the
Save to list on the
Options screen, look
on the other tabs (if
present). If you still
can’t find a Save to
list, the application
may not support this
feature.
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Copying or moving applications and files between
Your applications are your smartphone and an expansion card

usually located in the
My Device / Program

1.

Insert the expansion card into the expansion card slot.

Files folder. 2. Press Start (&) and select Programs.
3. Select File Explorer.
4. Select the file or application you want to copy or move (see
“Exploring files and folders” on page 156).
5. Press Menu C—— (right action key) and select Edit > Copy or Edit >
Cut.
6. Go to the folder where you want to place the selected item.
7. Press Menu 2 (right action key) and select Edit > Paste.
8. Press OK (@],
Viewing available expansion card memory
You can view how much space is available on the expansion card that
is currently in the expansion card slot.
1. Insert the expansion card into the expansion card slot.
2. Press Start [#) and select Settings.
3. Select the System tab, and then select Memory .
4. Select the Storage Card tab.
5. Press OK [@].
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Exploring files on an expansion card

2 A

Insert the expansion card into the expansion card slot.

Press Start (#) and select Programs.

Select File Explorer.

Select the Show list in the upper-left, and then select Storage Card.
Select the folder or files you want to view.

Press OK [@].

Renaming an expansion card

If you change the contents of an expansion card, you may at some point
want to rename the card to better match its contents.

1.

akrwd

N o

Insert the expansion card into the expansion card slot.

Press Start () and select Programs.

Select File Explorer.

Select the Show list in the upper-left, and then select My Device.
Highlight the current expansion card name (Storage Card by
default).

Press Menu ——— (right action key) and select Rename.

Enter a new name for the card.

Press OK (@].

Before copying
information to or
renaming the files or
folders on an
expansion card, or
renaming the card
itself, make sure the
card is not write-
protected. See the
instructionsthatcame
with your card for
details.
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Customizing Your
Smartphone

Today screen settings

Selecting your Today screen background

1.
2.

o

Press Start (&) and select Settings.
On the Personal tab, select Today %

On the Appearance tab, check the Use this
picture as the background box.

Select Browse.
Select the picture you want to use.
Press OK (@].

74 | settings 0 Y| &= BR

Today

Select a theme for your device:

Guava Bubbles Beam
Indigo
Windows Default

[Use this pickure as the background|

Appearance | Items

There are lots of
third-party plug-ins
available for your
Today screen. For
clocks, calculators,
MP3 players, weather
guides, and much
more, visit
www.palm.com/
mytreo700wVerizon.
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www.palm.com/mytreo700wVerizon
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http://www.palm.com

To change the color
theme for your
smartphone, select a
new theme from the
Appearance tab in
Today Settings.

Selecting which items appear on your Today screen

1.

2.
3.
4

Press Start (&) and select Settings.
On the Personal tab, select Today %
Select the Items tab.

Check the boxes next to the items you
want to appear on your Today screen and
uncheck any items that you want to hide.

(Optional) Select Options (if available) to

configure the settings for the current item.

Press OK (@] to return to Today Settings.
Press OK (@],

72 | settings [ Y =

Today

Checked items sppear on the Taday screen.
Llpate [(oveun |
B, 2

Today timeout:
Appearance | Tems |
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Phone settings

Selecting ringtones and vibrate settings

You can set different tones for different types of incoming phone calls

and notifications.

1. Press Start (&) and select Settings.

2. On the Personal tab, select Sounds & Notifications Q\E

3. Make sure your phone is on.

[ * INOTE If your phone is off, the notification tab changes to allow you

to select general notification settings. See “Selecting Sounds &

Notifications” on page 181.

4. Select the Notifications tab.

5. Select the Event list, and then select which type of call or
notification you want to set the ringtone for:
¢ Phone: Known Caller: An incoming

call from someone in your Contacts list

or Speed Dial list.

¢ Phone: Missed call: A call you did not
answer.

¢ Phone: Roaming: A call that comes in
when you're outside your home mobile
network.

Ring tone:

wibrate when ringer switch off
[] vibrate when ringer switch on

Notifications | Manage
E

e Phone: Unknown Caller: An
incoming call from someone identified
by caller ID who is not in your Contacts list or Speed Dial list.

e Phone: Voice mail: A new voicemail.

Turn on your phone to
access your Phone
Settings. See “Turning
your phone on and
off” on page 11.

You can download
MP3, MIDI, QCELP,
WAV, and WMA
ringtones directly to
your smartphone (see
“Downloading files
and images from a
web page” on

page 107). You can
also download
ringtones to your
computer and then
email them to your
phone.
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To record, preview,
delete, and send
sounds on your
smartphone, select
Manage. To record a
sound, press Menu
and select New
Sound. To play a
sound, select it. To
delete a sound,
highlight it and press
Backspace. To send
a sound, highlight it,
press Menu and select
Send Sound.

You can also set
sounds for messaging
notifications and
calendar reminders.
See “Selecting

9.

10.
1.

Select the Ring type list, and then select the ring style for the
selected type of call.

Select the Ring tone list, and then select the sound for the selected
type of call.

Check the Vibrate when... boxes to turn the vibrate feature on/off
based on the ringer switch setting.

(Optional) Select Play to preview the sound.
Repeat steps 4-7 to select ringtones for other types of calls.
Press OK (@],

Adjusting volume settings

Call volume: While a call is in progress, press the Volume button
(on the side of your smartphone) to adjust the call volume.

Music/Video volume: While playing music or a video, press
the Volume button to adjust the music/video volume.

Ringer volume: When a call is not in progress and you are not
playing music or a video, press the Volume button to adjust ringer
volume.

Sounds &
Notificati " . . . .
page 181 Assigning a picture and ringtone ID to a contact
1. Press Start [#) and select Contacts.
2. Highlight the contact you want to give a picture caller ID, and
then press Center
3. Highlight the contact’s name, and press Edit T (left action key).
4. Select Picture, and then press Center
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5. Select Camera to take a picture and add it to this contact entry
(if your smartphone includes a camera), or select an existing
picture for this contact entry.

6. Select Ring tone, and then press Center . Select a tone for this
contact entry.

Selecting your call settings

1. Press Start (&) and select Settings.

2. On the Personal tab, select Phone (.

3. On the Phone tab, set any of the
following options:

¢ Dialpad: Sets the style for the dial
pad tones (DTMF) in the Phone
application.

— Short tones: Tones sound briefly
as you dial.

— Long tones: Tones continue to
sound until you release the key.

e TTY/TDD: Lets you configure your smartphone for use with a
TTY/TDD device for people who are deaf or hard of hearing.

e After calls from numbers that are not in Contacts, ask if |
want to add them: Indicates whether you are prompted to add
contact entries for numbers that are not already in your
Contacts list.

4. Press OK (@] to finish.

After calls from numbers that are not
in Contacts, ask if I want to add
them.

Set ring tones For incoming cals.

Phone | Services | Hetwork | Security

Turn on your phone
to access your Phone
Settings. See
“Turning your phone
on and off” on

page 11.

If you have trouble
accessing a voicemail
system, try changing
the Dialpad tone
setting.
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Selecting your privacy settings

For quick access to the 1. Press Start (&) and select Settings.
Location Privacy

setting, tap the 2. On the Personal tab, select Phone (.
Location Privacy icon 3. Select the Services tab and set any of the
on your Today Screen. following options:

e Voice Privacy: Prevents over-the-air
eavesdropping when this option is
turned on and this feature is available
on the Verizon Wireless network.

¢ Location Privacy: Indicates whether
your smartphone broadcasts your

72 | settings [ Y =

Phone

To access settings for a service,
select it from the following list.

lLocation Privacy

Services | Network | Security

location at all times, or only during a 911 call.

4. Press OK to return to Phone Settings.
5. Press OK

178 Using Your Treo 700w Smartphone



Selecting your wireless band

The wireless band setting is preset for optimum performance. Do not
change this setting unless instructed to do so by a Verizon Wireless
representative.

1.

2.
3.
4

Press Start [#) and select Settings.
On the Personal tab, select Phone .
Select the Network tab.

Select the Band selection list, and then
select the band you want your
smartphone to use to connect to the
Verizon Wireless network.

Press OK (@] to finish.

Phone - (408) §55 -2760

Band selection: |V IEEE]

Phone | Services | Hetwork | Security
|
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If the ringer switch

is set to no sound,
the ringer setting
overrides the sound
settings and all
sounds are turned off,
including any music
you may be playing.

Your smartphone
includes a silent
alarm that can vibrate
even when the ringer
switch is set to Sound
Mode Off.

System sound settings

In certain situations, such as meetings and theaters, you need to turn off
all sounds on your smartphone. You can immediately silence all sounds
on your smartphone, including phone ringtones, Calendar notifications,
and system sounds. This does not mute the speaker during phone calls.

Setting the ringer switch
1. Slide the ringer switch to Sound Mode Off ¢& .

2. To hear all sounds again, slide the ringer switch to Sound Mode
On o).

When you slide the ringer switch back to the Sound Mode On position,
it restores the previous sound settings. For example, if the smartphone
ring volume is set to the loudest setting and you slide the ringer switch
to Sound Mode Off, you do not hear the smartphone ring. When you
move the ringer switch back to Sound Mode On, the smartphone ring
volume is still set to the loudest setting.

>)§8'J

L ———]

Sound
Mode On

Sound
Mode Off
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Selecting Sounds & Notifications

1. Press Start [#) and select Settings.

2. On the Personal tab, select Sounds & Notifications @),
3. On the Sounds tab, set any of the following options:

e Events: Turns sounds on/off for
system warnings and error messages.

¢ Programs: Turns sounds on/off in the
applications on your smartphone.

¢ Notifications: Turns alarms and
reminders on/off in the applications on
your smartphone.

e Screen taps: Turns sounds associated
with tapping the screen on/off, and sets
the volume level when this sound is
turned on.

¢ Hardware buttons: Turns sounds associated with pressing
buttons on/off, and sets the volume level when this sound is
turned on.

4. Turn your phone off.

72 | settings

Sounds & Notifications

Enable sounds for

[Events (warnings, system events)
Pragrams
Matifications (alarms, reminders)

[ sereen taps

[[] Herdware buttons
8]

Sounds | Motifications | Manage

[ * 1NOTE If your phone is on, the notification tab changes to allow you
to select phone notification settings. See “Selecting ringtones and
vibrate settings” on page 175.
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To record, preview,
delete, and send
sounds on your
smartphone, select
the Manage tab. To
record a sound, press
Menu and select New
Sound. To play a
sound, select it and
press Play. To delete
a sound, highlight it
and press Backspace.
To send a sound,
highlight it, press
Menu, and select
Send Sound.

Select the Notifications tab and set any of the following options:

e Event: Specifies which action you
want to change the settings for. The
remaining options vary based on the
action you select.

¢ Play sound: Lets you turn the sound
on/off for the selected event. To select a
different sound select the list to the
right of this setting, and then select a
different sound. To preview the sound,
select Play Sound, and then select Play.

¢ Repeat: Indicates whether the sound
plays more than once, if turned on.

¢ Display message on screen: Indicates whether a notification
message appears onscreen for the selected event.

e Vibrate: Indicates whether your smartphone vibrates to notify
you about the selected event.

Press OK (@],

73 | settings

Sounds & Notifications

Begin sync -

[1Play sound I:l
Bl

[] vibrate when ringer switch off
D “ibrate when ringer switch on

Nottcatons [ ]
B
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Display and appearance settings

Adjusting the brightness

1. Press Option (), and then press .

2. Press Left €4 and Right P to adjust the brightness.
3. Press OK (®].

Changing the text size

1. Press Start [#) and select Settings.

Select the System tab, and then select Screen E\
Select the Text Size tab.
Press Left 4 and Right
Press OK [@].

to adjust the text size.

oprpwN

Setting display formats
1. Press Start [#) and select Settings.
2. Select the System tab, and then select
Regional Settings 0
3. On the Region tab, select a region from
the list. The region selection sets the
default format settings.
4. (Optional) Select any of the following tabs
to customize the format settings:
¢ Number: Sets the decimal symbol and
number of decimal places, the digit
grouping symbol and group size, list separators, negative

73 | settings

Regional Settings

Appearance samples
123,456,759,00
$123,456,789.00
Time: 607:52 M
Short date: 7I3f0s

Positive numbers:
Positive currency:

Long date: Sunday, July 03, 2005

Region | Number | Currency | Time: | Date

If text looks rough
around the edges,
open the Screen
Settings screen and
select Clear Type.
Check the Enable
Clear Type box, and
then press OK.
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You can also set the
background for your
Today screen (see
“Selecting your Today
screen background”

number sign symbol and format, leading zero display, and
measurement system (metric vs. U.S.).

e Currency: Sets the currency symbol and position, the decimal
symbol and position, digit grouping symbol and group size, and
negative number format.

on page 173). e Time: Sets the time style, separators, and AM and PM symbols.
e Date: Sets the short date style, separators, and long date style.
5. Press OK (@].
Aligning the screen
Occasionally, your screen can move out of alignment, causing the
wrong feature to activate when you tap the screen. If this occurs, you
need to align your smartphone screen.
1. Press Start (&) and select Settings.
2. Select the System tab, and then select Screen E\
3. On the General tab, select Align Screen.
4. Tap the screen where indicated.
5. Press OK [®].
Changing the system color scheme
1. Press Start (&) and select Settings.
2. On the Personal tab, and then select Today %
3. On the Appearance tab, select a theme in the list.
4. Press OK [@].
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Application settings

Arranging the Start menu

You can select which applications appear in
the top level of the Start menu. You can still
access the remaining applications by
selecting Programs from the Start menu, and
then selecting the application’s icon.

1. Press Start [#) and select Settings.
2. On the Personal tab, select Menus m

3. Check the boxes next to the applications
you want to see in the Start menu.

4. Press OK (@].

Reassigning buttons

Buttons Settings lets you select which

applications are associated with many of the

buttons and key combinations on your

smartphone.

1. Press Start (&) and select Settings.

2. On the Personal tab, select Buttons

3. On the Program Buttons tab, highlight the
button or key combination you want to
change in the Buttons list. The hardware
buttons are mapped to the following
button numbers:

e Start (%) = Start Menu.

73 | settings G0 Y == G

Menus

Checked items appear in the Start menu.
Others appear in Programs.

Tl

[

O calculator
W= calendar
i@ camnera
[VIES] Contacts
[« bownioad Agent
[ 18 Movamioyack

4]

/4 | settings (0 Y = bR
Buttons
1. Select a button:
Button ‘ Assignment -
P Start <Start Menus 5]
oK <OK/Closex =
4] ] ¥

2. Assign a program:

i

Program Buttons | Up/Down Cantral
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To enter a suggested
word, simply tap it.

You can also press the
Voice Command
button during a
question to interrupt.
Once the microphone
icon is visible you may
say your answer.

5.

e OK (8] = OK/Close.

e Option O) + Phone/Send (&) = Internet Explorer.
e Option () + Start (%) = Calendar.

e Option O + OK (@ = Task Manager.

¢ Side button = Windows Media.

Select the Assign a program list, and then select the application
you want to assign to the button or key combination you selected
in step 3.

Press OK [@].

Setting up voice commands

Voice commands enable you to use speech to execute some commands
on the Start menu and the Programs menu.

1.

Assign the Hold Side button to Voice
Command. See “Reassigning
buttons” on page 185 for details. e e

Press Start [#) and select Settings. 2 rabied [ Pazeword Profacted
On the Personal tab, select Voice Checked items are voice enabled
Command. [Elcalendar

Select Enable.

Select the items you want to enable. If
an item is highlighted and the Options
box is active, select the Options box
to choose the features you want
enabled for the highlighted item.

74 | settings
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Using voice commands

1. Hold your device about nine inches away from your mouth, and
then press and release the Voice Command button. A tone plays
and a microphone icon appears at the top of your screen.

Set the ringer switch
at the top of your
smartphone to On.

2. In aclear voice say the command. For example:

e To access Help, say,“Help.” After Voice Command finishes
speaking, a microphone icon appears at the top of your screen.
Say your answer. For example, say, “General” to access general
Help topics.

e To access your Calendar, say, “Start Calendar.”

e To access your music, say, “Start Windows Media.” After Voice
Command finishes speaking, a microphone icon appears at the
top of your screen. Say your answer.

Setting input options
1. Press Start (&) and select Settings.
2. On the Personal tab, select Input .

3. Select the Word Completion tab and set any of the following
options:
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¢ Suggest words when entering text:
Indicates whether word suggestions
appear as you enter text. You can also
specify how many letters you want to
enter before a suggestion appears, how
many suggestions you want to see, and
whether a space appears after you
insert a suggested word.

¢ Replace text as you type: Indicates
whether the text you type adds to

73 | settings

Input

Suggest after entering etter(s)

Suggest word(s)

Add a space after suggested word
Replace text as you type

Input Methad | Word Completion | Gptions
|

existing text or replaces it. This is similar to the Insert function

on a computer keyboard.

Select the Options tab and set any of the following options:

e \Voice recording format: Sets the format
in which you save voice notes.

¢ Default zoom level for writing: Sets
the initial size of text entered using
onscreen writing methods.

e Default zoom level for typing: Sets
the initial size of text entered using the
keyboard.

e Capitalize first letter of sentence:
Sets whether the first letter of a
sentence automatically appears in

72 | settings [0 T = R

Input

Yoics recording Format:

Default zoom level for writing: ~ [200% =
Default zoom level for typing:

Capitalize first letter of sentence
Serall upon reaching the last line

Input Method | Word Complation | Options
E

uppercase, without pressing one of the Shift keys.

e Scroll upon reaching the last line: Sets whether the display
automatically scrolls when you select the last line of visible info.
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Locking your smartphone and info

Your smartphone includes several features that help you protect your
smartphone from inadvertent use and keep your information private.
The built-in security software lets you use your smartphone for
emergency calls, such as dialing 911, even if it is locked.

* Keyguard: Manually disables all buttons and the screen’s touch-
sensitive feature to prevent accidental presses in your briefcase
or pocket.

e Auto-Keyguard and touchscreen lockout: Automatically
enables Keyguard after a period of inactivity and lets you disable
the screen’s touch-sensitive feature during an active call.

e Phone Lock: Requires a lock code to make calls.

e System password lock: Requires a password to see any
information on your smartphone.

Using Keyguard

By default, your keyboard locks so that you don’t accidentally press
buttons or activate screen items while your smartphone is in a pocket
or bag.

e To disable Keyguard, press Center

e To manually turn on Keyguard when your smartphone screen on,
press Option () and Power/End (@) to enable Keyguard.

To avoid accidentally
pressing onscreen
buttons while you're
holding your
smartphone up to
your ear to speak, you
can disable the
screen’s touch-
sensitive feature
during active calls.
When the screen’s
touch-sensitive
feature is disabled,
you must use the
5-way navigator to
access items on the
screen.
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If you're using a
headset or hands-free
device and your
smartphoneisin a
pocket or bag, you
can manually turn on
Keyguard during a
call to prevent
accidental key
presses. Press Option
and Power/End to
manually turn on
Keyguard.

When Phone Lock is
on, you can unlock
your smartphone by
going to the Today
screen, entering your
lock code, and then
selecting Enter. You
do not need to enter
your password to
answer a call.

Using Auto-Keyguard and
touchscreen lockout

Auto-Keyguard lets you automatically lock the keyboard after a period
of inactivity.

1. Press Start (&) and select Settings.

2. On the Personal tab, select Keyguard @
3. Set any of the following options:

¢ Auto-Keyguard: Sets the period of
inactivity that passes before the
keyboard automatically locks, or
disables the auto-keyguard feature.

¢ Disable touchscreen: Indicates
whether the screen’s touch-sensitive
feature is enabled during a call.

4. Press OK (@].

72 | settings [ Y =

Keyquard

Auto-Keyguard:

Press Option+Pawer button to manually
enable the Keyguard.

Disable touchscreen:
[[] wihile on callin Today Screen

Using Phone Lock

You can lock your smartphone to prevent unauthorized use of your
mobile account. When your smartphone is locked, you must enter a
lock code to place calls, except for emergency numbers.
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1. Press Start (&) and select Settings.

72 | settings

2. On the Personal tab, select Phone . Phone - Currently Unlocked

3. Select the Security tab and set any of the Locking prevents all outgaing cals
. . except emergency calls.
following options:

e Auto-lock: Sets whether your

smartphone locks automatically and

when this occurs.
° Change Lock code: Lets yOU aSSign Phone Services|Natwnrk|5ecunty

or change the lock code used to unlock |—‘

your smartphone. Your default lock

code is the last four digits of your mobile phone number. If you

change the lock code, select OK to accept your new code.
4. Press OK (@] to finish.

Auto-lock:

Using system password lock

To protect your personal information, you can lock the system so that
you need to enter your password to access any of your information or
use other features of your smartphone.

[ ' TIMPORTANT If you lock your system, you must enter the exact
password to unlock it. If you enter an incorrect password, you are given
another chance. Each time an incorrect password is entered, you are
given progressively longer time periods between your chances to enter
the password. If you forget the password, you need to perform a hard
reset to resume using your smartphone. Performing a hard reset
deletes all the entries in your smartphone. However, you can restore all
previously synchronized info the next time you sync (see
“Synchronizing contacts and other info” on page 32).
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1. Press Start [#) and select Settings.
2. On the Personal tab, select Lock ©%,.
3. On the Password tab, check the Prompt

! ¢ 74 | settings & e BR
if device unused for box to turn on the P )
password feature. ———
4. Select the first list, and then select how Password type: [SImpls PIN s
long a period of inactivity must pass e
before you are prompted to enter a cotim [ ]

password to unlock the system.

5. Select the Password type list, and then password [Ht ||
select a format for your password. [=]

6. Select Password, tap the onscreen
keyboard,@| icon, and enter your password. Then tap the onscreen
keyboard =] icon.

7. Select Confirm, tap the onscreen keyboard icon, and enter the
password again. Then tap the onscreen keyboard|[i] icon.

8. (Optional) Select the Hint tab and enter a hint to help you recall
your password.

9. Press OK (@],
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Entering owner information

You can enter personal information that you want to associate with You can also display
your smartphone, such as your name, company name, and phone your Owner

P . Information on your
number. You can also set whether you want this information to appear Today screen. See
when you turn on your smartphone. If you lose your smartphone, this “Selecting which

feature can help the person who finds it return it to you. items appear on your
Today screen” on

1. Press Start [#) and select Settings. page 174 for details.
2. On the Personal tab, select Owner pE—
Information (. e —
3. On the Identification tab, enter any of the eeanyi | Creatlvel Sooart
contact information you want to include. e i
4. Sele_c_t the Notes tab and thgn enter any o BT S
additional text you want to include. vl | BTGRP
5. Select the Options tab and check the ideriicatn)| tes | Options |

boxes to indicate which info (if any) you =

want to appear on the screen when you
turn on your smartphone.

6. Press OK (@),
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By default your
smartphone
synchronizes the date,
time, and time zone
with the Verizon
Wireless network
whenever your phone
is on and you are
inside a coverage
area. You can disable
this option in Clock &
Alarms Settings by
selecting More, and
then unchecking the
Enable local network
time box. If you want
to keep your
smartphone date and
time set for your
selected location,
uncheck the Use
network time zone
box.

To set the display
format for the date
and time, see “Setting
display formats” on
page 183.

System settings

Setting the date and time

Clock & Alarms Settings lets you set the time zone, time, and date for
your home location and a location that you visit.

1.

2.
3.
4

Press Start () and select Settings.

Select the System tab, and then select Clock & Alarms @

On the Time tab, select Home.

Select the first list, and then select the
time zone for your home location.

Select the hour, and then press Up a or
Down ¥ to increase or decrease the hour
setting. Repeat this process for the
minute, seconds, and AM/PM settings.
(Optional) Select Visiting and set the info
for a location that you visit often.

Press OK (@],

If prompted, select Yes to accept your
changes.

72 | settings

Clock & Alarms

(@ Home

GMT-8 Pacific U5~

6:37:10 PM : -

7/ 3/20035 -

o[-

Alarms | Mare |

() visiting
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Setting system alarms

System alarms let you set alarms that are not associated with a task or
appointment. For example, you can use your smartphone as an alarm
clock when you travel, or set alarms to remind you when it’s time to
take medication or pick up the kids.

1.
2.

7

8.

9.

Press Start [#) and select Settings.

Select the System tab, and then select Clock & Alarms
Clock & Alarms @ Rise and shine s
s I < !
Select the Alarms tab. ki
|:| < Description > b o
Check a box to turn on that alarm. sETwWTES £:00 M
Select the description next to the box you | < pessistin > @
.. sETwWTFs 6:00 AM
checked and enter a description for the
a I arm Time Alarms Maore
’ Edit BE

Select the days of the week you want the
alarm to go off. You can select multiple
days for each alarm.

Select the time you want the alarm to go off, and then press OK [@].

Select i, check the boxes to select how you want the alarm to go
off, and then press OK [@].

Press OK (@] to finish.

10. If prompted, select Yes to accept your changes.

To change the alarm
sound, select the
alarm sound icon,
select the Play Sound
list, and then select
the alarm sound you
want to use.
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To delete a certificate,
tap and hold the
certificate in the list,
and then select Delete
from the shortcut
menu.

This error reporting
method meets the
privacy regulations
of the European
Union (EU) as well as
the Fair Information
Practice Principles of
the Federal Trade
Commission. To view
the Fair Information
Practice Principles,
visit the Federal Trade
Commission website
at www.ftc.gov/

reports/privacy3/
fairinfo.htm.

Managing identity certificates

Your smartphone may include preinstalled certificates. Certificates

are digital documents that are used to authenticate and exchange
information on networks. Certificates can be issued for a user, a device,
or a service.

1. Press Start (&) and select Settings.
2. Select the System tab, and then select Certificates .
3. Select any of the following:

* Personal: Displays certificates that establish your identity when
you log in to a secured network, such as a corporate network.

* Root: Displays certificates that identify the computers, such as
servers, that you connect to. These certificates help prevent
unauthorized users from accessing your smartphone and
information.

4. Press OK (@] to finish.

Enabling error reporting

Error Reporting sends info that helps diagnose application errors for
devices running Windows Mobile software. When an error is detected,
a text file is created. You can review the file and choose whether you
want it delivered to technical support. The information is used by
programming groups at Microsoft for quality control and is not used
for tracking individual users or installations for any marketing purpose.
The info that is collected is technical info about the state of your system
when the error occurred. No documents (or any info contained in them)
are intentionally sent with the report. To ensure further security, the
report is transmitted via a secure connection and is kept confidential
and anonymous in a limited-access database.
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If your smartphone is connected to your computer when you send the
error report, you are not billed for sending error reports—provided your
computer is connected to the Internet. If you use the Verizon Wireless
network to send an error report, data transfer charges apply.

1. Press Start (&) and select Settings.

2. Select the System tab, and then select Error Reporting @
3. Select whether you want to enable or disable error reporting.
4. Press OK (@] to finish.

Setting up a GPS device

If you purchased an optional Global Positioning System (GPS) receiver,
your smartphone can show your exact location on a map.

1. Press Start (&) and select Settings.

2. Select the System tab, and then select GPS .

3. On the Programs tab, select the GPS program port list, and then
select the port for applications to use to access GPS info. This port
must also be selected in your GPS application’s configuration
settings.

4. Select the Hardware tab.

5. Select the GPS hardware port list, and then select the port to which
your GPS receiver is connected. This must be a different port from
the one you set in step 4 as your program port. To connect to the
GPS device using a Bluetooth connection, you must first set up a
partnership between the two devices (see “Setting up a Bluetooth
connection” on page 110.)
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6. Select the Access tab and check the Manage GPS automatically box.
This setting lets more than one application simultaneously access
your GPS info.

7. Press OK (@] to finish.

Viewing memory usage

1. Press Start [#) and select Settings.

2. Select the System tab, and then select Memory .
3. Select any of the following tabs:

e Main: Displays the amount of memory assigned to your
applications and info, as well as the amount of memory in use
versus the available memory.

e Storage Card: Displays the amount of memory available on an
expansion card that is inserted in the expansion slot on your
smartphone.

* Running Programs: Lists the applications that are in use on
your smartphone. To switch to an application, highlight it and
select Activate. To close an application, highlight it and select
Stop. To close all open applications, select Stop All.

4. Press OK (@] to finish.
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74 | settings

73 | settings

73 | settings

Main ‘ Storage Card ‘ Running Programs |

Memary Memory Memory
Storage Program Total storage card memary:  30.53 MB Running Programs List:
Tatal: 61,72 MB Total:  25.46MB | | 1 use: 13.40ME  Free: 17.13 MB Calendar
Inuse: 3.57MB Inuse: 14.25MEB ArtiveSync
Free: Seisie Free 11civp | | DD ]
‘Smrage Card v|

][ Stopall |

Main | storage Card | Running Programs ‘

Main | Storage Card | Running Programs

Find largs files using storage memary.

Find large Files using storage memory.

Find large Files using storage memory.

Viewing and optimizing power settings
1. Press Start (&) and select Settings.
2. Select the System tab, and then select Power {k

3. On the Battery tab, view the power remaining in your battery.
4

Select the Advanced tab and set whether your smartphone’s screen
turns off automatically after a specified period of inactivity. You can
assign different intervals for battery power and external power.

5. Press OK (@] to finish.

To conserve
additional battery
power, adjust the
display backlight
setting. Press Start
and select Settings.
Selectthe System tab,
and then select
Backlight. On the
Battery Power tab, set
whether the display
backlight turns off
automatically after a
period of inactivity.
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74 | settings

To change the settings Power
for one of the
displayed wireless
features, select Menu
and select the
wireless feature you
want to change.

Main battery:
Bathery powst remaining: On

battery power:
o — (5 i e
On external power:

L:;”d?g device if not

Battery | Wireless | Advanced

Turning Wireless Services On/Off

1. Press Start (&) and select Settings.

2. Select the Connections tab, and then
select Wireless Manager.

3. Turn your smartphone’s wireless features
on/off. Select All to turn all wireless
features on/off.

4. Press OK (@] to finish.

You can also turn wireless services on and off
by tapping the signal-strength Y| icon at the
top of the screen and then selecting Wireless
Manager.

Lilon

attery | Wirckess | Advanced |
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Connection settings

Setting up a Wi-Fi® connection

Many corporate organizations and public environments, such as coffee
shops, airports, and libraries, offer access to a Wi-Fi network. A Wi-Fi
network is a wireless local area network (WLAN) based on the 802.11
standard. When you purchase an optional Wi-Fi SDIO card, you can use
your smartphone’s built-in software to set up a Wi-Fi connection and
quickly connect your smartphone to a Wi-Fi network when you’re within
range of an accessible Wi-Fi network.

Some Wi-Fi networks are known as open networks because they
broadcast their name (SSID) and do not require a password. Other Wi-Fi
networks broadcast their name but do require a password. Networks
that do not broadcast their name are known as closed networks. Follow
the instructions for the type of network you want to connect to.

[ *]1NOTE See “Regulatory Information” on page 245 for additional
guidance on using a Wi-Fi card with your Treo 700w smartphone.

[ ' TIMPORTANT Depending on where you are on a network and
certain coverage conditions, you might experience interruptions with
your phone operation while using a Wi-Fi card. Palm recommends that
you turn off the phone radio when using any Wi-Fi card or remove the
Wi-Fi card when not in use to ensure that you can always make and
receive phone calls. For EMERGENCY calls, always remove the card
from your smartphone to ensure optimal connectivity.

Turning off the
Bluetooth® feature
may improve your Wi-
Fi card performance.
To turn the Bluetooth
feature off, go to your
Today screen, tap the
Bluetooth icon, and
then uncheck the Turn
on Bluetooth box.

Wi-Fi access point
(also called a hotspot)
A network device with
an antenna that
provides wireless
connections to a
larger network.

SSID The name that
identifies a Wi-Fi
network. If a network
does not broadcast its
SSID, you must get
the SSID from the
system administrator
in order to connect to
the network.
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You can conserve
battery power by
removing the Wi-Fi
card or turning off

a Wi-Fi connection
when you are not
planning to use it for
an extended period.

Connecting to a network that broadcasts its name
Wi-Fi networks in public places often broadcast their network name.
Your smartphone automatically attempts to detect some network
settings, so you can connect to this type of network with minimal
configuration.

1. Wake up your smartphone’s screen (see “Waking up the screen
and turning it off” on page 11).

2. Insert the Wi-Fi card into the expansion slot (see “Removing and
inserting expansion cards” on page 167).

3. Ifthe Multiple Networks Detected dialog box appears, select the
network you want to connect to.

4. When the New Network Detected dialog box appears, select the
type of network you want to connect to.

5. Press Connect ) (left action key) to connect to the network.

6. If prompted, enter the password provided by the system
administrator.

Connecting to a closed network

Since closed networks have additional security features, your
smartphone cannot detect the network’s settings; you must obtain the
settings from the system administrator and enter the settings manually.
You can also use these steps to manually create a connection with an
open network.
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1. Wake up your smartphone’s screen (see “Waking up the screen
and turning it off” on page 11), and then insert the Wi-Fi card into
the expansion slot (“Removing and inserting expansion cards” on

page 167).

Tap Wi-Fi & in the title bar.

Select the Settings link.

Select Network Cards @;‘f

Select Add New.

On the General tab, set the following:

¢ Network Name: Specifies the SSID
provided by the system administrator.

e Connects to: Specifies whether this
connections connects to the Internet or

oo pwNd

73 | settings

Configure Wireless Network (7]

Connects bo: | The Internet -

[ This is & device-to-device (ad-hac)
connection

General | Metwork Key | 802, 1x

to Work. You may need to select Work to access a corporate

intranet.

¢ This is a device to device (adhoc) connection: Indicates
whether you're connecting to another device or to an access

point (network).

7. Select the Network Key tab, and then set the following:
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Authentication: Sets the method
used to identify devices that connect to
the network.

— Open: Indicates the network uses
open authentication.

— Shared: Indicates the network uses
shared authentication.

— WPA: Indicates the network is a
WPA network that uses 802.1x
protocols.

— WPA-PSK: Indicates the network is a WPA network that
requires a pre-shared key (password).

Data Encryption: Sets the encryption method. The options in

this list vary based on your Authentication setting.

— Disabled: Turns data encryption off.

— WEP: Turns on the wired equivalent privacy encryption
method.

— TKIP: Turns on the temporal key integrity protocol encryption
method. This method is often used to encrypt WPA and
WPA-PSK connections.

The key is automatically provided: Indicates whether you

need to specify the Network key and Key index provided by

your system administrator, or whether the network provides this
information. The availability of these options varies based on
your Authentication and Data Encryption settings.

73 | settings
Configure Network Authentication @G

Authentication:

Data Encryption:  [WEP -~
[ [The ke s automatically provided

Key index:

Metwork Key | 802 1x
|
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8.

9.

Select the 802.1x tab, and then set the
following if available (the settings vary
based on your settings on the other tabs

72 | settings i =R

Configure Network Authentication

[Use IEEE 802, 1x network access control
EAP type: [PEAP

and on the supported features of your -

Wi-Fi SDIO card):

¢ Use IEEE 802.1x network access
controls: Lets you set these
parameters if required by the network.

Genaral | Metwork Key | 802, 1x |

e EAP type: Specifies the extensible =

authentication protocol type.
Press OK (@],

Selecting a Wi-Fi network

After you set up a Wi-Fi connection, it's easy to connect to that network.
If you have access to multiple Wi-Fi networks, you can select which
network you want to connect to.

1.

AN

Wake up your smartphone’s screen (see “Waking up the screen
and turning it off” on page 11), and then insert the Wi-Fi card into
the expansion slot (“Removing and inserting expansion cards” on
page 167).

Tap Wi-Fi ¥ in the title bar.

Select the Settings link.

Select Network Cards @;f

Highlight the network you want to connect to.

Press and hold Center
select Connect.

to open the shortcut menu, and then

Insert the Wi-Fi card
into your smartphone
to automatically
connect to the Wi-Fi
network you
connected to

most recently if it is
available.

When you are
browsing the Internet
or performing
another Wi-Fi activity,
you can answer a call
without interrupting
that activity.
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Managing ISP settings

Your smartphone is already set up to connect to the Internet using

a high-speed data connection on the Verizon Wireless network. To
connect to the Internet, simply start Internet Explorer Mobile.

For special situations, such as connecting to your ISP (Internet service
provider) or a remote access server (RAS), you can set up another
connection. Before you begin, obtain the following information from
your ISP or system administrator:

e |SP server phone number or access point

e Username

Password

Press Start () and select Settings.

Select the Connections tab, and then select Connections qu.
On the Tasks tab, select Manage existing connections.

Select the Modem tab.

Highlight the connection you want to view or change, and then
select Edit, or to create a new connection, select New.

6. Follow the onscreen instructions to edit or create the connection.

o wbd =
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Connecting to a VPN

If you want to use your smartphone to access your corporate email
account or other files on your corporate server, you may need to set
up a VPN (virtual private network). A VPN enables you to log in to your
corporate server through the company’s firewall (security layer).

You need to set up a VPN to access a corporate server in either of
the following two situations:

e Your company'’s wireless local area network (LAN) is outside
the firewall.

*  Your company’s wireless LAN is inside the firewall, but you are
accessing the network from outside the firewall (for example, from
a public location or at home).

Check with your company’s system administrator to see if a VPN is
required to access the corporate network. If you need a VPN, you
must purchase and install a third-party VPN client to use this feature.

To manually start a
data connection on
the Verizon Wireless
network or another
network, go to
Connections
Settings, on the Tasks
tab, select Manage
existing connections.
Tap and hold the
connection you want
to start, and then
select Connect from
the shortcut menu.

Some VPN servers
require that you
install specific VPN
software (sold
separately) on your
smartphone. Go to
www.palm.com/

mytreo700w\Verizon
for more information.
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Before you begin setting up a VPN, ask your system administrator
To change settings for the following information:
such as the port
number, proxy server

type, or credentials, e Your server's domain name
select Advanced.

*  Your username and password

e  Your server's TCP/IP settings

*  Your server's host name or IP address

1. Install your third-party VPN client (see “Installing applications” on
page 157).

Press Start [#) and select Settings.

Select the Connections tab, and then select Connections an.

On the Tasks tab, select Add a new VPN server connection.

Follow the onscreen instructions to enter the settings provided by
your corporate system administrator.

ok wn

Setting up a proxy server

Press Start [#) and select Settings.

Select the Connections tab, and then select Connections 8%
On the Tasks tab, select Set up my proxy server.

Check both the boxes near the top of the screen.

Select Proxy server and enter the proxy server name.

Press OK [@].

o oA N =
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Connection settings CHAPTER 9

Ending a data connection

If your service plan includes minutes-of-use fees for data connections,
you can reduce costs by ending the data connection when you're done
browsing the web.

1. Use the stylus to tap the data arrows €* or ¢

2. Select Disconnect from the shortcut menu.

on the title bar.
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CHAPTER 9 Customizing Your Smartphone
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CHAPTER 10

Troubleshooting

Transferring info from another device + Did You Know?
. . . . . . You can purchase
For information on transferring your info from a previous Windows a third-party
Mobile device or from a Palm OS® device to your new Palm® Treo™ application that lets
700w smartphone, visit www.palm.com/us/support/Treo700w\Verizon you run Palm 0s®
for instructions. applications on
your Treo 700w
artph .
[ TTIMPORTANT Do not use a backup utility to transfer your info from smarpnene
another device to your new smartphone. This can cause your <4 Did You Know?
smartphone to malfunction. Ifyou have questions

about Windows
Mobile, you can go
to the Microsoft
Windows Mobile
website. Search for
Palm devices or
Pocket PCs for
information.
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Trouble installing the desktop software?

The Getting Started CD installs the software and drivers that let you
synchronize with Microsoft® Office Outlook® for Windows. If you want
to synchronize with a different personal information manager (PIM),
you must install a third-party solution. Contact the PIM'’s author or
vendor to learn if software is available for your Treo 700w smartphone.

1.
2.

Shut down your computer, and then turn it on again.

On your computer, click Start > Control Panel > Add or Remove
Programs.

Remove Microsoft ActiveSync if it is on your computer.

Quit any active applications, including virus scanners and Internet
security applications.

Make sure you're installing the version of the software that came
with your smartphone on the Getting Started CD. Other versions
may not work with this smartphone.

Make sure your computer profile includes administrator rights to
install software. In large organizations, these are usually granted
by the system administrator.
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Resetting your smartphone

Performing a soft reset

A soft reset is similar to restarting a computer. If your smartphone is
not responding or you have trouble synchronizing with your computer,
a soft reset may help.

1. Use one hand to press the battery door release and use the other
hand to slide the battery door downward to remove it from your
smartphone.

2. Use the stylus tip to gently press the reset button on the back of
your smartphone.

3. Wait for the progress bar on the Treo logo screen to fill before
continuing to use your smartphone.

You can also do a soft
reset by unplugging
yoursmartphone from
a power source (if
connected) and then
removing the battery
and reinserting it.

If the phone or
Bluetooth signals
were on before a
reset, these signals
automatically turn on
after the reset.
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Some third-party
applications do not
create a backup on
your computer when
you synchronize. If
you do a hard reset,
you may lose info in
these applications
and you need to
reinstall the
application on your
smartphone after the
hard reset. Please
contactthe developer
to find out if yourinfo
is backed up during
synchronization.

When you
synchronize after a
hard reset, the source
folder in My
Documents changes
from Treo My
Documents to
WM_your name.

Performing a hard reset

A hard reset erases all personal information, such as appointments,
contacts, and tasks, as well as programs you have added, such as third-
party software on your smartphone. Never do a hard reset without first
trying a soft reset. You can restore previously synchronized information
the next time you sync.

[ ' TIMPORTANT Synchronize to restore your Outlook data, such as
Outlook email, Calendar, Contacts, Notes, and Tasks. You can use a
backup and restore solution (make sure it's an application that’s
approved by Palm) to restore configurations and preferences such as
speed-dials, SMS entries, call log information, and personal settings.

A hard reset can tell you whether a problem stems from your
smartphone or from an application installed on it. If you do not
experience the problem after you perform a hard reset, the problem
may be related to software you installed. See “Third-party applications”
on page 236 for suggestions on diagnosing third-party software issues.

1. Use one hand to press the battery door release and use the other
hand to slide the battery door downward to remove it from your
smartphone.

2. If the screen if off, press Power/End (¥) to wake up the screen.

3. While pressing and holding Power/End [¥J, use the tip of the stylus
to gently press and hold the reset button on the back of your
smartphone.

4. Continue pressing and holding both buttons until the “Erase all
data?” prompt appears.

5. Press Up a to confirm the hard reset.
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6. Wait for the progress bar on the Treo logo screen to fill before
continuing to use your smartphone.

7. (Optional) Sync your smartphone with your computer to restore
your previously synchronized info. Connect your smartphone to
your computer, press Menu —— (right action key), and then select
Programs > ActiveSync > Sync. If you use a backup utility, you may
also need to restore a backup to recover additional info and
settings.
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Be sure to dispose of
your old battery in an
evironmentally
responsible and legal
way. In some areas,
disposal in household
or business trash is
prohibited.

Your smartphone
stores all your info
even when you
remove the battery.

Replacing the battery

Your smartphone comes with a replaceable battery. Be sure to use a
replacement battery from Palm that is compatible with Palm Treo 700w
smartphones.

1. Press Power/End (¥ to turn off the screen.

2. Use one hand to press the battery door release and use the other
hand to slide the battery door downward to remove it from your
smartphone.

3. Place a finger in the notch between the stylus and the battery and
lift the battery up at a 45 degree angle.

4. Align the battery contacts with the phone contacts inside the battery
compartment.

5. Insert the battery into the compartment at a 45 degree angle,
pressing it into place. Slide the battery door onto the back of the
smartphone until it clicks into place.

6. Wait for the screen to turn on, and then enable the network time or
set the date and time when prompted.

Battery door Battery

release
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Performance

The applications are running slower than usual

1. Press Start and select Settings.

2. Select System, and then select Memory E%

3. Select Running Programs.

4. Select Stop All to close all of your open applications.

5. Press OK (@].

If the previous steps don’t fix the problem, try doing a soft reset (see
“Performing a soft reset” on page 213). If the problem persists, follow
these steps to turn off the Voice Command setting, if it is enabled:

1. Press Start (&) and select Settings.

2. Select Personal, and then select Voice Command a’.

3. Uncheck the Enabled box.

4. Press OK [(@].

Be sure that third-
party applications are
compatible with
Windows Mobile
version 5 or later.
Applications written
for earlier versions
can have
performance
problems. If you can
try a free version of
the software before
purchasing it, you
can test it first to
make sure it works
properly.

Using Your Treo 700w Smartphone

217



To find carrying cases
that protect the screen
and other useful
accessories, visit
www.palm.com/

mytreo700w\Verizon

Make sure that the
third-party application
supports 240x240
screen resolution.
Some older
applications have
screen-size limits.

Screen

The screen appears blank

1.

When the time period specified in Backlight Settings expires, the
screen dims; one minute later, the screen automatically turns off.
Press any key except Power/End to wake up the screen. Pressing
Power/End hangs up the call.

Look closely at the screen. If you can see a dim image, try adjusting
the screen brightness (see “Adjusting the brightness” on page 183).
If that doesn’t work, perform a soft reset (see “Performing a soft
reset” on page 213).

If that doesn’t work, connect your smartphone to the AC charger
(see “Charging the battery” on page 9) and perform a soft

reset again.

If that doesn’t work, perform a hard reset (see “Performing a hard
reset” on page 214).

The screen doesn’t respond accurately to
taps or activates wrong features

o oA wN =

Make sure there is no debris trapped under the edges of the screen.
Start [#) and select Settings.

Select the System tab, and then select Screen E\

On the General tab, select Align Screen.

Follow the onscreen instructions to align the screen.

Press OK (@],
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Network connection

Signal strength is weak

1.
2.
3.
4

5.

If you're standing, move about 10 feet in any direction.

If you're in a building, move near a window. Open any metal blinds.

If you're in a building, move outdoors or to a more open area.
If you're outdoors, move away from large buildings, trees, or

electrical wires.

If you're in a vehicle, move your smartphone so that it's level

with a window.

My smartphone won’t connect to the mobile network

1.
2.

3.

Try the suggestions above for weak signals.

Turn off your smartphone and turn it on again (see “Turning your
phone on and off” on page 11).

Perform a soft reset (see “Performing a soft reset” on page 213).

Depending on where you are on a network and certain coverage
conditions, you might experience interruptions with your phone
operation while using a Wi-Fi card. Palm recommends that you turn
off the phone radio when using any Wi-Fi card or remove the Wi-Fi
card when not in use to ensure that you can always make and
receive phone calls. For EMERGENCY calls, always remove the card
from your smartphone to ensure optimal connectivity.

My smartphone seems to turn off by itself

If a system error and reset occur, the phone automatically turns on if it
was on before the reset. However, if your smartphone can’t determine if

Become familiar with
low coverage areas

where you live,

commute, work, and
play, so you know
when to expect signal

strength issues.
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1xRTT (Single carrier
[1x] radio
transmission
technology): A
wireless technology
that can provide fast
data transfer and
Internet access with
average speeds of 60-
80Kbps and bursts up
to 144Kbps.

EVDO (Evolution Data
Optimized): A wireless
broadband technology
that is designed for
very high-speed data
transfer with average
download speeds of
400-600Kbps, capable
of reaching speeds up
to1.8Mbps, and
upload speeds up to
156Kbps.

your phone was on before the reset, it does not automatically turn on
the phone (see “Turning your phone on and off” on page 11).

| can't tell if data services are available

The following icons appear in the title bar to indicate whether data
services are available:

=, [E
E¥ 1=
o
EY 1=
o e
s

A

o’

e

Your phone is on and a BroadbandAccess (EVDO) or
NationalAccess (1xRTT) network is within range. You can
make or receive calls or open a data connection.

Your phone is connected to a BroadbandAccess or
NationalAccess network, but you are not actively
transmitting data. You can still make or receive calls.

Your phone is on and a BroadbandAccess or
NationalAccess data connection is active. If an
BroadbandAccess data connection is active, you can still
make or receive calls. When you make or receive a call,
the data transmission is automatically interrupted. If a
NationalAccess data connection is active, you can still
make calls, but you cannot receive calls (incoming calls go
to voicemail). When you make a call the data transmission
is automatically interrupted.

Your smartphone is connected to a computer or network
which providing a data connection.

A data connection is not available or phone is turned off
(the wireless connection is off).
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My smartphone won’t connect to the Internet

Your smartphone supports NationalAccess (1xRTT) or
BroadbandAccess (EVDO) wireless data networks. To connect to the
Internet, you must subscribe to data services with Verizon Wireless.

e Contact Verizon Wireless to verify that your subscription plan
includes data services and that these services have been correctly
activated. Verizon Wireless should also be able to tell you if there
are any outages in your location.

e Press and hold Power/End @ to turn off your smartphone. Then
press and hold the same button to turn it back on again.

e Perform a soft reset (see “Performing a soft reset” on page 213).

e Confirm that data services are correctly configured on your
smartphone:

Start (&) and select Settings.

Select the Connections tab, and then select Connections qu.
On the Tasks tab, select Manage existing connections.

If Broadband Access appears in the list, press OK [@]. If not, contact
Verizon Wireless for assistance.

pPWbd-=

| can’t send or receive text or multimedia messages

e Make sure your phone is on (see “Turning your phone on and off”
on page 11).

e Contact Verizon Wireless to verify that your plan includes
messaging services, that these services have been correctly
activated, and that they are available at your location (Verizon
Wireless should be able to tell you if messaging services have been
experiencing transmission delays).
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If possible, contact the recipient or sender of the message, and
make sure the receiving device can handle the type of message
you're sending.

If a text message arrives but does not display a notification, perform
a soft reset (see “Performing a soft reset” on page 213).

| can’t make or receive calls using a hands-free device
with Bluetooth® wireless technology
Verify all of the following:

The Turn on Bluetooth box is checked in Bluetooth Settings.
Your Bluetooth device is charged and turned on.

Your smartphone is within range of the hands-free device.
Bluetooth range is up to 30 feet in optimum environmental
conditions, which include the absence of the following: obstacles,
radio interference from nearby electronic equipment, and other
factors.

The Bluetooth Settings screen is closed.

You are away from other devices using the 2.4 GHz radio frequency,
such as cordless phones, microwaves, and Wi-Fi® equipment. If this
impossible, move the phone closer to the hands-free device.

The device specifications are compatible with your smartphone.
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| lost the connection between my smartphone and my
Bluetooth headset

1. Press Start [#), and then select Settings.

Select the Connections tab, and then select Bluetooth.

Select Devices tab.

Select your headset name from the list.

In Partnership Settings, make sure the Hands Free option box is
checked.

Select Save.
Highlight the headset name.

8. Press and hold Center to open the shortcut menu, and then
select Set as Hands-Free.

9. Test your headset by making or receiving a call.

aprwN

N o

If the headset still doesn’t work, delete the existing partnership and
create a new one. To delete the partnership:

1. Press Start [#), and then select Settings.

2. Select the Connections tab, and then select Bluetooth.

3. Highlight the headset device name.
4

Press and hold Center to open the shortcut menu, and then
select Delete.

5. Create a new partnership (see “Setting up a Bluetooth connection”
on page 110.)
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You can go to the
Windows website for
more information at
www.windowsmobile
.com.

A common cause of
sync problems is the
presence of protective
software, such as
VPNs or firewalls, on
your computer or
network.

If you are syncing to
an Exchange Server
and you're unable to
change your lock
settings, check with
your system
administrator to find
out if a system-wide
locking policy is in
place.

Synchronization (ActiveSync® software)

Synchronization lets you back up the information on your smartphone
onto your computer. If you ever need to perform a hard reset or
otherwise erase all your information on your smartphone, you can
synchronize your smartphone with your computer to restore the info.
To make sure you always have an up-to-date backup of your info,
synchronize frequently.

Before you attempt to synchronize, make sure you've installed the
desktop synchronization software from the Getting Started CD.

ActiveSync Desktop does not respond to sync attempt

As you complete the following steps, synchronize after each step. If the

synchronization is successful, you do not need to complete the

remaining steps.

1. Verify that the USB sync cable is securely connected at all points
(see “Synchronizing contacts and other info” on page 32).

2. Look for the ActiveSync icon % at the top of your smartphone’s

screen and the ActiveSync icon @ in the taskbar on your computer
to make sure the ActiveSync software is running on your computer.

3. Double-click the ActiveSync icon @ in your taskbar. From the File
menu, select Connection Settings. Make sure the Allow USB
connections box is checked, and then click Connect.

4. Perform a soft reset (see “Performing a soft reset” on page 213).

Restart your computer and make sure ActiveSync is running.

6. If problems persist and you're synchronizing through a USB hub,
try connecting the sync cable to a different USB port or directly to
your computer’s built-in USB port.

o

224

Using Your Treo 700w Smartphone


http://www.windowsmobile.com
http://www.windowsmobile.com

If you're already synchronizing through a built-in USB port on the
front of your computer, move the sync cable to a USB on the back of
your computer (if your computer has USB ports in both places).
Uninstall the desktop software that came with your smartphone,
and then insert the Getting Started CD that came with your
smartphone and repeat the installation process.

Verify with your computer hardware vendor that your operating
system supports your internal USB controller.

Synchronization finishes but info doesn’t
appear where it should

With the included software, your smartphone can synchronize with
the root folders of Contacts, Calendar, Tasks, and Notes. If you want
to synchronize with a global Exchange Address Book, you must
copy the addresses to your local Contacts list in Microsoft Office
Outlook (right-click the addresses and select Add to Personal
Address Book).

Microsoft Office Outlook subfolders and public folders are not
accessible with the included software. You may wish to use a third-
party solution instead.

If you're trying to sync offline, be sure to set your Microsoft Office
Outlook Calendar, Contacts, Notes, and Tasks to be available offline.

If you're still having problems, try the following:

Make sure you’re synchronizing with the intended desktop personal
information manager (PIM). The Getting Started CD lets you
synchronize with Microsoft Office Outlook for Windows. If you use a
different PIM, you need to install third-party software to
synchronize. Consult the company that makes the PIM for more
information.
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2. Open ActiveSync on your computer, and make sure the necessary
synchronization settings are set to synchronize the files.

3. Uninstall the ActiveSync software,

reboot your computer, and then insert

the Getting Started CD that came with "’ Documents ~ Name -
Business
your smartphone and repeat the = My Music
installation process. My Pictures
| Personal
(=) Templates

Synchronization starts but doesn’t |Bamen 11/22/05 1508

L. [_|Estend Your H.. 11/22/05 2.81K
f| n |Sh Power Tips 11/22/05 2.15K
Make sure that you installed the desktop
software that came with your smartphone. If
you're not sure whether this software is
installed, reinstall it.

Up B Menu

My media files won’t sync

1. Make sure you have Windows Media Player 10 installed on your
computer.

2. Reinstall your synchronization software from the Getting Started CD
that came with your smartphone. Media file synchronization fails if
you installed the synchronization software before you installed
Windows Media Player 10.
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My appointments show up in the wrong
time slot after | sync

1.

4.

Make sure that you installed the desktop software that came with
your smartphone. If you're not sure whether this software is
installed, reinstall it.

Open Microsoft Office Outlook and correct the wrong entries.

Manually enter any information you've added to your smartphone
since the last time you synchronized.

Synchronize your phone and your computer.

You should now be able to assign time zones to your events without
encountering this problem.

My scheduled sync doesn’t work

By default, a scheduled sync does not work while you are roaming.
This is to prevent roaming charges on your account. If roaming charges
are not a concern, follow these steps to continue your sync schedule
while roaming:

1.

a ks owd

Press Start (&) and select Programs.

Select ActiveSync @.

Press Menu —— (right action key) and select Schedule.
Check the Use above setting when roaming box.

Press OK (@].
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An alert tells me that ActiveSync encountered
a problem on the server
There is a temporary problem with the server or the server may be

temporarily overloaded. Try again later, and if the problem persists,
contact your system administrator.

An alert tells me that there is not enough
free memory to sync my info
ActiveSync ran out of storage space. Try the following:

1. Go to Memory Settings and close all running programs. See
“Closing applications” on page 30 for details.

2. If the problem persists, see “Making room on your smartphone”
on page 238 for suggestions on other ways to free up space on
your smartphone.

An alert tells me that the server could not be reached

Your smartphone had to wait too long to connect to Exchange Server.
The connection may have been lost, the server may be temporarily
overloaded, or the server may have encountered an internal error.
Check your Exchange Server name and proxy server settings (see
“Synchronizing with Exchange Server” on page 161), and try

again later.

An alert tells me that ActiveSync encountered

a problem with [item type] [item name]

There is an error synchronizing a single item. This error can usually be
corrected only by removing the item that caused the error. If you sync
again to see if the error persists, be aware that items causing this type
of error are skipped and do not show up again.
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An alert tells me that my account information

could not be detected.

When you set up the Exchange Server sync options, the credentials
page was left blank. Correct the credentials (see “Synchronizing with

Exchange Server” on page 161), or set up your smartphone to sync only
with a computer, and try to sync again.

An alert tells me the device timed out
while waiting for credentials.

The Exchange Server credentials screen was left open too long.
Re-enter the Exchange Server credentials, and try to sync again.

My Today screen settings are not restored

after a hard reset

Settings such as the background image and plug-in choices are not
backed up during synchronization, so they can’t be restored after a hard
reset. If you use a backup utility, you may be able to restore a backup to
recover your Today screen setting and other additional info.
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Email

| have problems using my account

Occasionally you may experience problems using an email account
after you set it up. If you followed the account setup procedure and
are experiencing problems using the account, verify that the account
complies with your email provider’s requirements by following
these steps:

Verify both your password and your username for your email
account.

Some wireless service providers require you to be on their network
to use your email account. If this is the case, be sure to use your
provider's network as the connection type for the account.

Some wireless service providers have other requirements specific
to their service. For example, Yahoo! requires you to set up POP
mail forwarding for your Yahoo! account to download email
messages to your smartphone. Check with your service provider
to see if any provider-specific requirements exist.

Service provider settings frequently change. If your email account
was working but you are currently experiencing problems, check
with your service provider to see if any of the account settings
have changed.
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| have problems sending and receiving email

Short periods of time when email is unavailable are common due to
server problems or poor wireless coverage. If you have problems
sending or receiving mail for an extended period of time, check with
your ISP or email service provider to verify that the service is working
properly.

Auto Sync is not working

If Auto Sync is occurring and you turn your smartphone off or the
connection to your email service provider is disconnected, the Auto
Sync fails.

e Check the synchronization schedule to make sure that Auto Sync is
set to occur at the expected day and time. See “Setting the
synchronization schedule” on page 164 for details.

e Press Start (&), select Programs, and then select ActiveSync @.
Press Menu —— (right action key) and select Configure Server.
Make sure the verify password setting is on. This is required for
over-the-air synchronization.

| have problems sending email

If you are able to receive email messages but cannot send them, try
these steps, in turn:

e Make sure your ISP or email provider allows you to access email on
a smartphone. Some providers do not offer this option at all; other
providers require an upgrade to access email on a smartphone.

e Turn on ESMTP. Many services require authenticated access, or
ESMTP, to use their SMTP servers.
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e Press Start &), select Programs, and then select ActiveSync @.

Press Menu 2 (right action key) and select Configure Server.
Make sure the SSL box is checked.

e Enter the name of a different outgoing mail server for sending mail.

Many ISPs, such as cable companies, require that you have an
Internet connection to their network to send email through their
servers. In this case, you can almost always receive email from
these accounts, but if you want to send email, you must send it
through another server.

| have problems synchronizing messages on my
smartphone with messages on my computer

Make sure you have chosen the same settings for the account on both
your smartphone and your computer. For example, if the account is set
up on your smartphone to use the POP protocol, check the ActiveSync
settings on your computer to make sure that POP is selected as the
protocol for that account.

My vCard or vCal email attachment isn’t

forwarding correctly

Microsoft Office Outlook provides several features that work with email
client software on a Windows computer. For these features to work
correctly, the email client software must be properly set up. Follow
these steps to check the settings:

1. Click Start on your computer, and then select Settings.

2. Select Control Panel.

3. Select Internet Options, and then click the Programs tab.
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Make sure that the email field is set to the correct email client
software.

Click OK.

Start the email client software and make sure it is configured as the

default MAPI client. Consult the documentation for your desktop
email application for more information.

When | sync with my Exchange Server my
info is not downloading to my smartphone

Check with your system administrator to obtain the name of the mail
server that offers you wireless access to the corporate mail system.
If you cannot obtain the name of this server (some companies do not

give it out, because they do not want wireless access to their servers),

you cannot use ActiveSync to synchronize with the Exchange Server.
You can also check the following setting:

1.

2.
3.
4

Press Start (&) and select Programs.

Select ActiveSync @.

Press Menu —— (right action key) and select Configure Server.
Make sure the SSL box is checked.
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Your smartphone can
open your email
application when you
select an email
address on a web
page. If nothing
happens when you
select the link, try
setting up your email
application first.

Web

| can’t access a page

First, make sure you have Internet access: Open Internet Explorer
Mobile and try to view a web page you've loaded before. To ensure that
you're viewing the page directly from the Internet, press Menu ——
(right action key) and select Refresh. After confirming your Internet
connection, try to view the page in question again. If it comes up blank,
press Menu 2 (right action key) and select Refresh.

If you're still having trouble, the page may contain elements that are
not supported by Internet Explorer Mobile, such as Flash, Shockwave,
VBScript, WML script, and other plug-ins.

Some websites use a redirector to their true home page (for example,
if you enter the address http://www.palm.com/support it may resolve
to http://www.palm.com/us/support). If Internet Explorer Mobile can’t
follow the redirect, try using a desktop browser to see the landing page
of the redirector, and enter that address in Internet Explorer Mobile.

An image or map is too small on my
smartphone screen

Internet Explorer Mobile has several viewing modes: One Column,
Default, Desktop, and Full Screen. Switch to Desktop to see the full-size
image (see “Viewing a web page” on page 104).

A secure site refuses to permit a transaction

Some websites don't support certain browsers for transactions. Please
contact the site’s webmaster to make sure the site allows transactions
using Internet Explorer Mobile.
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Camera

If your smartphone does not have a built-in camera, then the

information in this section about taking pictures does not apply to you.

Here are some tips for taking good pictures with the built-in camera:

e (Clean the camera’s lens with a soft, lint-free cloth.

e Take pictures in bright lighting conditions. Low-light images may be

grainy, due to the sensitivity of the camera.
e Hold the camera as still as possible. Try supporting your picture-

taking arm against your body or a stationary object (such as a wall).
e Keep the subject of the pictures still. Exposure time is longer with

lower light levels, so you may see a blur.

* For best results, verify that you have the brightest light source

coming from behind you, lighting the subject’s face. Avoid taking

indoor pictures with the subject in front of a window or light.

e Make sure the subject is at least 18 inches away from the camera to

ensure good focus.

Remember that when you synchronize, your Camera images are stored
in the C:\Documents and Settings\<Username>\My Documents\Treo My
Documents folder on your hard drive (see “Viewing pictures and videos

on your computer” on page 126).

Pictures are 16-bit
color. Resolution
settings range from
1280 x1024 to 160 x
120 pixels (1.3
megapixels to VGA).
Video resolution
settings range from
352 x 28810 176 x 144
pixels. You can
changethe resolution
setting by pressing
Menu (right action
key) and selecting
Resolution (still
images) or Quality
(video).
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Remember that not
all third-party
applications were
written with the Treo
700w smartphone
keyboard and 5-way
navigator in mind.
You may encounter
strange behavior or
errors in these
applicationsifyouuse
the keyboard and
5-way navigator.

The Camera preview image looks strange

Some third-party applications overwrite your smartphone’s color
settings with their own 8-bit color settings. This can affect the Camera
Preview Mode. Delete third-party applications one by one until the
preview image improves.

Third-party applications

Sometimes, third-party applications can cause conflicts on your
smartphone. Third-party applications that modify wireless features may
affect your smartphone’s performance and may require extra
troubleshooting. Use caution when installing the following types of
applications:

e Ringtone managers

e Caller ID applications

* Instant messaging

e Applications that modify when your phone or data connections turn
on or off and how your phone behaves

If you recently installed an application and your smartphone seems to

be stuck, try the following:

1. Perform a soft reset (see “Performing a soft reset” on page 213).

2. Make sure the third-party application is compatible with the
Windows Mobile version 5.0.2. operating system on your
smartphone.

3. Delete the most recently installed application from your
smartphone (see “Removing applications” on page 160).

236

Using Your Treo 700w Smartphone



4. If the problem persists, perform another soft reset.

5. If possible, synchronize or use a backup utility to back up your most
recent info.

6. Perform a hard reset (see “Performing a hard reset” on page 214).

7. Synchronize or restore your backup to restore the info in your built-
in applications.

8. If the problem is resolved, begin reinstalling your third-party
applications one at a time.

9. |If the problem recurs, delete the last application you installed and
report the problem to its developer.

Getting more help

Contact the author or vendor of any third-party software if you require
further assistance.
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Making room on your smartphone

If you store a large number of records, or install many third-party
applications, the internal memory on your smartphone may fill up.
Here are some common ways to clear space on your smartphone:

Camera: Large size images take up a lot of memory. Move images
to an expansion card or delete images from your smartphone (see
“Viewing pictures and videos on your computer” on page 126).

Messaging: Multimedia content and email attachments can
consume excessive memory. Move multimedia content and
attachments to an expansion card, or delete large files from your
smartphone (see “Managing your messages” on page 99). You may
also want to empty the deleted items folder.

Internet: If you save links to pages you've visited in Internet
Explorer Mobile, you may want to clear all recent pages

(see “Customizing your Internet Explorer Mobile settings” on
page 108).

Third-party applications: You can delete infrequently used
applications or move them to an expansion card (see “Copying or
moving applications and files between your smartphone and an
expansion card” on page 170).

Also, remember that your smartphone includes an expansion card slot,
and that you can store applications and information on expansion
cards. However, you still need free memory on the smartphone itself
to run applications from an expansion card.
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Voice quality

Is the other person hearing an echo?

e Try decreasing the volume on your smartphone to avoid coupling
or feedback on the other person’s end. This applies to both the
speakerphone and to the handset ear piece.

* Position the smartphone closer to your ear to prevent sound leaking
back to the microphone. Keep your hand away from the
microphone hole, which is on the lower-right side of your
smartphone.

e If you're using Speakerphone mode with your smartphone lying
on a flat surface, try turning the smartphone “face down” (screen
facing the surface).

Are you hearing your own voice echo?

Ask the other person to turn down their volume or to hold the
smartphone closer to their ear.

Is your voice too quiet on the other end?

Be sure to hold the bottom of the smartphone, or the hands-free
microphone, close to your mouth.

Check the signal strength indicator. If the signal is weak, try to find
an area with better coverage.
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Glossary

1xRTT (Single carrier [1x] radio transmission technology): A wireless
technology that can provide fast data transfer and Internet access with average
speeds of 60-80Kbps and bursts up to 144Kbps. Also called NationalAccess.

ActiveSync®: The technology that exchanges and updates the information
on your smartphone with the information on your computer.

Alt (alternative) : A keyboard key. Enter a letter on the keyboard, and then

press Alt to access variations such as international characters and symbols.

Auto-off interval: The time of inactivity that passes before the screen on your
smartphone turns off. The wireless features on your smartphone are unaffected by
this setting.

Beam: The process of sending or receiving an entry or application using the infrared
port on your smartphone.

BroadbandAccess: A wireless broadband technology that is designed for very
high-speed data transfer with average download speeds of 400-600Kbps, capable of

reaching speeds up to1.8Mbps, and upload speeds up to 156Kbps. Also called EVDO.

Desktop software: A PIM application for computers, such as Microsoft Outlook,
that helps you manage your personal information and keep your personal information
synchronized with your smartphone.
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EVDO (Evolution Data Optimized): A wireless broadbandlike technology that is
designed for very high-speed data transfer with average download speeds of 400 to
600 Kbps.Verizon Wireless refers to this service as BroadbandAccess. Also called
BroadbandAccess.

Infrared (IR): A way of transmitting information using light waves. The IR port on
your smartphone lets you transfer information between other IR devices within a
short radius.

Lithium lon (Li-lon): The rechargeable battery technology used in Treo 700w
smartphones.

MMS (Multimedia Messaging System): An enhanced messaging system that
enables you to send pictures, animations, and ringtones almost instantly.

My Mobile Devices: The component on your Windows computer that enables
you to install applications and other information on your smartphone.

NationalAccess: A wireless technology that can provide fast data transfer and
Internet access with average speeds of 60-80Kbps and bursts up to 144Kbps.
Also called TxRTT

Option @:The keyboard button that lets you access the alternative feature that
appears above the letter on each key.

Phone Off: \When your Phone is off, your smartphone is not connected to any mobile
network. You can still use the organizer and other features.

Phone/Send @: The button on your smartphone that provides quick access to your
Today screen.
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PIM (personal information manager): A genre of software that includes
applications such as Microsoft Outlook, Palm® Desktop software, Lotus Notes, and
ACT!. PIMs generally store contacts, schedules, tasks, and memos.

SMS (Short Messaging Service): The service that exchanges short text messages
almost instantly between mobile devices. These messages can usually include up to
160 characters. Treo 700w smartphones can send and receive text messages while
you are on a voice call.

SSID: The name that identifies a Wi-Fi network. If a network does not broadcast its
SSID, you must get the SSID from the system administrator in order to connect to
the network.

Start @: The menu on your smartphone from which you can open all applications.

Username: The name associated with your smartphone that distinguishes it from
other Windows Mobile devices. When you first synchronize your smartphone, you are
asked to give it a username.

Wi-Fi access point: A network device with an antenna that provides wireless
connections to a larger network. Also called a hotspot

Windows Mobile: The operating system of your Treo 700w smartphone.

Using Your Treo 700w Smartphone
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Regulatory Information

FCC Statement This equipment has been tested and found

to comply with the limits for a Class B computer peripheral,

pursuant to part 15 of the FCC Rules. These limits are designed to

provide reasonable protection against harmful interference in a

residential installation. This equipment generates, uses and can

radiate radio frequency energy and, if not installed and used in

accordance with the instructions, may cause harmful interference

to radio communications. However, there is no guarantee that

interference will not occur in a particular installation. If this

equipment does cause harmful interference to radio or television

reception, which can be determined by turning the equipment off

and on, the user is encouraged to try to correct the interference

by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different
from that to which the receiver is connected.

* Consult the dealer or an experienced radio/TV technician

for help.

This device complies with part 15 of the FCC Rules.
Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this device
must accept any interference received, including interference
that may cause undesired operation.

RF Safety Exposure To Radio Frequency Energy (SAR) Radio
transmitting devices radiate Radio Frequency (RF) energy during
its operation. RF energy can be absorbed into the human body
and potentially can cause adverse health effects if excessive
levels are absorbed. The unit of measurement for human
exposure to RF energy is “Specific Absorption Rate” (SAR).

The Federal Communications Commission (FCC), Industrie
Canada (IC), and other agencies around the world have
established limits that incorporate a substantial safety margin
designed to assure the safety of all persons using this
equipment.

In order to certify this unit for sale in the US, Canada and
Europe this unit has been tested for RF exposure compliance
at a qualified test laboratory and found to comply with the
regulations regarding exposure to RF Energy.

SAR was measured with the unit transmitting at its maximum
certified RF power. Often, however, during normal operation the
unit will transmit much less than maximum power. Transmit
power is controlled automatically and, in general is reduced
as you get closer to a cellular base station. This reduction in
transmit power will result in a lower RF energy exposure and
resulting SAR value.

FCC RF Safety Statement In order to comply with FCC RF

exposure safety guidelines, users MUST use one of the following

types of bodyworn accessories.

1. A Palm® brand body-worn accessory that has been tested for
SAR compliance and is intended for use with this product.

2. An accessory that contains NO metal (snaps, clips, etc) and
provides AT LEAST 1.5 cm of separation between the users
body and the unit.

Do NOT use the device in a manner such that it is in direct
contact with the body (i.e. on the lap or in a breast pocket).
Such use will likely exceed FCC RF safety exposure limits.

See www.fee.gov/oet/rfsafety/ for more information on RF

exposure safety.

The Palm® Treo™ 700w smartphone may be used with a
Wi-Fi® SDIO card; however, the user must ensure that the SDIO
Wi-Fi card has been approved by the FCC for use with the Treo
700w smartphone. For a list of SDIO Wi-Fi cards approved by the
FCC for use with the Treo 700w smartphone, please go to
www.palm.com/us/: /Treo7 Verizon.

If using a SDIO Wi-Fi card not approved for use with the Treo
700w smartphone by the FCC, the user must turn off the phone
(CDMA radio) on the Treo 700w smartphone.
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Use of an SDIO wireless transmitter that is not approved in
conjunction with the phone (CDMA radio) is not authorized by
the FCC and may exceed FCC RF exposure guidelines.

Responsible party
(North America)
Palm, Inc.

950 W. Maude Ave.
Sunnyvale, CA 94085
USA
www.palm.com

(Europe)

Bornibus Francois

Buckhurst Court

London Road

Wokingham, Berkshire RG40 1PA,
UK

Antenna Care/Unauthorized Modifications Use only the
supplied integral antenna. Unauthorized antenna modifications
or attachments could damage the unit and may violate FCC
regulations. Any changes or modifications not expressly
approved by the party responsible for compliance could void the
user’s authority to operate the equipment.

Potentially Unsafe Areas Potentially explosive atmospheres:
Turn off your smartphone when you are in any areas with a
potentially explosive atmosphere, such as fueling areas (gas or
petrol stations) or storage facilities for fuel or chemicals.

Declaration of Conformity

Treo 700w Model

Palm declares that the above model of Treo 700w smartphone is
compliant with the regulations below. The declaration applies to
the smartphone and its associated accessories (power supply,
headset, and USB cable) where applicable.

For SAR values when used with a SDIO Wi-Fi card go to:
www.palm.com/us/support/Treo700wVerizon.

FCC OET Bulletin 65 Supplement C
Safety: EN 60950: 2000 (Jan-2000)
Radiated Emissions: EN 55022
FCC ID: O8RJIMI

IC ID: 3905A-JIMI

Palm

Treo 700W

Maximum Scaled SAR Values (W/kg)
Band Cellular PCS
Head SAR (W/Kg) (W/Kg)
(Held to Ear) 1.26 1.26
Body SAR (W/Kg) (W/Kg)
(Worn) 1.01 548
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Using TTY

ATTY (also known as TDD or text telephone) is a
telecommunications device that allows people who are deaf or
hard of hearing, or who have speech or language disabilities, to
communicate by telephone.

Your Palm Treo 700w smartphone is compatible with select
TTY devices. You can connect a TTY/TDD machine to your
smartphone through the headset jack, but you cannot use your
headset jack with a headset or hands-free kit while this mode is
enabled. Please check with the manufacturer of your TTY device
for connectivity information and to ensure that the TTY device
supports digital wireless transmission.

To use TTY, you may need to make additional arrangements
with Verizon Wireless. Please contact Verizon Wireless's
customer service department for more information.

1. Press the Start button and select Settings.

2. Select Personal, and then select Phone.

3. Select Phone.

4. Select the TTY/TDD list, and then select either Default mode,
VCO mode, or HCO mode.

5. Press OK. A keyboard icon appears at the top of your Today
screen whenever TTY is enabled.

To disable TTY, repeat steps 1 and 2.

FCC Hearing Aid Compatibility

Your Treo is compliant with the FCC Hearing Aid Compatibility
(HAC) requirements. For additional HAC information, including
the HAC rating of this product, please refer to www.palm.com/
treoHAC.

Operational Warnings

IMPORTANT INFORMATION ON SAFE AND EFFICIENT
OPERATION. Read this information before using your integrated
multi-service portable radio.

For the safe and efficient operation of your radio, observe
these guidelines:

Potentially Unsafe Areas / Potentially explosive
atmospheres Obey all signs and instructions regarding
turning off your smartphone. In particular, turn off your

smartphone when you are in any areas with a potentially
explosive atmosphere, such as fueling areas (gas or petrol
stations, below deck on boats), storage facilities for fuel or
chemicals, blasting areas and areas near electrical blasting caps,
and areas where there are chemicals or particles (such as metal
powders, grains, and dust) in the air.

Interference to Medical and Personal Electronic
Devices Most but not all electronic equipment is shielded from
RF signals and certain electronic equipment may not be shielded
against the RF signals from your smartphone.

Pacemakers The Health Industry Manufacturers Association
recommends that a minimum separation of six inches (6") be
maintained between a smartphone and a pacemaker to avoid
potential interference with the pacemaker. These
recommendations are consistent with the independent research
by the recommendations of Wireless Technology Research.

Persons with pacemakers should:

* ALWAYS keep the smartphone more than six inches from their
pacemaker when the smartphone is turned ON.

* Not carry the smartphone in a breast pocket.

* Use the ear opposite the pacemaker to minimize the potential
for interference.

® Turn the smartphone OFF immediately if you have any reason
to suspect that interference is taking place.

Audio Safety Some hearing aids may be affected by some
digital smartphones. You may want to consult your doctor in the
event of you experience interference with your hearing aid while
using your smartphone. When using the speakerphone feature,
itis recommended that you place your smartphone at a safe
distance from your ear.

Other Medical Devices If you use any other personal
medical device, consult the manufacturer of your device to
determine if it is adequately shielded from external RF energy.
Your physician may be able to assist you in obtaining this
information.

Turn your smartphone OFF in health care facilities when any
regulations posted in these areas instruct you to do so. Hospitals
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or health care facilities may be using equipment that could be
sensitive to external RF energy.

Interference to Other Electronic Devices RF energy may
affect improperly installed or inadequately shielded electronic
operating and entertainment systems in motor vehicles. Check
with the manufacturer or representative to determine if these
systems are adequately shielded from external RF energy. Also
check with the manufacturer of any equipment that has been
added to the vehicle.

Repetitive Motion Injuries When using the keyboard or
playing games on your smartphone, you may experience
discomfort in your neck, shoulders, hands, arms, of other parts
of the body. To avoid any injury, such as tendonitis, carpal tunnel
syndrome, or other musculoskeletal disorder, make sure to take
necessary breaks from use, take longer rests (such as several
hours) if discomfort or tiring begins, and see a doctor if
discomfort persists.

Blackouts and Seizures Blinking lights, such as those
experienced with television or playing video games, may cause
some people to experience blackout or seizure, even if never
experienced before. In the event a smartphone user should
experience any disorientation, loss of awareness, convulsion, eye
or muscle twitching or other involuntary movements, stop use
immediately and consult a doctor. Individuals with personal or
family history of such events should consult a doctor before
using the device. To limit the possibility of such symptoms,
wherever possible every hour take a minimum of 15 minutes, use
in a well lighted area, view the screen from the farthest distance
and avoid exposure to blinking lights if you are tired.

Aircraft While in aircraft, follow all instructions regarding the

operation of your smartphone. Use of your smartphone while on
board on aircraft must be done in accordance in compliance with
airline instructions and regulations.

Vehicles with Air Bags Your smartphone should not be
placed in a position that would affect the operation of air bag
deployment or in a position that, should the air bag inflate, could
propel the smartphone. Air bags will inflate with great force and
care should be taken to protect within a vehicle that has air bags.

Battery Your smartphone includes an internal lithium ion

battery. Please note that use of certain data applications can

result in heavy battery use and may require frequent battery
charging. Any disposal of the smartphone must comply with
laws and regulations pertaining to lithium ion batteries.

Driving Safety Tips Overview
Always obey all laws and regulations on the use of

smartphones in your driving area.

Safety — Your most important call. The Wireless Industry
reminds you to use your smartphone safely when driving.

. Get to know your smartphone and its features, such as speed

dial and redial.

2. When available, use a hands-free device.

. Position your smartphone within easy reach.

4. Let the person you are speaking to know you are driving; if
necessary, suspend the call in heavy traffic or hazardous
weather conditions.

5. Do not take notes or look up phone numbers while driving.

. Dial sensibly and assess the traffic; if possible, place calls

when you are not moving or before pulling into traffic.

7. Do not engage in stressful or emotional conversations that
may divert your attention from the road.

8. Dial 9-1-1 to report serious emergencies -it's free from your
smartphone!

9. Use your smartphone to help others in emergencies.

10.Call roadside assistance or a special non-emergency wireless
number when necessary.

w

o

Driving Safety Tips Details

1. Get to know your smartphone and its features such as speed
dial and redial. Carefully read your instruction manual and
learn to take advantage of valuable features most
smartphones offer including, automatic redial and memory
dial-most smartphones can store up to 99 numbers in memory
dial. Also, work to memorize the smartphone keypad so you
can use the speed dial function without taking your attention
off the road.

2. When available, use a hands-free device. A number of hands-
free smartphone accessories are readily available today.
Whether you choose an installed mounted device for your
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smartphone or a speaker phone accessory, take advantage of
these devices if available to you.

Position your smartphone within easy reach. Make sure you
place your smartphone within easy reach and where you can
grab it without removing your eyes from the road. If you get
an incoming call at an inconvenient time, let your voice mail
answer it for you.

Suspend conversations during hazardous driving conditions
or situations. Let the person you are speaking to know you are
driving; if necessary, suspend the call in heavy traffic or
hazardous weather conditions. Rain, sleet, snow and ice can
be hazardous, but so is heavy traffic. As a driver, your first
responsibility is to pay attention to the road.

Do not take notes or look up phone numbers while driving.

If you are reading an address book or business card while
driving a car, or writing a “to do” list, then you are not
watching where you are going. It's common sense. Don’t get
caught in a dangerous situation because you are reading or
writing and not paying attention to the road or nearby
vehicles.

Dial sensibly and assess the traffic; if possible, place calls
when you are not moving or before pulling into traffic. Try to
plan your calls before you begin your trip, or attempt to
coincide your calls with times you may be stopped at a stop
sign, red light or otherwise stationary. But if you need to dial
while driving, follow this simple tip-dial only a few numbers,
check the road and your mirrors, then continue.

Do not engage in stressful or emotional conversations that
may be distracting. Stressful or emotional conversations and
driving do not mix-they are distracting and even dangerous
when you are behind the wheel. Make people you are talking
with aware you are driving and if necessary, suspend phone
conversations which have the potential to divert your attention
from the road.

Use your smartphone to call for help. Your smartphone is one
of the greatest tools you can own to protect yourself and your
family in dangerous situations-with your smartphone at your
side, help is only three numbers away. Dial 9-1-1 in the case of
fire, traffic accident, road hazard, or medical emergencies.
Remember, 9-1-1is a free call on your smartphone!

9. Use your smartphone to help others in emergencies. Your

smartphone provides you a perfect opportunity to be a “good
Samaritan” in your community. If you see an auto accident,
crime in progress, or other serious emergency where lives are
in danger, call 9-1-1, as you would want others to do for you.

10.Call roadside assistance or a special wireless non-emergency

assistance number when necessary. Certain situations you
encounter while driving may require attention, but are not
urgent enough to merit a call to 9-1-1. But you can still use
your smartphone to lend a hand. If you see a broken-down
vehicle posing no serious hazard, a broken traffic signal, a
minor traffic accident where no one appears injured, or a
vehicle you know to be stolen, call roadside assistance or
other special non-emergency wireless number.
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NOTICE FOR CONSUMERS WITH HEARING DISABILITIES

Digital Wireless Phones to be Compatible with Hearing Aids

On July 10, 2003, the Federal Communications Commission
(FCC) modified the exemption for wireless phones under the
Hearing Aid Compatibility Act of 1988. This means that wireless
phone manufacturers and service providers must make digital
wireless phones accessible to individuals who use hearing aids.

For more information, please go to the FCC's Consumer Alert
on accessibility of digital wireless phones at http://www.fec.gov/

/consumerfacts/: iblewireless.html.

Wireless telephones are hand-held phones with built-in
antennas, often called cell, mobile, or PCS phones. These phones
are popular with callers because they can be carried easily from
place to place.

Wireless telephones are two-way radios. When you talk into a
wireless telephone, it picks up your voice and converts the sound
to radio frequency energy (or radio waves). The radio waves
travel through the air until they reach a receiver at a nearby base
station. The base station then sends your call through the
telephone network until it reaches the person you are calling.

Making a
Phone Call

8

Receiving a
Phone Call

When you receive a call on your wireless telephone, the
message travels through the telephone network until it reaches a
base station close to your wireless phone. Then the base station
sends out radio waves that are detected by a receiver in your
telephone, where the signals are changed back into the sound of
a voice.
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The Federal Communications Commission (FCC) and the Food
and Drug Administration (FDA) each regulate wireless
telephones. FCC ensures that all wireless phones sold in the
United States follow safety guidelines that limit radio frequency
(RF) energy. FDA monitors the health effects of wireless
telephones. Each agency has the authority to take action if a
wireless phone produces hazardous levels of RF energy.

FDA derives its authority to regulate wireless telephones from
the Radiation Control provisions of the Federal Food, Drug, and
Cosmetic Act (originally enacted as the Radiation Control for
Health and Safety Act of 1968).
[http://www.fda.gov/cdrh/comp/eprc.html].

FCC derives its authority to regulate wireless telephones from
the National Environmental Policy Act of 1969 (NEPA) and the
Telecommunications Act of 1996
http://www.fcc.gov/telecom.html]. Updated 7/16/2003

Hands-Free Capability

All CTIA Certified portable products provide the consumer with
a toll-free number for the purchase of a compatible hands-free
device. 1-800-881-7256

STATIC ELECTRICITY, ESD, AND YOUR PALM DEVICE
Electrostatic discharge (ESD) can cause damage to electronic
devices if discharged into the device, so you should take steps to

avoid such an occurrence.

Description of ESD

Static electricity is an electrical charge caused by the buildup of
excess electrons on the surface of a material. To most people,
static electricity and ESD are nothing more than annoyances. For
example, after walking over a carpet while scuffing your feet,
building up electrons on your body, you may get a shock—the
discharge event—when you touch a metal doorknob. This little
shock discharges the built-up static electricity.

ESD-susceptible equipment

Even a small amount of ESD can harm circuitry, so when
working with electronic devices, take measures to help protect
your electronic devices, including your Palm® device, from ESD
harm. While Palm has built protections against ESD into its
products, ESD unfortunately exists and, unless neutralized, could

build up to levels that could harm your equipment. Any
electronic device that contains an external entry point for
plugging in anything from cables to docking stations is
susceptible to entry of ESD. Devices that you carry with you, such
as your Palm device, build up ESD in a unique way because the
static electricity that may have built up on your body is
automatically passed to the device. Then, when the device is
connected to another device such as a docking station, a
discharge event can occur.

Precautions against ESD
Make sure to discharge any built-up static electricity from
yourself and your electronic devices before touching an
electronic device or connecting one device to another. The
recommendation from Palm is that you take this precaution
before connecting your Palm device to your computer, placing
the device in a cradle, or connecting it to any other device. You
can do this in many ways, including the following:
¢ Ground yourself when you're holding your device by
simultaneously touching a metal surface that is at earth ground.
For example, if your computer has a metal case and is plugged
into a standard three-prong grounded outlet, touching the case
should discharge the ESD on your body.
* Increase the relative humidity of your environment.
* Install ESD-specific prevention items, such as grounding mats.

Conditi that ent ESD occurrences
Conditions that can contribute to the buildup of static electricity

in the environment include the following:

* Low relative humidity.

* Material type (The type of material gathering the charge. For
example, synthetics are more prone to static buildup than
natural fibers like cotton.)

* The rapidity with which you touch, connect, or disconnect
electronic devices.

While you should always take appropriate precautions to
discharge static electricity, if you are in an environment where
you notice ESD events, you may want to take extra precautions

to protect your electronic equipment against ESD.
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Specifications

Radio e CDMA 800 (Digital Cellular), 1900 (PCS), and 1400(GPS)
¢ EVDO and 1XRTT
Phone features ® Personal speakerphone ® Microphone mute option
* Hands-free headset jack * TTY compatible
(2.5 mm, 3-barrel connector) ® 3-way calling
Processor ¢ Intel XScale™ processor, 312MHz
technology
Expansion e SD/MultiMediaCard/SDIO card slot
Battery ® Rechargeable Lithium lon * Up to 4.7 hours talk time
* Removable for replacement e Up to 15 days standby
® 3.5 hours full charge time
Operating ¢ Windows Mobile Edition 5.2.2.0 (Phone Edition)
system

Camera (not
included on all

¢ Still image capture resolution:1280 x 1024, 1.3 megapixel
* Automatic light balance

smartphones)
Size ©5.08in x2.28in x 0.89 in (129mm x 58mm x 22.5mm) with antenna
Weight ® 6.4 ounces (180 grams)
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Connectivity e Infrared (1.2 compliant)
¢ Bluetooth® wireless technology (1.2 compliant)

Display * Touch-sensitive LCD screen (includes stylus)
® 65,5636 colors (16-bit color)
e User-adjustable brightness

Keyboard e Built-in QWERTY keyboard plus 5-way navigator
* Backlight for low lighting conditions
Included ¢ Today/Phone (includes Speed Dial * Word Mobile
software and Dial Pad) * PowerPoint Mobile
* Messaging (text, multimedia, and ® Pocket MSN
email) e Solitaire
e Internet Explorer Mobile (web browser) ¢ Bubble Breaker
e Camera ¢ Voice Command
¢ Pictures & Videos ¢ Downloads application
¢ Windows Media Player Mobile ® Quick Tour
e File Explorer ® Search
e Contacts e Terminal Services
® Calendar ¢ Picsel PDF Viewer
® Tasks (available on the Getting
¢ Notes Started CD)
e Calculator ® Cubis (available on the
e ActiveSync® Getting Started CD)
* Excel Mobile
System e Windows 2000 or XP with USB port. Later versions may also be
requirements supported

* Some wireless features require Microsoft 2003 Exchange Server with
Service Pack 2
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Operating and ® 32°F to 104°F (0°C to 40°C)
storage ® 5% to 90% RH
temperature
range
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Index

SYMBOLS

licon 10

NUMERICS

1xRTT data networks 221

1XRTT network icons 220

3G2 files 81, 126, 127

5-way navigator 6, 19, 21,
236

802.1x page (Network
Authentication) 205

911 calls 178, 189

A

AC charger 8
accented characters 27
Access page 198
accessing
alternate characters 27
applications 30, 185
calculator 77
corporate email accounts
207, 233
Dial Pad 44
field lists 25
File Explorer 156, 158,
171

information 31, 196
instant messages 103
menu items 23, 24
on-device help 36
Outlook folders 225
Phone Settings screen 14
Quick Tour 35

secure websites 196, 234

shortcut menus 24, 205,
223
speed dial buttons 43
spreadsheet templates
144
Tasks entry bar 73
the Internet 206, 221
Today screen 38, 242
voicemail 47
web pages 104, 106, 234
accessories 218
account types 86
accounts
accessing corporate 207,

getting help with 36

preventing unauthorized
use of 190, 196

setting up email 86-93

synchronizing 96

troubleshooting 230
Accounts page 98
action keys 6
activating items on screen 21
active calls
See also phone calls
adding a second 50
adjusting volume for 176
ending 13, 49, 50
managing 48, 50
ActiveSync icons 33
ActiveSync software 15, 161,
224,233
options 161
ActiveSync technology 241
Add Contact prompt 49
Add Server Source
command 88
Add Server Source prompt

Add to Favorites command
106

adding
a second call 50
applications to Start

menu 185

appointments 64, 66
attachments to email 94,
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156
bulleted or numbered
lists 137
caller ID pictures 61
connections 206, 208
contacts 49, 61
documenttemplates 135,
139
email messages 94
expansion cards 166
favorites links 106
files to playlists 130
folders 138
My Text phrases 82
notes 61, 71, 74
signatures 100
speed dial buttons 54
spreadsheets 142
tasks 71
untimed events 64, 66

address book 95, 101
Address page 95, 101
addresses

adding email 61, 94, 95
entering message 79, 80,
82

messaging options for
101

multiple recipients 81

selecting email 21

adjusting screen brightness
183

Advanced page (Power
Settings) 199
advancing slides 140, 141

After calls from numbers...

setting 177

Agenda View (calendar) 63

alarm clock 195
alarm sounds 195
alarms
events and 66
setting system 195
setting vibrating 182
tasks and 71
turning on and off 181
Alarms page 195
albums 120
alert tones. See ringtones
aligning the screen 184
alignment settings
documents 137
spreadsheets 142
Allow cookies setting 109
Allow USB connections
check box 224
Alt key 26, 241
alternate characters 27

alternate characters list 27,

alternate phone numbers 42

animated images 126
animation 140, 141
anniversaries 66

Answer button 46

answering the phone 46, 51

antenna 5, 246

Appearance page 173, 174,
184

applications

See also third-party
applications

accessing help for 36

accessing shortcut
menus 25

associating with buttons
185

battery life and 34

closing 16, 30, 198

copying 170

customizing 185-188

deleting 160, 238

displaying 198

downloading 158

error reporting for 196

included with
smartphone 254

installing 157-159, 236

losing information in 214

moving to expansion
cards 170

opening 30, 168, 243

phone conversations and
running 48, 49

reinstalling 214

running from expansion
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cards 168, 238
storing 238
transferring information
from 32
troubleshooting 217
turning sounds on or off
for 181
viewing main menus 23
viewing memory usage
for 198
appointments 67
See also events
adding 64
appearing in wrong time
slots 227
deleting 69
entering multiple 63
hiding 67
marking as private 67
reminders for 66, 70
scheduling repeating 66
viewing 63
Appointments page 70
Area code setting 62
arrow icons (navigator) 19
Assign a program list 186
attachments
See also email
adding 94, 156
downloading 97
embedded objects in 98
freeing internal memory

and 238
opening 97
receiving 97
storing 98, 102
troubleshooting 232
audio 46, 125, 127
See also media files;
music
audio accessories 59
authentication 205
Authentication dialog box 91
Authentication list 204
auto shut off timer 165
Auto Sync, troubleshooting
231
auto-completion options 187
AutoCorrect command 123
Autofill setting 146
AutoFilter command 149
AutoFilter settings
(spreadsheets) 143
auto-keyguard feature 189,
190
Auto-Keyguard settings 190
Auto-lock settings 191
auto-off interval 241

back view (Treo™ 700
smartphone) 7

backgrounds 117, 123, 132,
173

backing up information 214
backlight (keyboard) 26, 199
Backspace key 22, 26
backup utilities 211, 215, 229
backups, restoring 215, 229
Band selection settings 179
battery
Bluetooth connections
and 112
charging 9-10
conserving power for 199
consumption factors 10
disposing of 216, 248
installing 8
maximizing life of 34
replacing 216
specifications for 253
viewing remaining
power for 199
viewing status of 40
battery contacts 8
battery door release 6, 7
battery icon 10
Battery Power page 199
battery status icons 40
Beam... command 112, 115
beaming 112, 114-116, 156,
241
birthdays 66
Bluetooth devices
compatibility with 110
connecting to 110-112,
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113
discovery setting for 112
phone calls and 59
sending and receiving
information over 112
synchronizing with 113
troubleshooting 222, 223
Bluetooth feature 110, 111
Bluetooth icon 40, 111

Bluetooth Settings screen
111

Bluetooth status indicator 40

BMP files 81, 126

Bold setting 137

border glow highlight 21

borders 142

Brightness command 118

brightness icons (camera)
118, 119

brightness, adjusting 118,
119, 183

broadband technology 241

BroadbandAccess data
networks 221

BroadbandAccess icons 220

browsing files and folders
155, 171

browsing the web. See web
browsing

built-in applications 36, 160,
254

built-in camera. See camera

bulleted lists 137
bullets 133
buttons
activating menus and 23
assigning voice
commands to 186
associating with
applications 185
calculator 77
creating speed dial 54
disabling 189
editing speed dial 56
on 5-way navigator 19
opgeoning applications and

reassigning 185-186
selecting or activating 21
turning sounds on or off
for 181
Buttons page 132
Buttons Settings page 185

C

calculations 77, 142, 145
Calculator application 77
calculator buttons 77
Calculator icon 77
calendar
adding meeting requests
67

adding special events 64
displaying 63

removing events 69
setting alarms for 66
setting options for 69
unavailable time slots on

Calendar application
adding contacts and 61
customizing 69-70
managing schedules

with 64-69
selecting views 63
starting 63
synchronizing with 32
untimed events in 64

calendar views 63

call forwarding 53

Call Log 44, 54

Call Log command 44

Call Timers command 54

call waiting 51

call waiting notification

window 51

callback number 80

caller ID applications 236

caller ID blocking 49

caller ID pictures 61, 117, 176

calling plans 54

calls. See phone calls

camera
See also pictures
battery life and 34
capturing videos with
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119-120
freeing internal memory
and 238
specifications for 253
taking pictures 117-118
troubleshooting 235-236
Cameraicon 118
camera lens 7
Camera page 125
Camera Preview Mode 236
camera settings 124-125
Cancel Bluetooth command
59
Cancel Mute command 48
capitalization 27, 188
Caps Lock 27
captions 83
capture resolution 253
carrying cases 218
case-sensitive searching
135, 151
cell patterns 142
cell phones. See wireless
phones
Center button (navigator) 19
certificates 108, 196
Certificates page 196
Change passcode button 191
changing
alarm sounds 195
connections 206
contacts 62

date and time settings
194
information 15, 151
lock codes 191
picture or video
resolution 118, 120, 235
speed dial buttons 56
text 135
text size 183
character sets 108
characters
capitalizing 27, 188
entering 27, 187
phone calls and 47, 55
text messages and 79, 80
typing alternate 27
charging
smartphone 8, 34
the battery 9-10
charging status 10
Chart command 149, 150
charts 143, 149, 150
chat rooms 36
check boxes 21
Clear Cookies setting 109
Clear History setting 109
Clear Now Playing
command 131
Clear Type setting 183
Clock & Alarms Settings
page 194, 195
closed networks 201, 202

closing
applications 16, 30, 198
lists in fields 25
menus 24
screens 21
color settings 236
color themes 174, 184
colors 184
command buttons 186, 187
commands 187
See also menus; specific
command
company lists 43
company names 43, 62
comparisons 149
completed tasks 71, 72
compliancy statement 246
components (Treo
smartphone) 2
compressed files 157
computers
connecting to 16
installing from 158
synchronizing with 15,
system requirements 15
Conference button 52, 53
conference call
Flash mode 52
conference calls 50, 52
Confidential setting 68
Configure Server command
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161
Configure Wireless Network
page 203
configuring
data services 221
Exchange Server 161
TTY devices 177
wireless networks 203
Connect command 207
Connect via Bluetooth
command 113
Connectvia IR command 116
connecting
smartphone to PCs 16
to a headset 111
to Bluetooth devices 110-

112,113
to data service providers
206

to hands-free car kit 111
to mobile networks 219
to the Internet 206, 221
to VPNs 207-208
to Wi-Fi networks 202,
205
connection icons 220
connections
adding 206, 208
band selection settings
for 179
changing 206
customizing 201-209

ending 209
manually starting 207
precautions for 251
removing Bluetooth 111
synchronizing
information and 32
synchronizing over
infrared 116
troubleshooting 219-222
unavailable 220
Connections Settings page
206, 208
connectivity 254
conserving battery power
199
consumption (battery) 10
contacts
adding 49, 61
addressing to 80, 82, 94
alternate phone numbers
for 42
assigning ringtones to
55, 61,121,176
changing 62
displaying 62
entering multiple 61
linking speed dial
buttons to 54
looking up 41
personalizing 176
removing 62
saving information for 49

selecting communication
method for 42
sending meeting
requests to 67
synchronizing 32
viewing details list for 41
Contacts application
customizing 62
managing contact
information with 61-62
starting 61
synchronizing with 32
Contacts list 41, 62
context-sensitive menus 24
continuous playback (slides)
1

cookies 109
Copy command 77,108, 122,

136, 170
copying

applications 170

items in folders 157

numbers 77

phone numbers 44, 45

pictures and videos 121

text 108, 136
copyrighted items 120
corporate email accounts 87

corporate mail systems 207,
233

corporate servers 207, 233
coverage area 11, 219
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creating
appointments 64, 66
bulleted or numbered
lists 137
caller ID pictures 61
connections 206, 208
contacts 49, 61
documents 133, 134, 135
email messages 94
favorites links 106
folders 138
multimedia messages 81
My Text phrases 82
notes 74, 75
playlists 130
signatures 100
speed dial buttons 54
spreadsheets 142
tasks 71
templates 85, 135, 139,
144
text messages 79
untimed events 64, 66
video ringtones 121
workbooks 144
cropping pictures 123
Currency page 184
currency symbols 184
current call. See active calls
customer support 36
Customize the playlists...
check box 127

customizing
applications 185-188
Calendar 69-70
camera 124-125
connections 201-209
Contacts application 62
dates and time 194
display settings 183-184
Excel Mobile 153
format settings 183
Internet Explorer 108
Media Player Mobile 131
Megsaging application

101

multimedia messages
102
Notes application 76
phone 175-179
system settings 194-200
system sounds 180
Tasks application 73
Today screen 173-174
voicemail system 55
Word Mobile 139
Cut command 122, 136
cutting. See deleting

D
daily schedules 63
data 144, 146, 214
See also information
Data Encryption settings 204

data formats 183
data service providers 206,
221

data services 3, 39, 220
data transfer 220, 241
date formats 184
Date page 184
dates 146, 184, 194
See also calendar
Day View (calendar) 63
day-planner formats 63
decimal places 183
decimal symbols 183, 184
decompression utility 157
default format settings 183
default lock code 191
default template 139
default zoom level 188
defined names
(spreadsheets) 147
Delete Appointment
command 69
Delete Cells command 152
Delete command 100, 139,
152
Delete Contact command 62
Delete Files setting 109
Delete Task command 73
Deleted Items folder 99, 102
deleting
applications 160, 238
Bluetooth connections
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111
certificates 196
contacts 62
directory services 95
documents 139
events 69
favorites links 106
files 157
items from playlists 130
items in folders 156
messages 99, 100, 101
notes 76
pictures 123
sounds 176
speed dial buttons 56
tasks 73
text 22
workbooks 152
worksheets 152
desktop software 212, 241
See also applications
device
ESD and 251
Device Setup Wizard 127
devices
beaming to 114
caution for storing 7
compliancy for 247
configuring TTY/TTD 177
identifying 112, 204
setting up GPS 197
troubleshooting 222

diagnostic information 196
Dial Lookup list 12
Dial Pad 44, 45
Dial Pad command 44
dial pad tones 177
dialing 13, 41-45, 50, 55
Dialpad setting 177
digit grouping 183, 184
Direct Push Technology 86
directory service 95, 101
Disable touchscreen check
box 190
Disconnect Bluetooth
command 113
Disconnect command 209
discoverable setting 112
Dismiss button 47
display
See also screen
customizing 183-184
scroll settings for 188
specifications for 254
display formats 183
Display message on screen
check box 182
displaying
alternate characters 28
animated images 126
appointments 63
available applications 30
calendar 63
contacts 41, 62

daily schedules 63
documents 133
events 64, 68
items in folders 139, 152
memory usage 198
menus 23, 25
multimedia messages 84
notifications 182
pictures 120, 126
power settings 199
space on expansion
cards 170, 198
spreadsheets 142, 143
tasks 72, 73
videos 120, 126
web pages 104, 108
wireless settings 200
document file types 133, 139
documentation 2
documents
See also Word Mobile
application
creating 133, 134, 135
deleting 139
displaying 133
finding and replacing
operations in 135
moving or copying
operations in 136
opening 135
organizing 138
saving 134, 136, 139
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setting margins for 137
spell-checking 138
documents list 139
down arrow in fields 25
Down button (navigator) 19
downloading
applications 158
attachments 97
email 233
files 107
images 107, 126
multimedia messages 83
ringtones 175
drafts 94
drawing 74
drivers 212
driving safety tips 248
dummy expansion card 167

EAP type setting 205
earpiece 6
eBooks 34
echoes 239
Edit command 123
Edit Speed Dial command 56
editing. See changing
electrostatic discharge 251
email

adding attachments 94,

156

addressing 61, 94, 95

creating messages for 94
dialing from 44
entering contact
information and 61, 67
getting from corporate
servers 207, 233
messaging options for
101
priority settings for 95
receiving attachments
with 97
requirements for 1
selecting addresses 21
sending 95
troubleshooting 230-233
email accounts
setting up 86-93
setting up multiple
accounts 93
synchronizing 96
troubleshooting 230
E-mail application 32
email client software 232
email message icons 99
embedded images 98
emergency calls 178, 189

Empty Deleted Items
command 99

Enable local network time
check box 194

Encoding setting 108

encryption 108, 204

End Conference button 52
End Show command 140
ending active calls 13, 49, 50
ending data connections 209
ending playback 129
endnotes 134
entering
alternate characters 28
datain spreadsheets 144,
146
information 15, 26, 188
lock codes 190, 191
numbers on calculator 77
owner information 193
passwords 93, 191, 192
phone numbers 45
Erase all data? prompt 214
erasing. See deleting
error messages 181
error reporting 196-197
Error Reporting page 197
errors 196, 219
ESD (electrostatic discharge)

EVDO (defined) 242
EVDO icons 220
EVDO networks 221
event icons 70
Event settings 182
events
categorizing 68
creating 64, 66, 67
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deleting 69
hiding 67
marking as sensitive 67
reminders for 66, 70
Events check box 181
Excel applications 142
Excel Mobile application
customizing 153
display settings for 144
formatting
considerations for 142
overview 142
searching in 151
starting 144
Excel Mobile icon 144
Exchange Address Book 225
Exchange Server accounts
15, 86, 88, 161, 233
exiting applications 30, 198
expanding lists in fields 25
expansion card slot 5, 167,
253
expansion cards
adding applications 159
displaying available
space on 170, 198
freeing memory and 238
inserting 167
moving itemsto 138, 151,
169, 170
opening items on 168
removing 167

renaming 171
saving items on 169
searching on 155, 156
storing attachments on
98, 102
transferring to 127, 130
types supported 166
extensible authentication
protocol 205
extensions (phone) 55
external power sources 199
Extra Digits button 47, 55
Extra Digits text box 55

F
factory-installed
applications 36, 160, 254
Favorites button 106
Favorites buttons. See Quick
Keys
Favorites command 106
favorites links 106, 107
FCC Statement 245
features 1, 35
fields
accessing lists for 25
scrolling through 20
File Explorer 155, 156, 171
File Explorer icon 156, 158
file lists 157
file names 134, 136, 138
file types 81, 127, 133, 139

files 155, 207, 238
caution for deleting 157
filtering information 62, 149
filtering tasks 72
Find/Replace command 135,
151
finding
information 32, 151, 155
text 135
firewalls 207
first letter capitalization 27,
188

First Synchronization dialog
box 92
Flash mode 52
folder names 138
folders
accessing Outlook 225
adding documents to 136
arranging pictures and
videos in 122
browsing 155, 171
creating 138
displaying contents 139,
152
moving items to 138, 151
opening items in 156
organizing web favorites
in 106, 107
sorting contents 139, 152,
156
Font color setting 137
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Font command 136

Font setting 137

fonts 134, 137, 142

footers 134

footnotes 134

forgetting passwords 191,
192

formatting
charts 150
paragraphs and lists 137
spreadsheet cells 147-
148

system information 183
text 136
Formatting toolbar 137
formulas 142, 145, 153
forwarding
email 232
messages 99
phone calls 53
forwarding codes (phone) 52
freeing memory 160, 238
front view (Treo
smartphone) 6
full charge (battery) 9
functions (spreadsheets)
142, 146

G

games 34
GIF files 81, 126
Global Positioning System

(GPS) 197
Glossary 241
Go to Slide command 140
GPS devices 197
GPS Settings page 197

H

Hands Free check box 111

hands-free car kit 58, 111

hands-free devices 58, 110,
251

hanging indents 138

hanging up phone 49, 50

hard resets 191, 214

hardware 2

Hardware buttons box 181

Hardware page 197

headers 134

headset 58-59, 111

headset button 58

headset jack 6

hearing disabilities 177, 247,
250

heat sources 35

help 36, 211, 237

Help command 36

Help screen 36

hiding
appointments 67
events 67
speed dial buttons 43
Tasks entry bar 73

Highlight setting 137
highlighting
alternate characters 28
items in lists 25
items on screen 20, 21
menu items 23, 24
multiple items 157
text 22, 137
high-speed data transfer 241
hints (passwords) 192
History command 108
History list 108, 109
Hold button 48
home locations 194
Home Page setting 108
Hotmail accounts 87, 103
hypertext links. See links

icons
charging status 10
data services 220
email 99
events 70
phone status 38
signal-strength 11, 200
synchronization 33
Ignore with text message
command 46
IM messaging 79, 103
image files 81, 126
images 98, 107, 234, 236, 238
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See also pictures
IMAP accounts 87, 92, 98
inactivity 190, 199
Inbox 99
Indentation setting 137
indented lists 134
indenting text 138
indicator light 6, 10, 11
information

accessing 31, 196

backing up 214

changing 15, 151

entering 15, 26, 188

filtering 62, 149

losing 214

moving 169, 170

protecting 189, 191

restoring 215

saving 169

searching for 32, 135,

151, 155

sorting 149

storing 166, 238

synchronizing 15, 32,

164, 224

transferring 211, 242

updating 15, 241
infrared port. See IR port
infrared transmissions 116,

242
Input Settings page 187
installation, troubleshooting

212,214, 236
installing
applications 157-159, 236
desktop software 212
synchronization software
15,16
VPN clients 207
Windows drivers 212
instant messages 79, 103,
236
interference 113
internal memory 160, 238
Internet 206, 221
Internet Connection Speed
setting 132
Internet Explorer Mobile
104-109, 206, 234
IR port 5, 114, 242
ISP settings 206
ISPs (Internet Service
Providers) 87
Italics setting 137
items
accidentally activating
189

highlighting 20, 21

moving through 20

opening shortcut menus
for 24, 205, 223

selecting for Today
screen 174

sezlecting oractivating 21,

5

Items page 174

J
JPEG files 81, 126

K

Key index setting 204
keyboard
accessing alternate
characters on 27
dialing from 41
displaying alternate
characters list for 28
entering text from 27-28
locking 189, 190
pressing keys on 26
scrolling with 20
selecting menu items
from 23
setting key combinations
for 185
specifications for 254
third-party applications
and 236
keyboard backlight 26, 199
Keyguard 189
Keyguard Settings page 190
Known Caller setting 175

L

LANs 207
large files 238
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LCD projector 141
leading zeros 184
Left button (navigator) 19
Legacy Pocket Word files 134
libraries (media) 129
Library command 128, 129
Library list 128
Library screen 128, 132
lightening bolt 10
lightning 10
Li-lon battery 242
See also battery
links
freeing internal memory
and 238
media files and 129
selecting or activating 21
text messages and 98
troubleshooting 234
list separators 183
List setting 137
Listen button 47
listening to
media files 59, 127
voicemail messages 47
lists
accessing 25
closing 25
creating 134, 137
formatting 137
highlighting items 20, 25
scrolling through 20

selecting items 21, 25
local area networks 207
locating information 32, 151,

155
Location Privacy icon 40, 178
Location Privacy setting 178
location-specificinformation
178, 183, 194, 197
lock codes 189, 190, 191
Lock icon 104, 120
locking
spreadsheet rows and
columns 145
the keyboard 189, 190
Treo smartphone 189,
191

logging in to

corporate servers 207

secure websites 196
Long tones setting 177
lookup feature 41, 155
losing

information 214

passwords 191, 192

Treo smartphone 32, 193
low coverage areas 219
low lighting conditions 26
lowercase letters 27

magnet 7
maghnification. See zoom

settings
mail servers 207, 233
main menus 23
Make this device
discoverable setting 112
Manage existing
connections setting 207

Manage GPS automatically
check box 198
maps 197, 234
margins 137
Match case box 135, 151
Match whole words only
check box 135, 151
maximizing battery life 34
measurement units 184
media files
creating playlists for 130
formats for 127
linking to 129
playing 128
transferring 127, 130
updating 129
media libraries 129
Media Player Mobile
customizing 131
overview 127
starting 128, 131
media players 34
meeting requests 67, 70, 98
memory buttons 77
Memory page 109
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Memory Settings page 198
memory usage 198
memory, freeing 160, 238
memos. See messages;
notes
Menu button 23
menu items, selecting 23, 24
menus 23, 24, 205, 223
Menus page 185
Message page 101
messages
See also multimedia
messages; text
messages; voice notes
adding signatures 100
addressing 79, 80, 82
creating email 94
deleting 99, 100, 101
dialing from 44
displaying status of 99
forwarding 99
invalid characters and 80
listening to 47
phone calls and 48
rearranging 99
receiving notifications for
83, 222
saving as drafts 94
selecting multiple 100
messaging
troubleshooting 221
Messaging application

accessing 79, 94
adding contacts and 61
customizing 101
freeing internal memory
and 238
overview 79
messaging applications 236
Messaging icon 79
Messaging list 100
messaging services 1, 221,
242,243
microphone 6, 48, 125
microphone icon 187
Microsoft Excel 142
Microsoft Exchange 2003
Server
Direct Push Technology
86

Microsoft Exchange Server.
See Exchange Server
Microsoft Outlook. See
Outlook
microwaves 113
MIDI files 81
Missed call setting 175
MMS messaging 79, 242
mobile accounts 36, 190
mobile devices
battery life and 35
getting help with 36
mobile networks 219
mobile phone numbers 61

See also wireless phones
Mobile to Market certificates
157
Modify Sheets command
148
Month View (calendar) 63
most recently dialed
numbers list 44
moving
documents to folders 138
information 169, 170
pictures and videos 121
speed dial buttons 57
text 136
workbooks 151
moving around the screen
19-20
MP3 files 127
MSN Hotmail 87, 103
MSN Messenger Contacts
list 103
multi-connector 6
multimedia messages
See also messages
adding items to 82
addressing 82
creating 81
customizing 102
displaying 84
downloading 83
file types for 81
freeing internal memory
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and 238
maximum size 82
phone numbers in 44
playing 84-85
previewing 83
receiving 83
requirements for 3
saving 85
sending 81, 83
troubleshooting 221
Multimedia Messaging
System. See MMS
messaging
MultiMediaCard expansion
cards 166, 167
Multiple Networks Detected
dialog box 202
multiple recipients 81
music 46, 127, 128, 176
See also media files
Mute command 48
My Device folder 156
My Device library 129
My Documents folder 155
My Mobile Devices folder
242
My Pictures folder 117, 119
My Playlists category 130
My Storage Card library 129
My Text command 80, 94
My Text phrases 79, 80, 94

names 243
naming
document files 134, 136,
138

folders 138
groups of pictures 125
speed dial buttons 54
templates 144
workbooks 144, 151
worksheets 147
NationalAccess data
networks 221
NationalAccess icons 220
navigating the screen 19-20
navigator. See 5-way
navigator
negative numbers 183, 184
Network Cards icon 203, 205
network connections 201,
219-222
Network Key page 203
Network key setting 204
Network page 132, 179
New Appointment
command 64
New Network Detected
dialog box 202
New Sound command 176
Nevl/1 Speed Dial command
5

notes

adding tasks and 71
creating 74, 75
entering contacts and 61
removing 76
saving 76
Notes application 74, 76
Notes icon 74
Notes list 75
Notes page 61
notification screens 47, 51,

notifications
Bluetooth devices and
113
displaying on screen 182
downloading sounds 175
messages and 83, 222
previewing ringtones 176
selecting 181
setting ringtones for 175
silencing sounds for 180
voicemail and 47
Notifications check box 181
Notifications page 175, 182
Now Playing playlist 130
Now Playing screen 130
number pad 13
Number page 183
number sign symbol 184
numbered lists 137
numbers
See also phone numbers
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entering 27, 77
formatting 142, 146, 183

o

Off Hold button 48
offline synchronization 225
Off-peak times setting 165
OK button 6
on-device help. See help
online address book 95, 101
online forums 36
online support 36
open networks 201, 202
opening
applications 30, 168, 243
attachments 97
calculator 77
characters list 27
Dial Pad 44
documents 135
File Explorer 156, 158,
171

Help screen 36

items in folders 156
Outlook folders 225
Phone Settings screen 14
Quick Tour 35

shortcut menus 24, 205,
223

templates 144
Today screen 38
web pages 104, 106, 234

operating system (Treo
smartphone) 253
operating systems (PCs) 15
operating temperatures 255
operational warnings 247
Option button 20, 242
Option key 26, 27
Option Lock 27
options 24, 25, 67
Options page 188
organizer features 34
orientation (slides) 141
Orientation page 141
Outbox 86, 99
Outlook
accessing folders for 225
client software and 232
downloading from 97
entering appointmentsin
63

entering contacts in 61
installing drivers for 212
synchronizing with 91, 95
overdue tasks 72
owner information 193
Owner Information page 193

P

page breaks 134

Palm Powered devices 16,
211

Paragraph command 137

paragraph formatting 137
partial battery icon 10
passkeys 111
Password Settings page 192
passwords 89, 93, 189, 191
Paste command 77, 108, 122
patches 160
patterns in workbooks 142
PCS phones. See wireless
phones
PCs. See computers
Peak times setting 165
performance 217
personal information 191,
193, 241
personal information
manager 225
Personal setting 68
Personal Settings page 173,
175, 185, 186, 193
phone
See also phone calls;
smartphone
adjusting volume 13, 176
advanced features 50-54
answering 46, 51
customizing 175-179
disabling touch-sensitive
feature for 189
downloading ringtones
for 175
getting forwarding codes
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for 52
hanging up 49, 50
overview 37, 41
previewing ringtones 176
running applications and
silencing ringer 46, 180
specifications for 253
turning off 13
turning on and off 11
viewing minutes usage
for 54
waking up screen for 48
phone calls
See also phone numbers
ending 49, 50
entering extra digits for
47, 55
forwarding 53
hands-free devices and
110
making 41, 48, 50
placing on hold 48
receiving 46, 48
sending to voicemail 46
setting ringtones for 175
setting up conference
sessions for 52
troubleshooting 222
phone contacts 8
Phone dialog box 44
phone headset 58-59

phone lock feature 189, 190
phone numbers
adding to messages 80
assigning to speed dial
buttons 54
checking 14
copying 44, 45
dialing 13, 41-45, 50, 55
entering manually 45
redialing most recent 44
saving 49-50
selecting 21
Phone Off
242
Phone Settings page 177,
178, 179
Phone Settings screen 14
phone status icons 38
Phone/Send button 6, 13,
242
Phone/Send icon 41
phone-off icon 11
picture files 81, 126
picture speed dial buttons
43,54
pictures
adding to messages 82
as backgrounds 123, 173
as screensaver 124
assigning to contacts 176
changing resolution 118,
123, 235

creating caller ID 61
defaults for 117
deleting 123
editing 123
naming groups of 125
on phone without
camera 117
organizing 121
previewing 236
saving 125
sending 121
setting default size 125
synchronizing 126
taking 117-118
troubleshooting 235
viewing 120, 126
Pictures & Videos
application 118, 119
PIM applications 225, 241,
243
Play button 128
Play Slide Show command
120
Play sound check box 182
Play Sound list 195
playback icons 55, 128
Playback page 131, 141
Playback screen 131
playback, ending 129
playing
media files 128
multimedia messages
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84-85
presentations 140, 141
sounds 125, 176
voice notes 75
voicemail messages 47
playlist files 127
playlists 127, 130
PNG files 126
Pocket MSN application 103
POP accounts 87, 92
portable radio. See radio
ports. See IR port; USB ports
Power Settings page 199,
200

Power/End button 6
PowerPoint Mobile
application 140-141
PowerPoint Mobile icon 140
precautions 251
preferences, setting. See
customizing
presentations 140, 141
See also PowerPoint
Mobile application
previewing
multimedia messages 83
pictures 236
sounds 176, 182
priority levels 71
Priority list 95
privacy settings 178
private appointments or

events 67
Private setting 67
processor 253
Program Buttons page 185
Programs check box 181
Programs page (GPS
Settings) 197
Programs screen 30
programs. See applications;
software
projectors 141
protected spreadsheets 142
protecting
expansion card slot 167
information 189

Treo 700 smartphone
189-193

proxy servers 208
punctuation marks 27
push
Direct Push Technology
86

Q

QCELP files 81

Quality command 120
Quick Keys 43, 55

Quick Tour 35

quitting applications 30, 198

R
radio 247, 253

radio frequencies 245
RAS connections 206
Receive all incoming beams
check box 112
receiving
attachments 97
beamed information 115
email 231
meeting requests 98
multimediamessages 81,
83
text messages 80, 83
Receiving Data message 115
rechargeable battery. See
battery
recipients, sending to
multiple 81
Record button 76
recording
ringtones 176
videos 119-120
voice notes 74, 188
recording toolbar 74
records 115
recurring appointments. See
repeating appointments
redialing phone 44
redirector (websites) 234
Region page 183
regional settings 183, 194
Regional Settings page 183
Regulatory Information 245
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reminders

events and 66, 70

system alarms and 195

tasks and 71, 73

turning on and off 181
remote access server 206
remote synchronization 161
Remove Programs icon 160
Remove Programs page 160
removing

applications 160, 238

Bluetooth connections

111

certificates 196

contacts 62

directory services 95

documents 139

events 69

expansion cards 167

favorites links 106

files 157

items from folders 156

items from playlists 130

messages 99, 100, 101

notes 76

pictures 123

sounds 176

speed dial buttons 56

tasks 73

text 22

workbooks 152

worksheets 152

Rename command 171
Rename/Move command

135, 138, 151, 169
renaming

documents 138

expansion cards 171

items in folders 156

workbooks 151

worksheets 148
Repeat check box 182
Repeat command 129
repeat patterns 66
repeating appointments 66
repeating current song 128
repeating sounds 182
repeating tasks 71
Replace All setting 135, 151
replacing

information 151

text 135

the battery 216
reset button 213
resetting Treo 700

smartphone 191, 213, 214
resolution 117, 235
Resolution command 118
restoring information 215
restoring sound settings 180
retrieving voicemail 47
Return key 26
reverse type 21
revision marks 133

RF Safety Statement 245
Right button (navigator) 19
right-click menus 24
Ring tone list 176
Ring type list 176
ringer switch 5, 180
ringer volume 176
ringer, silencing 46, 180
ringtone files 81
ringtone IDs 176
ringtone managers 236
ringtones
assigning to contacts 55,
61,121, 176
creating video 121
downloading 175
previewing 176
selecting 175
silencing 180
roaming 39, 165, 175
Roaming setting 175
rotating pictures 123, 124
Running Programs screen

’

S

Save As command 136

Save password check box
88, 93

Save to Contact Ring Tone
command 121

Save to Drafts command 94

Using Your Treo 700w Smartphone

275



Save to list 169
Save to Template command
85

saving
documents 134, 136, 139
information 169
multimedia messages 85
notes 76, 188
phone numbers 49-50
pictures and videos 125
workbooks 142, 144, 153
Schedule command 164
schedules
adding items to 64, 66,
67,71
managing 64-69
organizing events for 68
removing events 69
removing tasks 73
sorting tasks on 72
unavailable time on 68
viewing daily 63
scheduling synchronization
164-165
screen
accessories for 218
activating items on 21
adjusting brightness 183
aligning 184
backgrounds for 123, 173
caring for 6
disabling touch-

sensitivity for 189
moving around on 19-20
selecting items on 21
setting appearance of

173,174,184
troubleshooting 218
turning off 35, 199
waking up 11, 48

Screen taps check box 181
screens, returning to
previous 21
screensavers 124
scroll arrows 20
scroll bar 20
scrolling 20, 67, 140, 188
SD expansion cards 166, 167
Search dialog box 156
Search for list 156
Search icon 156
searching
contacts list 41
documents 135
spreadsheets 151
web pages 32, 104
searching for files 155, 156
searching for information
32,135, 151, 1565
searching for signal 35
secure websites 196, 234
security 189-193, 196
security certificates 108
Security page 109

security software 189
self-portrait mirror 7, 119
Send outgoing items...
setting 165
Send Sound command 176
sending
copyrighted items 120
email 95, 231
meeting requests 67, 70
multimediamessages 81,
83
pictures 121
text messages 46, 80
videos 121
Sent folder 96, 101
Service Pack 2 86
Services page 178
Set as Today Background
command 123
setting alarm clock 195
sheet list 145
Shift key 26, 27
Short Messaging Service.
See SMS messaging
Short tones setting 177
shortcut icons 30
shortcut menus 24
Show alphabetical index
setting 62
Show contact names only
setting 62
Show list 120
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Shoz\llv Options command
141
Shuffle command 129
side button 6
signal, searching for 35
signal strength 38, 219
signal-strength icon 11, 200
signatures 100
silencing all sounds 180
silencing ringer 46, 180
silent alarm 180, 182
single carrier radio
transmission 220
Size setting 137
sketching 74
Skins page 132
Slide Show page 124
slide show toolbar 120
slide shows 120, 124, 141
slide timings setting 141
slider 20
slides 82, 120
smartphone
See also Treo 700
smartphone
caution for resetting 214
caution for storing 7
charging 8, 34
components of 5-7
connecting to PCs 16
disabling touch-
sensitivity for 189

disposing of 248
freeing space on 160, 238
getting help with 36
locking 189, 191
losing 32, 193
low light and 26
monitoring status 38-40
not responding 213, 236
not turning on 219
operational precautions
for 247
third-party applications
and 236
unlocking 190, 191
usage guidelines for 245
SMS messaging 79, 243
soft resets 8, 213
software
See also applications
hard resets and 214
included with
smartphone 2, 254
installing 15, 16, 212
songs. See music
Sort by list 149, 156
Sort command 149
sorting
folder items 139, 152, 156
History list items 108
information 149
pictures and videos 122
tasks 72

sound clips 81
Sound Mode positions 180
sounds
changing alarm 195
customizing system 180
playing 125, 176
previewing 176, 182
recording 176
selecting 181
setting Dialpad 177
setting ringtone 175
turning off 180, 182
Sounds & Notifications page
175, 181
Sounds page 181
SP2 86
Space key 26
speaker 7, 127
speakerphone 48
Speakerphone command 48
special characters. See
alternate characters
special occasions 64
specifications 253
speed dial buttons 43, 54-57

Speed Dial Options
command 57

Spell Check command 80, 94
spell-checking 80, 94, 138
Spelling command 138

split bar 145

spreadsheet templates 142,
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144, 153
spreadsheets
See also Excel Mobile
application; workbooks
changing order of
worksheets 147
creating 142
displaying 142, 143
entering data in 144, 146
filtering in 149
searching 151
sorting in 149
Start button 6, 30
Start menu 30, 185, 243
starting
Calendar application 63
Contacts application 61
data connections 207
Excel Mobile 144
Internet Explorer 104
Media Player Mobile 128,
131
Notes application 74
Pictures & Videos
application 118
PowerPoint Mobile 140
Quick Tour 35
synchronization 164
Tasks application 71
Word Mobile 134
static electricity 251
status icons 38, 99

stereo adapters 59, 127

stereo headphones 127

Still image compression
level setting 125

Stop command 129

stopping playback 129

stopping synchronization
164

Storage Card page 170, 198
Storage Card setting 168,
169
storage card symbol 156
storage cards. See
expansion cards

Storage page 102

storage temperatures 255

storing
applications 238
attachments 98, 102
document files 136
information 166, 238
passwords 89
smartphone 7
workbooks 151

Strikethrough setting 137

stylus 5

support information 36

swapping calls 52

Symbol command 144

symbols 27, 55, 144

sync cable 17, 225

sync conflicts 89

Sync Setup Wizard 161
synchronization
scheduling 164-165
setting options for 161
starting 164
troubleshooting 213,
224-227, 232
synchronization icons 33
synchronization software 15,
16

synchronizing

dates and time 194

email accounts 96

information 15, 32, 164,
224

offline 225

over Bluetooth
connections 113

over infrared
connections 116

pictures and videos 126

playlists 128

prerequisites for 15

remotely 161

web files 109

wirelessly 86, 91, 110

with Exchange Server
161

with multiple computers
162

system alarms 195
system errors 219
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system locks 189, 191

system requirements 15, 254

System Settings page 183,
184, 196, 197, 198

system sounds 180

system warnings 181

T

tables in documents 134
tabs, scrolling through 20
taking pictures 117-118, 235
tapping 19, 22, 181, 218
tasks
adding 71
deleting 73
displaying 72, 73
marking as completed 72
marking as sensitive 71
setting reminders for 71,
73
Tasks application
customizing 73
filtering options for 72
starting 71
synchronizing with 32
Tasks entry bar 71, 73
Tasks icon 71
Tasks list 72
technical assistance 36, 237
telecommunications 247
temperature range 255
templates

documents 135, 139
multimedia messages 85
spreadsheets 142, 144,
153
temporal key integrity
protocol (TKIP) 204
tentative appointments 64
text
aligning 137
changing 135
copying 108
correcting 80, 94, 138
deleting 22
entering 27-28, 188
finding and replacing 135
formatting 136
highlighting 22, 137
moving or copying 136
resizing 183
searching for 32, 135
selecting 21
word-processing
features for 133
text captions 83
text fields 20
text messages
See also messages
addressing 80
creating 79
links in 98
phone numbers in 44
receiving 83

sending 46, 80
troubleshooting 221
text messaging service 1
Text Size page 183
Text Speed Dial button 55
text speed dial buttons 43, 54
themes 174, 184
third-party applications
5-way navigator and 19,
236

accessing Outlook
folders and 225
freeing internal memory
and 238
getting help with 159
installing 157
losing 214
synchronizing
information and 15, 212
troubleshooting 214, 236
third-party vendors 15, 212
Thumbnail View 118, 120
Thumbnails button 120
time formats 184
Time page 184, 194
time settings 194
time zones 194
tips icon 1
Today screen 31, 38, 242
customizing 123, 173-174
Today Settings page 173,
174
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tones. See ringtones;
sounds
touchscreen. See screen
touchscreen lockout 189, 190
touch-sensitive feature 189
transferring
information 211, 242
media files 127, 130
transition effects (slides) 141
Transparency level list 123
Treo 700 device
features of 1, 35
online support for 36
required items for 3
specifications for 253
Treo 700 smartphone
See also smartphone
compatibility with third-
party vendors 15, 212
compliancy statement for
246

components of 2

resetting 191, 213, 214

turning on and off 11
Treo700wVerizon web page

troubleshooting 211

TTY devices 177, 247

TTY/TDD settings 177, 247

Turn on Bluetooth check box
110

turning keyboard backlight

on and off 26
turning off call forwarding 53
turning off screen 35, 199
turning off system sounds

turning on alarms 195
turning on indicator light 10
turning phone on and off 11
Typing mode 76

U

unauthorized users 190, 196
unavailable connections 220
unavailable time slots 68
underlining text 134, 137
Unknown Caller setting 175
unlocking

smartphone 190, 191

spreadsheet rows and
columns 145
unread messages 99
unretrieved voicemail 47
unsafe areas 246
untimed events 64, 66
Up button (navigator) 19
Update Library command
129
updating
information 15, 241
media files 129
uppercase letters 27, 188
URLs 128, 140

USB hub 224

USB ports 17, 224

USB sync cable 17, 225

Use above settings while
roaming setting 165

user discussion groups 36

usernames 243

\'

vCal attachments 232
vCard attachments 232
Verizon Wireless accounts 1
Verizon Wireless Customer
Care 36
Vibrate when... check boxes
176, 182
vibrating alarm 180, 182
video files 81, 126
Video Mode command 119
Video page 125, 131
video ringtones 121
videos
adding sounds 125
adding to messages 82
adjusting volume for 176
changing resolution 120,
235

defaults for 118
limiting length 125
on phones without
camera 117
organizing 121
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VPN connections
Voice Command buttons
186, 187
voice mail buttons 55
Voice mail setting 175
voice notes 74, 83, 188
voice privacy icon 40
Voice Privacy setting 178
voice quality 239
voice recording formats 188

recording 119-120
saving 125
sending 121
synchronizing 126
viewing 120, 126
View Recording Toolbar
command 74
viewing
alternate characters 28
animated images 126

warnings 181, 247

warranty 2

WALV files 81

web browser. See Internet
Explorer Mobile

web browsing 1, 104, 108

web links. See links

web pages
accessing 104, 106, 234
clearing links to 238

appointments 63 voicemail copying from 108
available applications 30 customizing 55 dialing from 44
calendar 63 playing 47 display options for 104

contacts 41, 62

daily schedules 63

documents 133

events 64, 68

items in folders 139, 152

memory usage 198

menus 23, 25

multimedia messages 84

notifications 182

pictures 120, 126

power settings 199

space on expansion
cards 170, 198

spreadsheets 142, 143

tasks 72, 73

videos 120, 126

web pages 104, 108

wireless settings 200

sending calls to 46

setting ringtones for 175

setting up 47
troubleshooting 177
viewing minutes usage
for 54
voicemail controls 55
Voicemail icon 47
voicemail systems 47
Volume button 6, 176
volume, adjusting 13, 176
VP icon 40
VPN clients 207
VPN connections 98, 207-
208

w

waking up screen 11, 48

downloading items from
107, 158

playing media files from
128

returning to recently
viewed 104, 108
searching 32, 104
security settings for 109
setting as home 108
troubleshooting 234
viewing 104, 108

Web search field 32, 104
websites

connecting to 104

ending connections 209

logging into secure 196

problems accessing
secure 234

Week View (calendar) 63

virtual private networks. See wallpaper 117
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WEP networks 204

Wi-Fi connections 201-205

Wi-Fi icon 203

Wi-Fi routers 113

Wi-Fi SDIO cards 201

Windows Media Player. See
Media Player Mobile

wireless band setting 179

wireless features 34, 200

wireless networks 201, 203

Wireless page 200

wireless phones 35, 113, 250,
251

Wiéeless Sync accounts 86,

1

wireless synchronization 86,
91, 110
WLANSs. See wireless
networks
WMA files 127
WMV files 126, 127
Word Completion page 187
word matching 135, 151
Word Mobile application
133-139
Word Mobile icon 134
word-processing features
133,134
workbook list 144, 153
workbooks
See also Excel Mobile
application;
spreadsheets

adding calculations 145
adding cells, rows, and
columns 147
adding charts 149, 150
adjusting column and
row size 148
creating 144
defining filters for 149
deleting 152
display options for 144
formatting options for
147-148
formulas in 145, 153
functions in 146
moving around in 145
naming 144, 151
organizing 151
removing cells, rows,
and columns 152
replacing information in
151
saving 142, 144, 153
searching 151
setting default template
for 153
worksheet names 143
worksheets 145, 147, 148,
152
See also spreadsheets;
workbooks
WPA networks 204
WPA-PSK connections 204

Writing mode 76
Y

Year View (calendar) 63

z

ZIP files 157

Zoom command 118

zoom icons (camera) 118

zoom icons (presentations)
140

Zoom In command 140

zoom settings 143, 145, 188
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